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Version 4.0.0.53

1. Under the ‘Preferences’ menu option, added a new option ‘Automatically convert images 
after T-Series’.  By default this option is checked.  If this option is unchecked, 
then when the operator performs a T-series acquisition with a ‘Max Speed’ option 
checked for any cycles (or if the T-series includes Z-series with a the ‘Fastest 
Acquisition’ option checked), the images will not be automatically converted to TIFF 
format at the end of the acquisition.

a. For individuals performing certain acquisitions that might include tens of 
thousands of images, the conversion process from ‘raw’ format to TIFF could 
take many minutes.  During this time, the operator is prevented from performing 
another acquisition and so on.

b. If the operator unchecks this option, then he/she will have to use the ‘Image-
Block Ripping Utility.exe’ program located in the ‘Prairie View’ directory to 
convert the acquired images from raw format to TIFF format at a later time.

2. Within the ‘PrairieConfigUtility.exe’ program on the ‘Z’ tab, an ‘Auxiliary Z’ 
checkbox parameter has been added for the 
‘PVFocusAssemblyPrairieMultiAxisMotorController’ device type.

a. This box should only be considered if the system is configured with two or more 
separate Z devices that are both controlled by the Multi-Axis Motor Controller 
(MAMC).  If the system does include two MAMC Z devices, then this box should 
only be checked for one of the devices.

b. When this box is checked, the MAMC controller will be configured so that two 
different Z devices may be controlled with the same ‘wheel’ if desired.  The 
operator selects the Z device association via one of the buttons on the MAMC 
controller.  The order that the Z devices are specified will determine which 
device is controlled by which state of the button on the controller.  If the 
desired association of the Z device with the button on the controller is 
backwards, simply change the order within the configuration.

3. Within the T-series controls, when all ‘cycles’ have been removed (via either the 
‘Clear All’ button or by removing the last cycle via the ‘Remove Selected’ button), if 
the ‘Insert’ cycle option had been selected, it will automatically switch to ‘Add’ 
cycle to allow for immediate editing of the now empty T-series cycle list.

4. When Prairie View is exiting, a dialog is displayed (similar to the start-up dialog) 
that informs the operator of the current status of the termination of Prairie View.

5. Prairie View Scripting:
a. New commands has been added; ‘Camera’, ‘SFC’, ‘SecondaryLaserBeamRoute’.
b. See the scripting help dialog found in the ‘Edit Scripts’ dialog for a complete 

description of this and all script commands.
6. Corrected a potential dead-lock situation that could occur when ROIs are used within a 

T-series.
7. If the system is equipped with a Multi-Axis Motor Controller (MAMC) and includes the 

‘wheel’ based motion control (as opposed to a ‘joystick’) for the X and Y axes, then 
there is a new option in the ‘Preferences’ menu, ‘Adjust MAMC Stage Controller vs 
Optical Zoom’.

a. This option allows the operator to specify how the response of the manual 
‘wheels’ for the X and Y stage axes will be affected as the operator changes 
the optical zoom.

b. When ‘Fine’ is selected, then as the optical zoom is increased from 1.0, the 
number of motor steps generated when the X or Y axis wheels are turned will be 
decreased to better match the stage movement with the current field of view.

c. When ‘Coarse’ is selected, a similar affect as with the ‘Fine’ option will 
occur, but to a lesser degree.

d. When ‘No Adjustment’ is selected, then the number of motor steps generated by 
the X or Y axis wheels will not be modified as the optical zoom is changed.

e. If the proper hardware configuration does not exist, then this menu option is 
not visible to the operator.

8. Modified the logic associated with the Confocal pinhole assembly when Prairie View is 



starting so that the pinhole motors will only be ‘homed’ if necessary.
9. Corrected a problem within the ‘Mark Points Wizard’ where on the first attempt to 

specify the galvo selection, the operator selection was not being communicated to 
TriggerSync.

10. Corrected a problem within the ‘Mark Points Wizard’ where sometimes when the ‘Acquire 
Loop’ option was selected for the ‘Acquisition Mode’, the action was not being 
properly registered within TriggerSync.

11. TriggerSync:
a. Modified the logic so that if the 'Mark Points' dialog was open whent the 

'Acquisition & DAC OUtput Setup' button is pressed, then when that dialog is 
closed, the 'Mark Points' dialog will be automatically re-opened.

b. Corrected a problem where sometimes, after opening the 'Acquisition & DAC 
OUtput Setup' dialog, that when the ‘Mark Points’ dialog was re-opened, the 
controls for ‘Galvo Selection’ and/or ‘Point Control’ were no longer visible.

c. Added a new optional feature to TriggerSync that allows the use of an external 
'trigger' pulse to move from one 'marked point' to the next.

i. To activate this option, the following line must be set up in 
the '[Hardware]' section of the 'TriggerSync.ini' file:

ii. Auxiliary Input Trigger=-1
iii. Where '-1' would be replaced by the appropriate NI board ID that 
the input trigger latch is physcially connected to (e.g. 1 or 2).  The 
following three lines should also be included as comments:

iv. # If the input trigger latch hardware is present, 'Auxiliary 
Input Trigger' is the NI board ID

v. # that the latch is connected to.  If the trigger latch hardware 
is not present, the value

vi. # should be -1
vii.
viii. For this feature to work, a Prairie 'Input Trigger' box (exactly 
like the one used by Prairie View before the use of the GPIO box is 
needed.  This box needs to have the 'Clear' signal connected to 'DIO 6' 
on the specified board, the 'Out' signal connected to 'DIO 7' on the 
same board, and 'Power' connected to a +5V connector.  If no GPIO box is 
present, then the opeator's trigger signal will be connected to the 
'Trigger' connection.  If a GPIO box is present, then the 'Trigger' 
connection should be connect to a spare BNC connection on the GPIO box 
and properly labeled.

ix.
x. To use this feature, simply 'check' the control on the right 
side of the main TriggerSync window labeled '"Move to Next Point" on TTL 
Pulse'.  When this item is checked, anytime a TTL pulse is sent to 
TriggerSync via the 'Trigger' box input, the software will automatically 
move to the next 'marked point'.  Basically the same action will happen 
as if the operator had pressed the 'Move to Next Point [F11]' button.

xi.
xii. When this feature is active, there is a second checkbox 
available  directly below the main control called 'Max Speed'.  This 
parameter is ignored unless the '"Move to Next Point" on TTL Pulse' is 
checked.  If this 'Max Speed' item is not checked, then even when the 
software looking for input triggers to move to the next marked point, it 
will still monitor all controls and command inputs from Prairie View.  
In this setting, the software is only able to move the marked point 
based upon the receipt of the input trigger at a maximum speed of 2-3Hz.  
When the 'Max Speed' item is checked, then TriggerSync will only respond 
to commands from Prairie View and will ignore contorls within 
TriggerSync.  However, the software is now able to move the marked point 
based upon the receipt of the input trigger at a maximum speed of about 
20-25Hz.

12. When the operator chooses ‘Help->About’, the dialog will now display the firmware 
version information for many of the hardware components in the system.

13. On the ‘Misc’ tab, if the system is configured with a Z Piezo device, the incorrect 
value for the maximum drive voltage was being displayed.

14. Modified the software which communicates with the Prairie Z Piezo device so that the 
serial communication option can be used in addition to the USB communication option.



15. Corrected a problem when Prairie View was exiting, if a Prairie Z Piezo device is 
present, it wasn’t being set back to ‘Manual’ mode.

16. If the Ultima system is configured with a GPIO box, if the ‘Center Galvos’ option had 
been selected under the ‘Tools’ menu and then the program was exited, the GPIO box was 
not being properly configured on exit to route the drive signals from the National 
Instruments scan card (PCI-6110 or PCI-6115) to the galvos.  This has been corrected.

Version 4.0.0.52

1. If the system configuration includes a Z Piezo device, then on the ‘Misc’ tab there is 
a new display value ‘Z Piezo Range/Voltage’.  Displayed under this is a text message 
that defines the travel range of the Z Piezo device and the voltage range 
corresponding to that travel range.

a. If there is no Z Piezo device in the system configuration, this display will 
not be visible.

2. Added four optional ‘utility buttons’ to the ‘Misc’ tab.
a. These buttons are configured in the ‘PrairieConfigUtility’ program on the 

‘Misc’ tab.  They can be configured to use a digital output line from either 
the GPIO box or the Device Control Box.  The operator may specify the caption 
to associate with each button, as well as the text to associate with both the 
‘false’ (off) and ‘true’ (on) states for each button.

b. If none of the buttons is configured, then the entire ‘Utility Buttons’ group 
is not displayed.

c. Only the configured utility buttons will be displayed.
3. Prairie View Scripting:

a. New command has been added; ‘UtilityButton’.
b. See the scripting help dialog found in the ‘Edit Scripts’ dialog for a complete 

description of all script commands.
4. Modified the vertical scroll bars in the LUT (Lookup Table) dialog so that the minimum 

values are at the bottom, not at the top.  This applies to the gamma, brightness, and 
contrast vertical scroll bars.

5. Extended the capabilities of the ‘ROI’ feature.
a. When the ‘Auto Edit’ option is selected, after an ROI is drawn, there is an ‘X’ 

box located near the upper right hand corner of the ROI (located next to the 
corner with the ‘circle’ indicator for rotating the ROI).  If the operator 
clicks on the ‘X’ box, that particular ROI will be deleted.

b. Within the ROI context menu, a new option ‘Show Advanced Settings’ has been 
added.

i. When this option is checked and the ‘Auto Edit’ option is 
checked, then when the operator creates a single ROI, the ‘Advanced ROI 
Settings’ dialog will appear (if any additional ROIs are drawn, the 
‘Advanced ROI Settings’ dialog will be automatically hidden.

ii. If this option is not checked, but the ‘Auto Edit’ option is 
checked, then after the operator draws a single ROI, if he/she goes to 
the ROI context menu and selects the ‘Show Advanced Settings’ feature, 
the dialog will appear.

iii. The operator may switch between scanning the defined ROI, or a 
line (located in the vertical center of the ROI) by either double 
clicking within the ROI or clicking on the desired scan option ‘Scan 
Region’ or ‘Scan Line’ within the ‘Advanced ROI Settings’ dialog.

1. If the ‘Scan Line’ option is selected, then when the ROI is used 
in a T-Series, for example, the galvos will scan the defined 
‘line’ for the number of times defined by the number of lines in 
the original ROI definition.

2. If an ROI definition is set to ‘Scan Line’, then in the ROI 
context menu list of defined ROIs, that particular ROI will have 
the additional listing of ‘(Line)’ with it.

iv. Under ‘Advanced Settings’ within the ‘Advanced ROI Settings’ 
dialog is a checkbox ‘Manual Frame Rate’ and a field for the desired 
frame rate in Hertz (Hz).

1. If this checkbox is checked, then the ‘Hz’ text box becomes 
active.



2. By selecting this option and specifying a frame rate, the 
operator has strict control over the frequency with which the 
defined ROI will be exposed (rastered). 

3. To take advantage of this feature, within the T-series, select 
the ROI (or go into the desired ROI definition before starting 
the T-series), specify the number of images to acquire in the ‘# 
Reps’ column and then check the ‘Max Speed’ checkbox.  For 
example, if the ROI takes 75ms to raster (scan), and a frame 
rate of 10Hz is specified, then over the span of the desired T-
series acquisition first the ROI raster will take place, 
followed by 25ms of no data, then repeat the ROI, and so on.  
This will be much more accurately timed than if the operator 
attempted to use a non ‘Max Speed’ T-series and would then 
specify a ‘Period’ of 100ms (10Hz).

4. If this checkbox is checked and the ‘Scan Line’ option is 
selected for the region option (instead of ‘Scan Region’), then 
the linescan will occur for the entire frame time.  Using the 
previous example, the acquisition will not be limited to 75ms, 
it will continue for the entire 100ms.  To this end, the ‘Manual 
Frame Rate’ option is not very useful with the ‘Scan Line’ 
option.

a. So within a T-series, if an ROI with the ‘Scan Line’ 
option is selected, 

6. Extended the capabilities of the ‘Dual ROI’ feature.
a. To provide proper laser control with the new capabilities, it is necessary 

within the ‘PrairieConfigUtility’ program for the operator to specify which 
laser control is associated with the imaging galvos and which laser control is 
associated with the uncaging galvos.

i. Exit Prairie View.
ii. Start ‘PrairieConfigUtility.exe’ (C:\Program Files\Prairie
\Prairie View’).

1. Go to the ‘Laser’ tab,
2. On the last column ‘Light Path’, select ‘Imaging’ or ‘Uncaging’ 

as appropriate for each laser line control.
3. Click the ‘Save’ button at the bottom.
4. Exit ‘PrairieConfigUtility’

iii. Start Prairie View.
b. See the previous section ‘Extended the capabilities of the ‘ROI’ feature’ for 

an introduction to the new feature operation.
c. As it pertains to the simultaneous scanning with both sets of galvos.

i. As before, right click on the ‘ROI’ button in the image window 
and select ‘Enter Dual ROI’.

ii. Within the image window, draw the ROI for the scanning area for 
the imaging galvos.

iii. After drawing the ROI for the image galvos, click within the ROI 
and move the ROI box that indicates the location for the uncaging 
galvos.

iv. If desired, rotate the ROIs or shrink the size of the uncaging 
galvos scan area (effectively zooming in).

v. This is where the previous Dual ROI scanning setup would end.  
If you do not intend to use the new features, click on either the ‘Save 
ROI’ button or the ‘Enter ROI’ button at the top of the image window.

vi. If the ‘Advanced ROI Settings’ dialog is not already open, open 
it.

vii. Within the ‘Dual ROI’ mode, the operator may select to scan an 
ROI or a line with either galvo set.  This provides the ability to scan 
two ROIs simultaneously, scan one ROI and one line simultaneously, or 
scan two lines simultaneously.

viii. The same basic acquisition notes apply here as in the previous 
section.

1. Let’s say that the operator chooses a ‘Scan Region’ for the 
imaging galvos and a ‘Scan Line’ for the uncaging galvos, and 
that the ‘Manual Frame Rate’ was set to 10Hz.

a. Within the T-series, the operator indicates to acquire 



100 images with the ‘Max Speed’ option checked.
b. When the T-series is started, the raster rate for the 

imaging galvos will generate ten rasters per second.  If 
the raster time of the ROI were 30ms, then after the 
raster was finished, the imaging laser would stop 
illuminating the sample for the next 70ms.  Since the 
‘Scan Line’ option was selected for the uncaging galvos, 
the uncaging galvos will scan continuously for the 
duration of the 100 images. During the uncaging galvo 
line scan there will be no interruption of the laser 
illumination.

c. The data collected from the PMT(s) will have happened 
continuously during the entire cycle and would have been 
saved as a sequence of 100 images (the number of images 
defined in the cycle).

Version 4.0.0.50

1. Modified the logic for communication with the Coherent Chameleon laser to better 
handle the occasional command failure.

2. Corrected a deadlock situation that occasionally could occur in Playback mode.
3. Modified to support TriggerSync 2.0.0.
4. TriggerSync version 2.0.0.

a. Added support for a second PCI-6713 card.  This will allow TriggerSync to 
control up to 16 analog outputs.

b. To activate this option, the following line must be set up in the '[Hardware]' 
section of the 'TriggerSync.ini' file;

i. Output DAQ Board 2=4
ii. Where '4' would be replaced by the appropriate NI board ID.  The  
folloowing two lines should also be include as comments;

1. # If a second analog output board is present, 'Output DAQ Board 
2' is the NI board ID for the

2. # second PCI-6713.  If a second analog output board is not 
present, the value should be -1.

c. The 'Continuous Pulse Output' feature (found under the 'Configuration' menu 
option was not modified to support the expanded list of potential analog 
outputs.

d. Corrected some dialogs that contain the 'DAC Output' selections so that the DAC 
Outputs that should not be accessible (uncaging galvos signals, etc.) are not 
selectable.

Version 4.0.0.49

1. Corrected an issue, where sometimes, the ‘Waiting for Input Trigger’ message was not 
being displayed in the status window during T-Series acquisitions.

2. Changed the logic so that if a ‘Max Speed’ acquisition is waiting for an input 
trigger, the message, ‘Acquiring 1 of N’ is not displayed before the ‘Waiting for 
Input Trigger’ message.

Version 4.0.0.48

1. Within the PrairieConfigUtility program, on the ‘Misc’ tab, associated with the 
‘Shutter’ settings, a new colum ‘Delay’ has been added.  This column allows the 
operator to specify the number of milliseconds that Prairie View should ‘delay’ or 
wait after opening or closing the specified hard shutter before continuing.  This 
provides the ability to make certain that the shutte is fully opened/closed before 
acquiring images/data.



Version 4.0.0.47

1. Added brightness over time drive signal feature which is activated in the 
configuration utility on the 'Custom Outputs' tab allowing one or more analog outputs 
to be driven by brightness over time region intensities.  Check the checkbox next to a 
drive signal line to enable it and then enter a BOT region number to drive it (1-32).  
Optionally you can enter a scaling factor to scale the resulting waveform to your 
needs.

Version 4.0.0.46

1. Modified Prairie View for the control of two lasers and shutters when the laser lines 
are combined on the imaging path within the scan head (sidecar) and a GPIO box is part 
of the system.  This modification allows for the control of the second laser (which is 
on the ‘uncaging’ path, to be controlled via Prairie View or TriggerSync).

2. Corrected some problems within the BOT dialog.  If the ‘Remove Region’ button was 
pressed and not regions were currently ‘selected’, the program would crash.  A similar 
issue existed when the ‘Remove Group’, ‘Update Group’, ‘Remove Function’, or ‘Edit 
Function’ buttons were pressed.

3. TriggerSync version 1.5.5
a. Added a new button in the lower right hand corner of the main dialog ‘Connect 

to Prairie View’.  This should allow the operator to 'connect' TriggerSync to 
Prairie View even if Prairie View is started second, or is restarted without 
exiting TriggerSync.  This button is only ‘active’ (enabled) when both 
applications are running, but the communication connection between them hasn’t 
been established.

4. Corrected a problem in the BOT interface, if the operator selected the ‘Clone’ 
operation when right-clicking on a BOT region, an error was generated.

Version 4.0.0.45

1. Added a feature to the LUT controls (the ‘AUTO’ and ‘RESET’ buttons) that allows the 
operator to press a button and have the software automatically determine the placement 
of the cursors for the optimal display of the image data.

a. This feature may also be utilized without actually displaying the LUT dialog.  
The operator may right click on either the ‘LUT’ button in the image window, or 
click on the context menu button next to the LUT button, and then from the menu 
that pops up, select ‘Automatically Adjust Lookup Table Levels’ to 
automatically determine the placement of the cursors for the optimal display of 
the image data, or select ‘Reset Lookup Table Levels’ to reset the cursors.

Version 4.0.0.44

1. Added support for the Prior ProScan I stage.

Version 4.0.0.43

1. Within the ‘PrairieConfigUtility.exe’ program on the ‘XY’ and ‘Z’ tabs, added a new 
checkbox; Disable ‘Home’ Option.  If this option is ‘checked’, then the ‘Home’ 
controls associated with either the XY Stage or Z controls within Prairie View will be 
disabled.  If a system is configured with multiple Z (focus) devices, then this option 
must be set for each Z device.

2. Modified the software with regards to the motorized pinhole assembly in the ‘confocal 
module’ so that the pinhole sizes are read directly from the Confocal module, and are 



no longer defined in the ‘PrairieConfigUtility.exe’ program.
3. Finished modifying dialogs (LUT and etc.) that include ‘graphs’ to provide better 

tools for ‘zooming’ and ‘panning’.
4. Corrected a problem where the ‘Save’ option was not always present in the ROI menu.

Version 4.0.0.42

1. Started modifying the dialogs (Point Scan, BOT, Line Profile) that included ‘graphs’ 
to provide better tools for ‘zooming’ and ‘panning’.

2. The BOT window will not automatically ‘close’ unless the operator specifically closes 
the dialog.

3. Added ‘icons’ to some of the buttons in the image windows.

Version 4.0.0.41

1. Prairie View Scripting:
a. New command has been added; ‘SetHardShutterSelection’.
b. See the scripting help dialog found in the ‘Edit Scripts’ dialog for a complete 

description of all script commands.
2. Changes have been made to image window size control:

a. The ‘Image Window Size’ controls located in the main Prairie View window still 
work the same way by adjusting the size of all open image windows.

b. The operator may resize an individual image window by simply clicking and 
dragging on one of the corners of the image window.

c. Along the right hand side of each image window is a toolbar with the following 
options; Zoom In, Zoom Out, Zoom Fit, Zoom 1:1, and New Window.

3. When the ‘PA’ button is pressed in an image window, the Photoactivation controls will 
appear in a separate dialog and are no longer physically attached to the image window 
where the ‘PA’ button was pressed.

4. When the ‘Mark’ button is pressed in an image window, the Mark Points controls will 
appear in a separate dialog and are no longer physically attached to the image window 
where the ‘Mark’ button is pressed.

5. Fixed a problem where the cursors in the LUT graphs would sometimes move 
inadvertently.

6. Fixed a problem when a T-Series was aborted during a ‘Max Speed’ cycle and the .xml 
file was not being properly created.

7. Corrected a problem if Prairie View was started while still physically set to AOD mode 
(only applies to dual scan systems).

Version 4.0.0.40

1. Added a new option for the ‘Second Laser Beam Router’ on the ‘Misc’ tab within 
‘PrairieConfigUtility.exe’.  The new option is ‘PVPrairieGPIOBoxLaunch’.  If this 
option is selected, then when the ‘Secondary Laser Beam Router’ control on the ‘Misc’ 
tab in Prairie View has it’s state changed, it will change the routing of the control 
of the ‘Laser Launch’ outputs within the GPIO Box.

2. TriggerSync version 1.5.4
a. Added a new parameter to the '[Shutter]' section of 'TriggerSync.ini', 

'BNC-2090 Open State DIO2'.  When the BNC-2090 DIO2 shutter is selected from 
the 'Configuration' menu, this will define the logic level for the open state 
for the shutter.

3. Modified Prairie View to pay attention to the setting for the ‘Default State’ for a 
‘Hard’ shutter configured in the ‘PrairieConfigUtility.exe’ program.  The definition 
of ‘Default State’ is the logic output level when the hard shutter is to be opened.  
For example, if the ‘Default Setting’ is ‘True’, then when the hard shutter in Prairie 
View is open, the output level will be ‘high’, and when the hard shutter is closed, 
the output level will be ‘low’.  If the ‘Default Setting’ is ‘False’, then when the 
hard shutter in Prairie View is open, the output level will be ‘low’, and when the 



hard shutter is closed, the output level will be ‘high’.
4. Within the ‘Point Scan’ function, corrected a problem where if the ‘Repetitions’ value 

was greater than ‘1’, and the ‘Until Stopped’ option is checked, then when the ‘Start 
Point Scan’ button was pressed, after ‘Abort Point Scan’ button is pressed to stop the 
acquisition, it would continue with a new acquisition until all ‘Repetitions’ were 
completed.  This has been corrected so that if the ‘Until Stopped’ option is checked, 
only one acquisition will be executed.

Version 4.0.0.39

1. Corrected a problem related to routing of the ‘PC 2 OUT’ signal for a GPIO box based 
Ultima.

2. Modified the T-Series tab.
a. Instead of the operator selecting the ‘cycle’ type and then pressing the ‘Add’ 

or ‘Insert’ buttons, this operation has been reversed to make setting up a T-
Series more efficient.

i. Now the operator will select the ‘Add’ or ‘Insert’ option, and 
then simply click on the desired ‘cycle’ type to add or insert the 
desired cycle into the T-Series.

b. Previously the operator would have to select the desired ROI, Label, XY Stage 
Location, Script, or Marked Point before adding or inserting that cycle into 
the T-Series.  In addition, once that cycle was added, the only way it could be 
edited would be to delete the cycle, make the appropriate selection, and add/
insert the cycle again.

i. Now, a new column ‘Resource Selection’ has been added.  When a 
ROI, Label, XY Stage Location, Script, or Marked Point cycle is added, a 
combo box will appear in this column with all of the available options 
for that particular cycle.

ii. In this way the operator may change/edit the cycle by simply 
changing the selection in the combo box in the ‘Resource Selection’ 
column.

c. These changes will improve the capability to save/reload T-Series setups.
3. Corrected a problem when configuring a system with multiple preamplifiers.

Version 4.0.0.38

1. Corrected a problem that would cause an error at Prairie View start up if all of the 
Confocal elements (pinhole, dichroics, and filters) were not present.  Also disabled 
any Confocal elements that were not present in the system configuration.

Version 4.0.0.37

1. Added support to be able to use the Prairie Piezo objective driver for ‘fast’ 3-D 
uncaging experiments.  This is where the Piezo objective driver is controlled via an 
analog signal driven by TriggerSync.

2. Added additional ‘ROI’ features.
a. ROIs may be rotated.
b. There is a new ‘Auto Edit’ option in the context menu.

i. When this mode is active (checked), when an ROI is drawn, the 
system will not automatically activate that ROI.  Rather, after the 
operator finishes drawing the ROI, the ROI will remain on the screen 
with the option for the operator to ‘edit’ the ROI by adjusing the size, 
placement, or rotation angle.

1. To adjust the size, place the mouse inside of the one of the 
‘boxes’ on the edge of the ROI (the mouse cursor will change to 
an line with an arrow on both ends), left click and drag to 
change the ROI size.



2. To adjust the placement, place the mouse inside of the ROI (the 
mouse cursor will change to a ‘hand’ icon), left click and move 
the mouse to change the location of the ROI.

3. To adjust the rotation angle, place the mouse inside of the 
‘circle’ on the one corner of the ROI (the mouse cursor will 
change to a ‘rotate’ icon), left click and move the mouse to 
rotate the ROI.  If the ROI is located close to an edge of the 
image window, as the ROI is rotated, if a corner of the ROI 
would extend beyond the edge of the image window, the center of 
the ROI will be shifted enough to keep the ROI within the 
current image window.

4. If you ‘right’ click the mouse inside of an ROI, this will 
create a ‘clone’ or copy of that ROI.  Then by left clicking the 
mouse, you can move the new ROI to the desired location.  This 
is a convenient way to create multiple ROIs that have the same 
dimensions.

5. Click on the ‘Accept’ button in the image window to accept the 
ROI definition, or click on the ‘Cancel’ button to exit without 
creating the ROI.  If a single ROI has been defined when the 
‘Accept’ button is pressed, ROI mode will be entered.

c. There is a new ‘Edit New ROIs’ option in the context menu.
i. When this option is selected, the operator may define multiple 
ROIs without actually entering into the ROI mode.

ii. All of the ROI editing options described in (b) apply here as 
well.

iii. Click on the ‘Accept’ button in the image window to accept the 
ROI definitions, or click on the ‘Cancel’ button to exit without 
creating the ROIs.

Version 4.0.0.36

1. Corrected the title in the form with the ‘Help’ information for the ‘Laser 
Calibration’ dialog.

2. Updated the ‘Help’ file associated with the ‘Laser Calibration’ feature.
3. Corrected a problem where the ‘Laser Calibration’ dialog was not automatically 

minimized and restored when the main Prairie View window was minimized and restored.
4. Corrected a problem in the ‘Notes’ dialog (‘Tools->Notes’) where the bottom was hidden 

behind the new buttons for ‘Clear’, ‘Save As’, and ‘Accept’.
5. Added the following keyboard short cuts:

a. Ctrl+O: File->Load Images(s)
b. Ctrl+X: File->Exit
c. Ctrl+S: This is equivalent to clicking on the ‘Camera’ icon in ‘Image Window - 

1’.  If the ‘Default Action’ assigned to that button is ‘Save’ or ‘Save As’, 
the appropriate action will be taken.

6. Corrected a problem with the saving of the configuration files (.cfg), where an 
incorrect setting was being used for the ‘permissions’ field for the 
‘positionCurrent_’ parameters.  Bascially, the ‘Read’ permission should not be set.  
If it is set, then when the configuration file is ‘loaded’ the motors will be told to 
move to the locations saved in this file.

a. Also changed the loading of configuration files where the ‘positionCurrent’ 
parameters will be ignored.

7. Made a change to the ‘FindSlice’ script command to guarantee that the z motor has 
finished moving to its intended location before acquiring an image.

Version 4.0.0.35

1. When in Playback mode, with a Z-series loaded, if the ‘Line Profile’ tool was active 
and the ‘MIP’ mode was activated, the ‘Z mode’ button in the ‘Line Profile’ dialog was 
not active.  This has been fixed.



2. Modified the ‘Dual Galvo scanning’ feature to allow the operator to adjust the size of 
the ROI for the ‘Uncaging’ galvos relative to the ROI for the ‘Imaging’ galvos.  The 
ROI for the Uncaging galvos may be made smaller than the ROI for the Imaging galvos, 
but not larger than the ROI for the Imaging galvos.  Since the image resolution for 
each ROI is kept the same, this will have the affect of ‘zooming’ the scan area for 
the Uncaging galvos.

a. Since the ‘period’ for each ROI is the same, if the ROI for the Uncaging galvos 
is smaller than the ROI for the Imaging galvos, there will be the ‘hidden’ 
affect of increasing the dwell time per pixel in the Uncaging galvo image.

Version 4.0.0.34

3. Modified the ‘FindSlice’ script command. 
a. See the scripting help dialog found in the ‘Edit Scripts’ dialog for a complete 

description of all script commands.
4. Corrected a problem when the ‘ROI’ button on an image window is right clicked on, and 

the ‘Load ROI’ option is selected, as the operator drags the ROI around within the 
image window to adjust its placement, the x dimension of the ROI would in some 
instances start to decrease as the ROI was moved.

5. Modified camera controls (when in camera only mode (not SFC)) so that some camera 
settings may be edited while scanning.

6. Corrected a problem with the initialization of the GPIO box pockels cell routing for 
the second laser line if the laser were configured as ‘PVAnalogOutputDAQBuffered’.

Version 4.0.0.33

1. Corrected a problem where closing and reopening the line scan dialog would cause the 
channel combo box for selecting which channel to load into the line scan viewer to 
stop updating when channels were enabled/disabled.

2. Modified the format of the .lsd files that are generated with linescan acquisition.  
This change was necessary so that the LinescanViewer application could read a separate 
‘source’ image for each linescan in a given data set.

3. LinescanViewer modifications:
a. Modified LinescanViewer so that when a ‘Line’ is selected, if there is already 

at least one ‘Profile’ associated with that ‘Line’, it will be automatically 
selected and displayed.

b. Corrected an issue in LinescanViewer where when the operator attempted to 
‘zoom’ the linescan image (not the reference image), if a ‘Profile’ was 
currently selected, then the profile would move to the location where the mouse 
was clicked for the ‘zoom’ action.  With this correction, the profile will no 
longer move when the image zoom is changed.

4. Corrected a problem when a laser line was configured as PVAnalogOutputDAQBuffered, if 
the number of lines to skip for a linescan was other than 0, the data sampling was not 
happening in synchronization with the laser control.

5. Within the ‘Mark Points Wizard’ dialog, on the ‘Sync’ tab, a field was added to allow 
the operator to specify the TriggerSync acquisition time.

6. Corrected a problem within the Linescan Control dialog when the operator would enter a 
desired acquisition time, the entered value would not be applied.

7. Corrected a problem within the Scripts editor dialog where if a ‘category’ was 
deleted, the remaining categories were not being properly renumbered.

8. In the Linescan Control dialog, when using the ‘freehand’ selection, only the left 
mouse button may be used to draw the linescan form.  The right mouse button is still 
used to move the pattern around when clicking on one of the linescan endpoints.  This 
allows the operator to have the ‘Mark Points’ option enabled simultaneously with the 
linescan controls and to be able to properly access the appropriate action.

9. Modified the image size buttons in (e.g. ‘512x512’) so that if the current scan 
settings do not allow that ‘size’, the button will be disabled.  This would mostly 
apply to the ‘64x64’ image size button.



Version 4.0.0.32

1. Added a ‘Save As’ button to the Notes dialog found under the ‘Tools’ menu on the main 
form or by pressing F8.

Version 4.0.0.31

2. Corrected a problem with a software crash shile scanning when the ‘Line Measurement’ 
option is enabled.

3. Corrected a problem when ‘aborting’ a T-Series with BOT data collection could 
sometimes cause the software to lock up.

Version 4.0.0.30

1. Corrected a problem in acquisitions where a TriggerSync experiment is executed in 
conjunction with a Prairie View acquisition (Linescan or T-Series) and there was an 
extra delay (approximately 5 seconds) that was unnecessary.

2. Modified Prairie View so that if the ‘Confocal’ controls are not enabled, then the 
Confocal controls will not appear behind the laser controls if the laser controls are 
‘removed’ from the main user interface.

3. Corrected Prairie View so that the ‘Mark’ or ‘Mark Uncage’ button in the image windows 
is not active by default.  It is only active when TriggerSync is active.

4. Added a ‘Move All’ button within the ‘Mark Points’ controls in the image window.  When 
the operator presses this button, all of the current ‘points’ will be shown in the 
current Overlay Color, then, simply place the cursor over any point so that the cursor 
changes to the ‘hand’ cursor.  Then left click and drag the mouse and all of the mark 
points will move.  Release the mouse to complete the move.  Then click the ‘Move All’ 
button again to turn off this option.

5. Modified the ‘Point Scan’ logic so that the imaging galvos would be pointing at the 
desired spot before the acquisition actually begins.

6. In the ‘Linescan Control’ dialog, a control ‘Number of Lines to Skip’ has been added 
and the ‘Line Period [ms]’ control has been changed to simply be a display value.  If 
the operator wishes to skip every nth line during a linescan acquisition (as a way of 
controlling the time between each acquired line), then simply specify the number of 
lines using this new control and the value displayed in ‘Line Period [ms]’ will simply 
be the ‘Minimum Line Period [ms]’ multiplied by the number of lines to skip plus one.

7. Fixed a problem in the ‘Mark Points’ dialog where if the operator specified to save 
TriggerSync data, if the operator manually entered the desired file name, if the 
‘Enter’ key was not pressed, then the last character in the file name was not 
included.

8. Fixed a problem with the ‘Mark Stage’ option.  If the ‘Record Optical Zoom’ setting 
was enabled and the operator ‘marked’ stage locations using the right mouse button 
with the ‘Mark Stage’ option, the optical zoom was not being recorded.

9. Corrected a problem involving the link between Prairie View and either LinescanViewer 
or TriggerSync which would cause Prairie View to use excessive CPU time after either 
of these programs would exit.

10. Corrected a problem where sometimes when starting LinescanViewer or TriggerSync, they 
would not successfully ‘Connect’ to Prairie View.

11. A new option, ‘Preserve Base-Directory Names?’ has been added under the ‘Preferences; 
menu option.  When this item is checked, the ‘Base-Directory’ fields for Z-series, T-
series, Linescans, and all other acquisitions will use the entries from the previous 
session of Prairie View (as opposed to the default operation when this item is not 
checked, where the ‘Base-Directory’ field is automatically set at program start to 
something like ‘Z-Series-04012010-0923’).

12. Within the ‘Action’ dialog (Tools -> Actions), a ‘Before Scan’ action has been added.
13. TriggerSync modifications:

a. New version is 1.5.3
b. Modified so that the ‘IMAQ Tools’ window is only displayed when the operator 

presses the ‘Show Tools’ button in the ‘Image Control’ section of the main 



window.
c. Corrected a communication issue with Prairie View so that the ‘ACQUIRE_READY’ 

response is properly issued during combined acquisitions.
d. Added an ‘Exit’ option under the ‘File’ menu option.
e. Within the ‘Acquisition and DAC Output Setup’ dialog, ‘Reset’ buttons have been 

added for each of the ‘Protocol’ options (except for G.F.C. which only has a 
single value).

f. Increased the number of 'Load Parameters' buttons from six to twelve.
g. Modified all dialogs so that the scroll bars are no longer present.

14. LinescanViewer modifications:
a. New version is 3.7
b. Corrected a problem if a data set included multiple linescans (straight line 

only, not freehand or circle), and the location of the linescan data varied 
from linescan to linescan, the incorrect starting/ending values were being used 
to generate the line profile data.

c. Displays for the ‘Profile’ data range as well as for the ‘TriggerSync’ data 
range for the y-axis of the graph have been added.

d. Above the graph area, a ‘Notes’ field has been added that will display any 
‘Notes’ that were saved with the Prairie View generated linescan images.

e. Modified so that the reference image and linescan image would not automatically 
zoom to 1.0, thus overriding the operator zoom settings.

f. Under the ‘Display’ menu option, added the option ‘Reset Image Windows’.  When 
this option is selected, the ‘zoom’ value for each window will be set to 1.0, 
and the image window size will be adjusted to fit the size of the image.

Version 4.0.0.29

1. Removed correction made for Olympus BX-61 microscope in version 4.0.0.27.  That 
modification led to slight ‘pauses’ in the image display during ‘Live’ scan or 
Playback mode.

Version 4.0.0.28

8. Modified the Z-Series ‘table’ of settings so that if the operator is manually editing 
a value in a ‘laser line’ column, and the laser line is in either ‘Attenuation’ or 
‘Calibrated’ mode, the proper value will now be generated.

9. Modified the ‘Custom Laser Gradient’ dialog so that the vertical (Y-axis) scale is 
displayed in the appropriate units based upon the laser control mode (‘Default’, 
‘Attenuation’, or ‘Calibrated’).

10. Modified to support the ‘CoolSnap K4’ camera by Photometrics.
11. Within the XY-Stage controls, the ‘Grid Definition’ logic was slightly modified to 

prevent the generation of unnecessary stage locations when the ‘Add to Grid Locations’ 
or ‘Replace Grid Locations’ button was pressed.

12. Prairie View Scripting:
a. New commands have been added; ‘LinescanMode’, ‘GetFreehandLine’, ‘GetROIs’, 

‘ClearBOTs’, and ‘ClearROIs’.
b. See the scripting help dialog found in the ‘Edit Scripts’ dialog for a complete 

description of all script commands.
13. Corrected a problem where an ROI is currently selected, a Photo Activation mask was 

created for the ROI image, and in a T-series cycle, the PA mask could not be selected 
in the ‘Photo-activation’ column in the T-series unless an ‘ROI’ cycle with the 
current ROI definition was set first.

14. A new option has been added to the ‘Actions’ dialog (located under the ‘Tools’ menu 
option).  There is now a dedicated action for ‘Regions of Interest’.

Version 4.0.0.27



1. Prairie View Scripting:
a. New command has been added; ‘SendTriggerSyncString’.
b. See the scripting help dialog found in the ‘Edit Scripts’ dialog for a complete 

description of all script commands.
c. Corrected a problem when trying to use the ‘WaitForInputTrigger’ script command 

within a T-series.
2. Within the Z-Series, a new feature has been added.  Under the ‘Laser Power Gradient’ 

option, a ‘Manual’ option has been added.
a. When the operator selects ‘Manual’, the table of settings for the Z-Series is 

changed so that the operator may ‘manually’ enter a value in any of the fields.  
The only exception to this is that the operator may not enter values in the 
first column (‘Position’), with the exception of the first row (start position) 
or last row (stop position).  This allows the operator complete freedom over 
the desired Z-Series settings.

b. If the number of slices in the Z-Series is changed, there is no guarantee as to 
what will happen to the settings in the table when in ‘Manual’ mode.

3. Modified the logic for the Olympus BX-61 integrated Z (focus) control to eliminate the 
problem on some systems of the manual controls on the BX-61 becoming inactive 
periodically.

Version 4.0.0.26

1. Corrected a problem where the preamplifier was resetting to default settings when 
reset, after a reset the preamplifier now recalls the settings prior to the reset.

Version 4.0.0.25

2. Corrected a problem when Prairie View was exiting and the MAMC was not being properly 
‘released’.

Version 4.0.0.24

1. Modified Prairie View so that it can be configured to run with an XY-stage, but no 
focus (Z) device.

2. Modified Prairie View so that when a ‘Label’ is executed in a T-Series, the label 
settings will take effect immediately, not when the next image is acquired.

3. Corrected a problem where sometimes the ‘MIP’ button is not active when Playback mode 
is active.

Version 4.0.0.23

4. Added support for the serial communication link for the MAMC (Multi-Axis Motor 
Controller).

5. Prairie View Scripting:
a. New command has been added; ‘WaitForInputTrigger’.
b. See the scripting help dialog found in the ‘Edit Scripts’ dialog for a complete 

description of all script commands.

Version 4.0.0.22

1. Prairie View Scripting:
a. New command has been added; ‘Perform3DUncaging’.
b. See the scripting help dialog found in the ‘Edit Scripts’ dialog for a complete 

description of all script commands.



2. Within the Mark Points controls, the ability to mark points with the ‘Enable 3D’ 
option checked (turned on) has been extended to all Z (focus) devices, not just 
limited to piezo drivers any longer.  Obviously, the act of having to coordinate Z 
movement via a motor with the galvanometer movement will be quite slow due to the 
necessity to coordinate these actions between Prairie View (controls the Z device) and 
TriggerSync (controls galvo movement and other uncaging signals) for every single 
marked point.  There are two options available to the operator to control the speed/
point order for the 3D uncaging.  These options are selected based upon the ‘Maintain 
Point Order’ checkbox.

a. If ‘Maintain Point Order’ is checked (default state), then the uncaging 
experiment will proceed from point to point in the order in which the points 
were defined.

b. If ‘Maintain Point Order’ is not checked, then the uncaging experiment will 
proceed on a slice by slice basis based upon the Z-series definition.

i. If any marked points exist for the given slice, then the number 
of pulses for the output waveform will be automatically adjusted based 
upon the number of points, and then those points will be ‘uncaged’.

3. Corrected a problem with the ‘Playback’ of certain T-Series acquisitions that include 
BOT data.

4. Corrected a problem with the ‘0’ button associated with the XY Stage controls.  If the 
‘reset’ option is disabled for the XY Stage configured for the system, then this 
control will now be disabled.

5. Corrected a problem with the ‘0’ button associated with the Z Motor controls.  If the 
‘reset’ option is disabled for the currently select Z device, then this control will 
now be disabled.

6. Corrected a problem so that the preamplifier settings that were in use for the ‘gain’ 
and ‘offset’ that were in use when Prairie View was exited will be recalled when 
Prairie View is started again.

7. Corrected a problem where the image display would stop updating during a scan (Live 
Scan or Single Scan) if the ‘Measurement’ tool was activated without the ‘Display 
Profile’ option being ‘checked’.  The image display would not update until the 
‘Profile’ dialog had been displayed at least once.

8. Corrected a problem for dual scan systems (include the AOD (high speed optics)).  If 
imaging in galvo mode and the scan rotation is other than 0.0, when switched to AOD 
mode, if the scan settings (dwell time, optical zoom, and image resolution) were 
adjusted, an incorrect waveform could be generated for the y-galvo leading to 
incorrect images being created.

Version 4.0.0.21

1. Prairie View Scripting:
a. Two new commands have been added; ‘LoadROIFile’ and ‘ROILoad’.
b. The ‘ExecuteScript’ command has been augmented so that a new option for the 

value of the ‘iterations’ parameter is available.  The new option is ‘allROI’.  
When this value is used, the specified script will be executed for each of the 
current ROI definitions.

c. See the scripting help dialog found in the ‘Edit Scripts’ dialog for a complete 
description of all script commands.

2. Added a ‘None’ camera option for the SFC or stand-alone camera mode in the 
‘PrairieConfigUtility’.  This allows Prairie View to run and control the SFC without a 
camera connected/controlled by Prairie View.  Much of the capability of Prairie View 
will not behave as expected however when the ‘None’ camera is selected (e.g. the BOT 
feature will run, but the data will only be 0s).

Version 4.0.0.20

1. Within the ‘Linescan Control’ dialog, a new checkbox ‘TriggerSync short name’ has been 
added.  When this box is checked, if TriggerSync experiments are being run with the 
linescan acquisition, the automatically generated TriggerSync file names will not 
include ‘_Data_Line000001’.



2. In TriggerSync 1.5.2
a. In the 'Acquisition and DAC Output Setup' dialog, a new field has been added in 

the 'Acquisition Setup' area, 'Maximum Acquisition Time Warning (ms)'.  If the 
operator specifies a value for the 'Acquisition Time' that exceeds this value, 
then a warning will be displayed asking the operator if they really wish to 
specify an 'Acquisition Time' that exceeds the 'Maximum Acquisition Time 
Warning' value.

3. Within the ‘Linescan Control’ dialog, if the operator clicks on the ‘Append 
Linescan(s)’ button, then in the ‘status’ window (located in the upper right hand 
corner), will display ‘Acquiring n of m’ where ‘m’ would be the new total number of 
linescan acquired and appended into one data set.  Previously, it would always display 
‘Acquiring n or m’ where m would be based upon the value in the ‘Repetition Count’ 
field.

4. Modified the various controls that use a horizontal or vertical scroll bar to work 
with the mouse ‘wheel’.  When the ‘focus’ is on a given control (e.g. PMT HV), if the 
mouse wheel is moved, the control will increase or decrease (depending upon direction 
of wheel motion).

5. Within the ‘Mark Points’ controls in Prairie View, if the ‘Delete All’ button is 
pressed, then the numbering for the various types (Point, Freehand Line, Line, and 
Grid) will start at 1 again.

6. ‘Timed’ Mode within the SFC controls now supports triggering from a start of frame 
signal (e.g. ‘Expose Out’ from the camera).  This will eliminate the ‘dark/blank’ 
frame at the start of acquisitions.

7. When in SFC mode, additional unused controls are now hidden.
8. Updated LinescanViewer to version 3.6

a. Corrected a problem where if previously acquired/processed data is loaded into 
the application and then ‘File->Export All Data’ is selected from the menu, any 
‘Profiles’ that were part of the loaded data were being exported with all ‘0.0’ 
values.  This problem has been corrected.

b. Added two new controls ‘Graph X-Axis Size’ and ‘Graph Y-Axis Size’ that allow 
the operator to increase the size of the graph area (and the corresponding 
application window size).  These values are saved and automatically recalled 
when the applications is stopped and started.

9. Corrected a problem with the ‘MoveToStagePosition’ script command where the target 
position was not always properly reached.

Version 4.0.0.19

1. Within the ‘Playback’ controls, the operators settings for the ‘Loop’ and ‘Wrap’ 
option are retained and reset between Prairie View sessions.

2. Corrected a problem where the system could not be switched into ‘AOD’ mode if the 
system was so equipped.

Version 4.0.0.18

1. Within the saved Z-Series definitions, the trigger start option (No input trigger for 
Z-series, Start Z-series with input trigger, Use input trigger for each image) is now 
saved as part of the Z-series definition.

2. Added scripting command; SingleScanTriggered.
3. Corrected a problem with the LUT controls when moving between ‘live’ imaging and 

‘playback’ of images.
4. Modified the scripting commands; SetZSeriesStart and SetZSeriesStop

Version 4.0.0.17

1. Added an ‘Abort Script’ menu option under the ‘Tools->Scripts’ menu option.  This 
option is enabled when a script is started from the menu, not when a script is 
executed from the ‘Scripts’ dialog.  It is automatically disabled when the script has 



finished executing.
2. Modified the T-Series logic so that if the ‘Photoactivation’ option is other than 

‘None’, the operator may still select the ‘Max Speed’ option as well.
3. Corrected a problem with certain T-Series that could cause the software to lock up.  

This problem was created when a T-Series was defined with a ‘Label’, then and ‘ROI’ 
selection, followed by an image acquisition cycle that include a Photoactivation 
definition being applied to the ROI definition.  This has been corrected.

4. Added scripting commands; SetFrameAveraging.
5. Corrected a problem within the LUT dialog.  If both cursors for a given channel were 

‘dragged’ down to the ‘0’ (left) end of the graph, a ‘divide by zero’ error would be 
generated.  This has been fixed.

6. To correct a problem where sometimes at program start, the preamp does not properly 
initialize, the ‘Reset Preamp’ logic is invoked at the end of the program start to 
minimize the chance of the preamp not initializing properly.

Version 4.0.0.16

1. Modified the logic when a Sutter DG-4/5 is being used.  If a live scan is being 
performed and the operator changes the output galvo position (by adjusting the laser 
slider), the live scan will be temporarily halted while the adjustment is made, then 
the live scan should be automatically re-started.  The same will happen if the ‘Zero’ 
button is pressed.

2. Within the ‘XY-Stage’ tab, when a grid definition is set, if a different Z position 
was used for the starting and stopping locations, an incorrect Z position was being 
calculated for each stage location in the grid definition.

3. Corrected a problem within the T-Series setup where a ‘Script’ cycle could not be 
‘inserted’ into the T-Series.

4. Corrected a problem when the ‘0’ buttons for XY-Stage or Z in the ‘Stage Control’ 
section of the user interface.  If the device does not support the ‘0’ function, then 
no action will take place.  For example, if the device does support the ‘0’ function 
and a table of XYZ stage positions existed, when the ‘0’ button for the XY-Stage is 
pressed, this table will be recomputed with the necessary offsets to keep the stage 
locations correct even though the current XY position has been set to (0.0, 0.0)

5. Added the ‘Wait’ command as a new script command.
6. Modified the logic so that if a ‘Live Scan’ is executing when the scan mode is 

switched between galvo and AOD (or vice versa) or switched between AOD modes, the scan 
will be temporarily stopped and then re-started again automatically.

7. Added additional commands to the ‘Scripting’ option; ‘Wait’, ‘MoveToStagePosition’, 
‘SetOpticalZoom’, ‘Linescan’, and ‘TriggerSyncExperiment’.

8. TriggerSync 1.5.2 is now released.
a. The ’TTL Trigger Start’ option under the ‘Acquisition->Start Experiment’ menu 

option has been modified.  The operator may now select which ‘PFI’ line (0-7) 
to use for the triggered acquisition start.  To select the desired PFI line, 
open the ‘Preferneces’ dialog found under the ‘Configuration’ menu option.  The 
last value (at the bottom of the dialog) allows the operator to select the 
desired PFI line.  After this dialog is closed, the ‘TTL Trigger Start’ menu 
option under ‘Acquisition->Start Experiment’ will be automatically modified to 
display the PFI line that was selected.

i. For this feature to work, the trigger signal must be physically 
connected to the selected PFI line on both the PCI-6052E and the 
PCI-6713.

ii. The selected PFI line will remain in effect even when 
TriggerSync is exited and re-started until the operator changes the PFI 
line selection.

b. Corrected a problem with Functional Mapping acquisitions.  The first 'point' is 
'hit' twice, and the last point is never 'hit'.  This has been corrected.

c. Corrected a problem with the display of the 'electrical map' data within the 
Functional Mapping analysis feature.  When there was more than one pixel 
between each of the acquisition points, the generated image was slightly larger 
than it should have been.  This has been corrected.

d. Modified the display of the 'electrical map' for Functional Mapping so that the 
electrical map image matches the extracted 'Map Region' image in size.



Version 4.0.0.15

9. Corrected a problem with pockels cell control for the Dual Galvo Scanning feature.

Version 4.0.0.14

10. Corrected a problem within the ‘Z-Series’ controls.  When the ‘Goto’ Middle Position 
button was pressed, an improper setting was being used for the laser and PMT settings.  
This did not affect the actual Z-Series.

11. When the Photo Activation (PA) controls are active, if the operator clicks on the 
‘Clear’ button, if no selection has been selected using the ‘Selection Tool’, then the 
operator will be prompted if all PA regions should be deleted before taking any 
action.  Previously, if no selection had been made all regions were automatically 
deleted without any control by the operator.

12. Corrected an issue when using Scientifica stages where the X axis was being moved when 
the intent was to move the Y axis and vice versa.

13. Corrected a problem where a switch state was not being properly set for the Dual Galvo 
Scanning feature.

Version 4.0.0.13

14. Modified the output trigger logic so that the start of frame trigger will not be 
accidentally sent at the end of a single scan image.

15. Modified the T-Series logic so that if the very last cycle to be executed in a T-
Series is a ‘Wait’ cycle, that particular cycle will not be executed so that there 
will be no unnecessary delay at the end of the T-Series.

16. Added a new feature to allow for simultaneous scanning with both sets of galvonometers 
(imaging and uncaging) if the system is equipped with the proper hardware.

a. In the current implementation, this feature requires the addition of a second 
PCI-6713 card and associated hardware.  In addition, there is a switch box 
needed for proper signal routing for control of the shutter and pockels cell on 
the uncaging path.

b. If this feature is enabled (via the ‘PrairieConfigUtility’ program), it is only 
available when TriggerSync is running as well.  This is necessary since the 
location of the scan area for the uncaging galvos will be based upon the 
uncaging calibration data within TriggerSync.

c. To activate this feauture, either right click on the ‘ROI’ button in an image 
window or click on the menu button located next to the ‘ROI’ button and select 
the ‘Enter Dual ROI’ option.

i. Draw the desired ROI in the image window and when you are 
finished drawing a second ROI will automatically appear located directly 
on top of the first ROI.  Click in the ROI and move it and you will see 
that the ROI is labeled ‘Uncaging’ will move.  This ROI defines the 
location of the scan area for the uncaging galvos, while the other ROI 
defines the location of the scan area for the imaging galvos.

ii. A current restriction of this feature is that the two ROIs must 
be of the same size, so if the operator wishes to resize the ROIs, he/
she must click on one of the boxes located on the sides and corners of 
the imaging ROI and then simply click and drag to change that particular 
dimension.  As the imaging ROI is resized, the uncaging ROI will be 
automatically resized as well.

iii. After the size and location of the ROIs is defined, the operator 
may select the ‘Save ROI’ button at the top of the image window to save 
these definitions.  When this definition is later recalled/loaded 
(either directly from the ROI button or via the ROI cycle within a T-
Series), the dual scan mode will be automatically set.

iv. If the ‘Cancel ROI’ button is pressed, then the ROI mode is 



exited.
v. If the ‘Enter ROI’ button is pressed, then the system will 
automatically enter the dual galvo scanning mode.  If the operator 
performs a ‘Single Scan’, ‘Live Scan’, or acquisition, it will be 
performed in the dual scanning mode.

Version 4.0.0.12

17. Corrected a problem where sometimes the camera binning factor (either stand alone 
camera or SFC camera) was not being transmitted to TriggerSync which could lead to 
issues with uncaging with the 2-P laser using the camera image as a reference.

18. When the laser control(s) within Prairie View were configured as 
PVAnalogOutputDAQBuffered type, during Z-series and T-series it was possible that the 
first couple of lines in the image, starting with the second image in a sequence, 
would be blank because the laser line(s) were not being turned on at the proper time.  
This has been rectified.

19. Added a new command to the list of available script commands; ZeissMicroscope.  This 
allows for the control of various mechanical components on the Zeiss Axio line of 
microscopes when the microscope control is integrated into Prairie View.  A complete 
description of the syntax is found in the script html file accessed from the script 
dialog.

Version 4.0.0.11

20. Corrected a problem when performing Z-Series from within a T-Series and the ‘Trigger 
Cycle’ or ‘Trigger Rep’ option is checked.  Only the first Z-Series acknowledged the 
need to wait for the receipt of the input trigger signal.

21. Fixed a problem where when switching into AOD mode (for dual scan systems), the 
display of the preamp filter was not being properly updated.

22. Added a new button to the ‘Scan Rotation’ controls.  This button allows the operator 
to define the amount of adjustment applied when the scan rotation scroll bar is 
‘clicked’ on (as opposed to ‘dragged’).  When set to ‘Coarse’ the large step size 
(clicking on the scrollbar directly) will result in a change of 10.0, the small step 
size (clicking on the left or right arrow at the ends of the scrollbar) will result in 
a change of 1.0.  When set to ‘Medium’ the large step size is 2.5 and the small step 
size is 0.25.  When set to ‘Fine’, the large step size is 1.0 and the small step size 
is 0.01.

23. Within the ‘PrairieConfigUtility.exe’ program, on the ‘XY’ tab, a new parameter has 
been added ‘Swap X and Y Axes’.  If this option is ‘checked’ then the left/right arrow 
buttons in Prairie View associated with the stage control will actually move the y 
axis and the up/down arrow buttons will move the x axis of the stage.  This is only 
necessary if the orientation of the image in Prairie View is rotated 90 degrees 
relative to the stage motion.

24. Within the ‘PrairieConfigUtility.exe’ program, on the ‘XY’ tab, a new set of 
parameters have been added that allow the system to be configured to control two 
separate XY stages via the MAMC (Mult-Axis Motor Controller’) hardware.  These 
‘auxiliary’ axes are only configured for control via the MAMC remote interface (little 
box with three wheels).  The auxiliary axes are not controlled via the Prairie View 
software.

25. Corrected a problem where within a T-Series, if the ‘Max Speed’ option is selected and 
an ROI is being used at an optical zoom greater than 1.0, in certain situations, the 
displayed ‘Period’ within the T-Series was not being properly computed and so it would 
not match the displayed ‘Frame Period’ field displayed within Prairie View.

Version 4.0.0.10

26. For systems equipped with the MAMC, when the ‘Reset Multi-Axis Motor Controller’ menu 
option is selected under the ‘Tools’ menu option, the software will now re-initialize 



the communication connection to the MAMC.
27. Minor internal software change to improve program efficiency.
28. Corrected a problem that can occur when attempting to activate the ‘MIP’ mode.  

Sometimes the mode would not be activated or the software could potentially crash.  
This was caused by trying to display the MIP data based upon the cursor location in 
the image window before the actual MIP data was completely computed.

29. Modified the logic related to waiting for focus and stage movements via the ‘Device 
Control Box’ to finish before allowing the scan to start.  This should allow the code 
to run as efficiently as possible and eliminate ‘time-out’ conditions in acquisitions 
using the focus and/or stage.

Version 4.0.0.9

30. On the ‘XY-Stage’ tab a ‘Record Optical Zoom’ checkbox has been added.  This option, 
when checked, allows the operator to record the current optical zoom value at the time 
when the stage location is added to the table.  When an XY-Stage location that 
includes an optical zoom value is referenced (via T-Series, Z-Series, and etc.), the 
optical zoom will be set accordingly.  If a stage location does not include the 
optical zoom value (indicated in the table by ‘---‘, then the optical zoom will not 
change.

a. Regardless of the state of the checkbox for ‘Record Optical Zoom’, if the ‘Add 
to Grid Locations’ or ‘Replace Grid Locations’ button in the ‘Grid Definition’ 
controls is pressed, the optical zoom will be recorded.  This is necessary 
since changing the optical zoom after defining the grid locations would 
invalidate the grid definition with regards to image overlap.

31. Corrected a problem with the resizing of BOT regions that were originally created as 
circles or squares (shift key held down while drawing the regions).

32. When the ‘Center Galvos’ option is enabled under the ‘Tools’ menu item, a check will 
appear in front of the option.  When a scan is started or the ‘Center Galvos’ option 
is disabled, the check will be removed.

Version 4.0.0.8

33. In the ‘Line Profile’ dialog (activated via the ‘Measurement’ button in the image 
windows) an ‘Export…’ button has been added.  When this button is pressed the operator 
will be queried for the directory and file to use for saving the data currently 
displayed in the graph window to a spreadsheet compatible file.

34. Added a context menu to the ‘Meausrement’ button in the image windows.  If the 
operator clicks on the downward pointing arrow button or left clicks on the 
‘Measurement’ button, the context menu will be displayed.

a. The context menu option ‘Display Profile’, is a switch/state that is either on 
(checked) or off (unchecked).  When checked or on, if the Measurement button is 
pressed, the ‘Line Profile’ dialog will be displayed along with the measurement 
line in the image window.  When unchecked or off, if the Measurement button is 
pressed, the ‘Line Profile’ dialog will not be displayed.

35. Added some new features to the ‘Mark Points’ controls within Prairie View.
a. In the ‘Point Options’ section there is a new combo box control ‘Display’ with 

the options ‘Cross hairs’ and ‘Point’.
i. ‘Cross hairs’ is the default mode and is how the individual mark 
points have been previously displayed.  Each point is displayed with a 
cross hair patter.  The size of the cross hair is scaled up and down 
with the size of the image display.

ii. ‘Point’ will display the marked point as just a collection of a 
few pixels.  The size of the ‘point’ display does not scale up and down 
with the size of the image display.  This mode could be useful for 
closely spaced points in making it easier to differentiate between them.

b. Under the ‘Delete All’ button a ‘gradient’ control has been added allowing the 
operator to control the ‘opacity’ of the displayed mark point graphics (points, 
indices, and etc.).  Increasing the opacity value allows for easier 
visualization of the mark point graphics.  Decreasing the opacity value allows 



for easier visualization of the image data ‘behind’ the mark point graphics.
36. Under the ‘Tools’ menu, if the system includes a Prairie manufactured piezo objective 

controller, a new option ‘Tune Piezo …’ has been added just after ‘Calibrate Piezo 
Focus’.

a. When the operator selects this option, a new dialog will appear.  The dialog 
contains instructions for the piezo tuning process.

Version 4.0.0.7

37. Added support for the Sutter DG-4/5 light source.  This includes manual control of the 
device as well as high speed synchronization with a digital camera.

a. Each filter position for the DG4/5 will appear with in the Laser Line control 
panel.  The controls for the DG-4/5 are available when the ‘Camera’ operating 
mode is the current operating mode.

i. Clicking on the ‘Blanked’ button will cause the DG-4/5 to open 
the shutter for the desired wavelength.  Clicking on the ‘Unblank’ 
button will cause the shutter to close.

ii. If one particular wavelength is ‘Unblanked’ and the operator 
presses the ‘Blanked’ button on another wavelength, the previously 
unblanked wavelength will be blanked and the new wavelength will be 
displayed.

iii. Coming from the factory, each filter position is calibrated for 
maximum light output (this is included on a sheet included with the 
DG-4/5).  The slider control in Prairie View for each filter/wavelength 
is used to control the position of the output galvo for that particular 
filter.  Adjusting the position of the output galvo for a given filter 
position is the only way to control the strength of the light for a 
given filter/wavelength.

1. Prairie View will ‘remember’ the value for the output galvo for 
each filter when it is changed by the operator so that when the 
program is stopped and started, the controls will come up with 
the proper values.  If the output galvo position is modified via 
other software or via the control panel of the DG-4/5, then when 
Prairie View is started it will not display the correct value 
since there is no capability to query the DG-4/5 for the current 
output galvo position for each filter position.

2. If the operator wishes to reset the output galvo position for a 
filter/wavelength back to the factory calibrated maximum output 
position, then press the ‘Zero’ button associated with the 
desired filter.  This process could take 10 seconds or longer 
and the operator can watch the front panel of the DG-4/5 for the 
status of this process.

b. Image collection when using the DG-4/5 is accomplished using a digital camera.  
Obviously, only one filter/wavelength may be used at a time.  Since Prairie 
View supports multiple channels, it is necessary to associate a filter from the 
DG-4/5 with a channel within Prairie View.  This is accomplished by clicking on 
the desired channel button located below the slider control.  The operator is 
prevented from associating more than one filter with a given channel.  It is 
allowed to have no channel associated with a given filter.

i. Once a filter/wavelength is associated with a particular 
channel, it is only necessary to select that channel in at least one 
image window to be able to acquire images with the associated filter.  
Whenever an acquisition is performed (single scan, live scan, T-series, 
Z-Series), all channels that are turned on in any image windows will be 
acquired.

1. For example, let’s say that a 488 filter is associated with 
channel 1 (Ch 1) and a 568 filter is associated with channel 2 
(Ch 2).  If two image windows are open, but only Ch 1 is turned 
on, then when an acquisition is started, only the images 
generated by the 488 filter will be acquired.  If two image 
windows are open and Ch 1 is turned on in one and Ch 2 is turned 
on in one, then when an acquisition is started, two images will 



be automatically acquired (one at 488 and then immediately one 
at 568).

2. If performing a T-Series, the number of iterations multiplied by 
the number of different channels that are turned on in the image 
windows will determine the total number of images acquired.

c. Synchronization between the camera and the DG-4/5 is achieved by connecting the 
‘Expose Out’ BNC connection on a Photometrics camera to the ‘STROBE’ BNC 
connection on the DG-4.

d. After any single image, z-slice, or max-speed acquisition, the DG4/DG5 will 
remain illuminating with the last filter used for a brief period (typically 
less than 800 ms) before being “shuttered”.  If you need to monitor the 
illumination time to account for phototoxicity or photobleaching, you may 
monitor the DG-4/5 galvo drive signal by connecting to the ‘DAC’ BNC on the 
back of the unit.  The voltage level output corresponds to one of the filter 
positions (or the “blanked” filter position of approximately 0 volts).

e. Filter changes begin at the start of a camera exposure, so images will contain 
a small amount of fluorescence signal from the previous filter position as the 
galvos move the light path away from the old filter and onto the new filter 
(duration of illumination with old wavelength is typically less than 600 µs).  
If the new filter position is not adjacent to the old one, other wavelengths 
may illuminate the sample briefly, and more of the exposure time will be spent 
without the correct wavelength exciting the sample.  The shorter your exposure 
time is, the more this transition period will influence the signal in the 
image.  Therefore, while you are able to choose an exposure time that is 
shorter than the frame period of the camera, doing so is not recommended.  

f. The data sheet for your camera should have a table with frame rates listed for 
some common binning and ROI settings at the fastest readout speed.  Otherwise, 
you can get the approximate frame rate by setting a short exposure time and 
doing a live scan, then viewing the measured average frame rate by selecting 
Frame Rate from the Display menu in Prairie View.  You can also monitor the 
camera’s ‘Expose Out’ signal to more accurately measure the period.

i. CAUTION: On some camera models first exposure’s period may not 
be the same as subsequent exposure periods.

Version 4.0.0.5

38. For the line of Zeiss Axio microscopes, added software control for the Motorized Stage 
(XY), Optovar, Motorized Objective Lens Changer, and Motorized Sideport Turret.

Version 4.0.0.4

39. Corrected a number of problems related to the LUT.
40. Added a new feature with the Z-Series.

a. There is a new check box option labeled ‘Acquire until n% drop in image 
intensity detected’.  Where n is set by the operator (1-100).

b. When this option is enabled, the Z-Series is defined as normal, but during the 
Z-Series, each image is compared to the image before it and if the overall 
image intensity has dropped below the specified percentage change from the 
previous image, then the Z-Series will be automatically terminated at that 
point.

c. All of the images up to that point will be saved with the acquisition.
d. If a Z-Series with this option enabled is being executed from within a T-

Series, BOT data can not be collected simultaneously and the BOT check box will 
be disabled.

41. Added ‘Scripting’ capability to Prairie View.

Version 4.0.0.2



42. Corrected some software related to the preamplifier after support was added for 
multiple preamplifiers.

43. Modified the ‘Confocal’ control diagram to accurately portray the B/G light path with 
respect to the dichroic.

44. On the ‘XY-Stage’ tab, added a ‘Shift Selected Location’ button.  When this button is 
pressed, the currently selected stage location (as indicated in the XYZ stage position 
table) will have it’s location modified to match the current stage location.

Version 4.0.0.0

45. Added the ability within T-Series when a TriggerSync experiment is to be used that the 
operator may select which TriggerSync experiment to run.  This is set under a new 
column in the T-Series dialog ‘TriggerSync Parameters’.  The valid values are 0..6.  
Where 0 indicates to use the current TriggerSync parameter settings.  A value of 1..6 
indicates to use the settings associated with the ‘Load Parameters x’ buttons on the 
main panel.  If the T-Series setting does not correspond to a valid selection in 
TriggerSync, then the current TriggerSync parameter settings will be used.

46. For many controls, added the ability to ‘tear-off’ or move the controls from their 
respective location in the main interface and placed wherever the operator desires on 
the computer desktop.  To ‘tear-off’ the controls, the operator must first click on 
the diagonal arrow button located on the right side of the control group label.  
Prairie View will remember these selections and when Prairie View is subsequently 
started, these controls will be brought back in their last location.  After placing 
these controls on the desktop, if the operator clicks on the ‘X’ in the upper right 
corner, the controls will revert back to their original location in Prairie View

47. Added a new ‘Mark Point’ feature to the T-Series.
a. When used with TriggerSync and ‘Mark Points’ are generated, a new ‘Mark Point’ 

T-Series cycle option is activated as well as a checkbox option ‘At all Mark 
Point locations’

b. If the checkbox option ‘At all Mark Point locations’ is selected, then the 
entire list of T-Series cycles will be repeated at each mark point.  This 
option makes it very easy to create an experiment where the operator may repeat 
something for every mark point.

c. If the ‘Mark Point’ cycle option is used, this allows the operator to go to any 
of the Mark Points at any point in a T-Series.  This option could be useful if 
the operator wishes to perform a different TriggerSync experiment at different 
mark point locations.

48. Corrected a problem that will sometimes occur when exiting the Playback mode while an 
image loop is ‘running’, the dwell time control for ‘Averaging/Summing’ will be 
accidentally set to ‘Summing’ internally even though the display will still read 
‘Averaging’.

49. Added support for the Prior ProScan II XY stage.
50. Added support for a new Confocal module (including motorized pinhole selection, 

dichroic selection, and emission filter selection).
51. Modified the region drawing tools for the ‘ellipse’ and ‘rectangle’.  If the shift key 

is held down while an ellipse is being drawn, the shape will be constrained to a 
circle.  If the shift key is held down while a rectangle is being drawn, the shape 
will be constained to a square.  This feature applies to drawing an ROI, a region for 
BOT (Brightness Over Time), or PA (Photo Activation) shapes.

52. Added a new feature for use with automated XY stages.
a. Overview:  This feature is designed around the idea that an operator would be 

using a low magnification lens to view a large sample area.  Within that sample 
area (or within an even larger area if the stage is moved) the operator might 
want to identify specific areas that he/she would like to image at a higher 
magnification.  With this new feature the operator can simply click in the 
image (similar to marking points for uncaging experiments) to record the XY 
stage location.  This location will be recorded in the table of XY stage 
locations located in the XY-Stage tab.  Then, after switching to a higher 
magnification lens, the operator may quickly move between the recorded stage 
locations for further analysis.

b. Setup:
i. To take advantage of this feature, the ‘Mark Stage’ option on 



the UI tab in ‘PrairieConfigUtility.exe’ must be checked.  In addition, 
the currently selected objective lens in Prairie View must be 
calibrated.

ii. Next, in the lower right hand corner of the ‘XY-Stage’ tab in 
Prairie View there are two new check boxes, ‘Invert X Travel for Mark 
Stage’ and ‘Invert Y Travel for Mark Stage’.  To determine the proper 
value for ‘Invert X Travel for Mark Stage’, start a ‘Live Scan’ with an 
image where you can discern the sample moving left/right and up/down.  
Click on the ‘Mark Stage’ button to activate the feature (the button 
will turn green).  While the ‘Live Scan’ is running, place the mouse 
cursor about half-way down the image in the y dimension (if y dimension 
is 512, the y cursor position should be near 256).  Now place the cursor 
a little bit left or right of the center of the image and click the 
‘left’ mouse button.  The sample area that was under the cursor should 
move to the center of the image.  If the sample area under the cursor 
moved further from the center, then change the status of the ‘Invert X 
Travel for Mark Stage’ value and repeat the test.  The sample area under 
the cursor should now move towards the center of the image.  Repeat this 
test but attempt to move the sample up/down and set the value for 
‘Invert Y Travel for Mark Stage’ accordingly.  These settings will be 
saved and automatically recalled when Prairie View is stopped/started.

c. Use:
i. To use this feature, click the ‘Mark Stage’ button in the image 
window, then using the right mouse button, click in the image window to 
record stage locations for sample areas of interest.  Each time that the 
right mouse button is pressed, the operator should see an additional 
entry in the table of stage locations on the XY-Stage tab.

ii. If the left mouse button is pressed while the ‘Mark Stage’ 
feature is active, then the stage position will be changed to bring the 
point of image that was clicked on into the center of the field of view.  
It will not record that location in the table of stage locations.  
Please note, that clicking the left mouse button will induce a stage 
movement, while clicking the right mouse button only records a stage 
location.

iii. Located in the XY-Stage tab is a new combo box in the lower 
right hand corner that allows the operator to specify whether or not to 
display in the image windows an indicator for the currently defined XY 
stage table entries.

1. If the ‘Display Nothing’ option is selected, then there will be 
no indicators displayed in the image window when an XY Stage 
table entry falls within the field of view.

2. If the ‘Display Locations’ option is selected, then a cyan 
colored cross-hair with a polygon will be displayed at each 
stage location that falls within the field of view.

3. If the ‘Display Locations and Indices’ option is selected, then 
a cyan colored cross-hair with a polygon as well as the numeric 
entry corresponding to the XY Stage table entry will be 
displayed at each stage location that falls within the field of 
view.

iv. Since this feature uses the mouse buttons similar to the ‘Mark 
Uncage’ or ‘Mark Points’ feature, when ‘Mark Stage’ is enabled, the 
‘Mark Uncage’ feature will be automatically turned off and vice versa.

Version 3.3.7.15

1. Modified the Z-Series ‘Device’ selection combo box (only visible/active if a system is 
configured with multiple Z devices) so that it will operate properly while a ‘Live 
Scan’ is in progress.  It will remain disabled during T-Series, Z-Series, and other 
acquisitions.

1. Under ‘File->Preferences->Z-Series’ a new option has been added if the system is 
equipped with multiple Z devices.  This combo box allows the operator to ‘link’ or 



‘not link’ the two ‘Z Device’ controls in Prairie View.  One control is located on the 
Z-Series tab and one is located in the Stage Control panel of the main window.  If the 
option is set to ‘not link’ then the user may independently select a Z device to be 
used with the Z-Series definition and/or controls that might be a different device 
than the Z device selected in the Stage Control panel and associated with the Up/Down 
arrows in that control group.  If the option is set to ‘link’ the device selections, 
then selecting a Z device with one of these controls will cause the other control to 
automatically change as well.

2. Added logic so that when Prairie View is exiting, if the Ultima is a dual mode 
(contains AOD), it will set the system back into galvo mode.  This is necessary for 
proper start-up conditions regarding the new dual mode preamplifier.

Version 3.3.7.14

3. Corrected a problem when an Ultima is built with a GPIO Box and a TriggerSync 
experiment is run during a T-Series that controls the “hard” shutter on the Ultima.  
After the TriggerSync experiment has finished, when the next cycle is started, the 
“hard” shutter was not being opened again.

4. Corrected a problem where the Photo-Activation button in the image window was disabled 
during ‘Playback’ if the SFC was enabled as part of the system configuration.

5. Corrected a problem where the Photo-Activation switch was not being properly 
controlled.

6. Modified Prairie View so that after a data set is loaded into Playback mode using the 
‘File->Load Image(s)’ menu option, the data set directory is not ‘locked’.

Version 3.3.7.13

7. Corrected logic that affects certain control types, combo boxes, etc. and does not 
allow for selection of items that do not exist.

8. Added two additional commands for TriggerSync; ‘CAMERA_BIN_FACTOR’ and 
‘SFC_BIN_FACTOR’ (e.g. ‘SFC_BIN_FACTOR~2’).

9. Corrected a problem if the lasers were configured to use the 
‘PVAnalogOutputDAQBuffered’ type, if there was an odd number of laser lines defined, 
there were possible scan settings that would result in a National Instruments driver 
error and no drive signal would be sent for the laser lines.

10. TriggerSync Changes:
a. Version is now 1.5.
b. On the Point Calibration dialog, the size of the field showing the calibration 

file path/name has been enlarged to show multiple lines of text so that it 
won't appear as if the specified file name is not being used or some such 
thing.

c. Added support for ‘Mark Points’ being set from either a SFC image or from a 
stand-alone camera.  This feature allows the operator to calibrate the SFC or 
camera to the imaging and/or uncaging galvos of the Ultima.  They can then use 
the SFC or camera image to define the locations of the points (and the galvo 
set to use) for uncaging.

i. In the ‘TriggerSync.ini’ file, in the [Hardware] section, there 
is an entry ‘Number SFC Uncaging Galvo Sets’.  Set this value to 0 if 
there is no SFC or stand along camera integrated into Prairie View along 
with the Ultima.  Set this value to 1 if the Ultima only has imaging 
galvos.  Set this value to 2 if the Ultima has both imaging and uncaging 
galvos.

ii. In the ‘TriggerSync.ini’ file, in the [Photolysis Motion] 
section there are specific entries for both the SFC and Camera mode.  
These entries allow the operator to define the orientation of the 
imaging and/or uncaging galvos of the Ultima to the SFC or Camera image.

1. The first step is to determine if the SFC image or Camera image 
is oriented the same as the Ultima image.  Is the x axis of the 
Ultima the same as the x axis of the SFC or Camera.  If not, set 
the parameters ‘SFC Uncage Photolysis Switch XY’ and ‘SFC Image 



Photolysis Switch XY’ to ‘True’.  If they are on the same axis, 
then set these values to ‘False’.  The same logic applies to 
‘Camera Uncage Photolysis Switch XY’ and ‘Camera Image 
Photolysis Switch XY’ for the Camera.

2. Once that is set, then it is necessary to define the ‘SFC Uncage 
Photolysis Selection’ and ‘SFC Image Photolysis Selection’ 
values.  These settings determine the movement of the ‘spot’ 
image collected with the SFC based upon fluorescence from the 
uncaging galvos or image galvos of the Ultima.  Basically you’ll 
need a flourscent sample (dry erase red marker slide or 
something). Start imaging with the SFC (no SFC laser power) and 
then adjust the appropriate 2-P laser power and open the 
necessary shutter and move the ‘spot’ with the ‘Blue’ buttons in 
TriggerSync.  If left/right is reversed or up/down is reversed, 
change the setting for ‘SFC Uncage Photolysis Selection’ or ‘SFC 
Image Photolysis Selection’, save the TriggerSync.ini file 
changes and repeat the test.

a. As a reminder, a value of 0 means leave X and Y alone, 1 
means to reverse X (left/right), 2 means to reverse Y 
(up/down), and 3 means to reverse X and Y.

3. Once the ‘spot’ movement is correct, you calibrate the imagning 
or uncaging galvos of the Ultima to the SFC image using the 
regular ‘Point Calibration’ method in TriggerSync.

a. Specify a calibration file name that is indicative of the 
scan mode and galvo selection.  For example ‘SFC-
UltimaImagingGalvos’ or ‘SFC-UltimaUncagingGalvos’.

4. After the calibration is completed, on the ‘Mark Points’ dialog 
in TriggerSync, make sure that you are in the proper oprating 
mode (e.g. SFC with the uncaging galvos selected) and load the 
appropriate calibration file.  TriggerSync will retain this 
selection so when you switch between Ultima and SFC mode or 
change galvo selections, the proper calibration file will be 
loaded and used.

Version 3.3.7.12

11. Modified the logic for handling image acquisition requests (via the ‘Snap’ command) 
from TriggerSync.  This is intended to eliminate errors that sometimes occur when 
image acquisition is being controlled from TriggerSync, specifically when performing 
the uncaging calibration procedure.

Version 3.3.7.11

12. If ‘Single Scan Auto. Save’ is turned on, the directory containing the most recently 
saved image was not being displayed in the status area at the bottom of the main 
Prairie View window.

13. Modified so that the message that the ‘Thread was being aborted’ does not appear for 
the XYZ stage hardware when Prairie View is exiting.

14. Corrected a problem with acquiring images in AOD mode with ‘Average Every N Frames’ > 
1.

Version 3.3.7.10

15. Made some modifications to support the use of the Prairie GPIO box for dual scan 
(galvo and AOD) systems.

Version 3.3.7.9



16. Made some modifications to support the use of the Prairie GPIO box for dual scan 
(galvo and AOD) systems.

17. Added a new item to the ‘File’->’Preferences’ menu option, ‘Leave Soft Shutter Open’.  
When this item is ‘checked’ then the soft shutter will be opened and the control for 
the soft shutter will be disabled.  If the ‘blanking’ BNC input on the back of the 
Device Control Box is disconnected, coupled with ‘Leave Soft Shutter Open’ being 
checked, then the pockels cell output will never be turned off unless the laser 
intensity slider is set to 0.

Version 3.3.7.8

18. Added the value of the dwell time used during Point scan acquisitions to the XML file 
generated with the data.

19. At the end of an acquisition, the directory into which the images/data was saved is 
listed in the status area at the bottom of the main window.

20. Corrected a problem if background subtraction is turned on during a T-Series with the 
‘Max Speed’ option turned on.

Version 3.3.7.7

21. Modifications made to the software to support the Photo Activation feature when using 
the Prairie GPIO Box.

22. Change made to daq_int.dll so that data samples with an intensity of 0 are not 
discarded.

23. Corrected a problem with the ‘Mark Points’ option where if the operator selected to 
save the TriggerSync data when the experiment was executed via the ‘Acquire’ button in 
the image window, the file iteration value display was not being updated.

24. Corrected a problem with the ‘Mark Points’ option where if the operator selected to 
save the TriggerSync data when the experiment was executed via the ‘Acquire’ button in 
the image window, if the destination directory already contained files, and the 
operator selected to not over write the existing files, then the TriggerSync 
experiment would continue but no data would be saved.

Version 3.3.7.6

25. Modified default control of the Multi-Axis Motor Controller motors so that motors are 
not enabled.

Version 3.3.7.5

26. Modifications were made to support the Dodt detectors built using the quad servo 
board.

Version 3.3.7.4

27. Internal software modification.



Version 3.3.7.3

28. Added support to move the Multi-Axis Motor Controller Z Axis via an input pulse (e.g. 
end of frame trigger).

29. Under the ‘File’ -> ‘Preferences’ menu option a new item ‘Adjust Live display…’ has 
been added.

a. For some systems, newer versions of Prairie View (3.3.x.x) controls for the PMT 
high voltage and such don’t have the same response to operator adjustment as 
previous versions.  This is mostly due to corrections in the software.  If the 
operator wishes to improve that ‘feel’ then by selecting this option (placing a 
‘check’ in front of it), the number of updates to the image display will be 
reduced thereby improving response to control adjustments.  This only will 
impact the ‘Live’ scan mode.

30. Corrected a problem that would occur in certain T-Series experiments where the ‘Start 
with input trigger’ checkbox state would be improperly handled.

31. Corrected an issue with T-Series where the current cycle being executed during the T-
Series was not always being properly updated.

32. Corrected a problem that will sometimes occur when exiting the Playback mode while an 
image loop is ‘running’, the dwell time control for ‘Averaging/Summing’ will be 
accidentally set to ‘Summing’ internally even though the display will still read 
‘Averaging’.

Version 3.3.7.2

33. Modified the Playback logic so that when the stop button is pressed, the loop that is 
updating the display will stop as soon as possible.

34. If a Z-Series will contain more than 500 slides, the operator will no longer encounter 
a warning message informing them of this situation.

35. Modified the logic used during the ‘Live’ image acquisition mode to make the system 
more responsive to user adjustments to various controls such as the PMT settings, 
laser settings, and so on.

36. Modified the logic when the ‘Center Galvos’ option under the ‘Tools’ menu is selected.  
If the system is operating with a GPIO box, the shutter and laser controls will remain 
active.

Version 3.3.7.1

37. Modified the Point Scan feature so that when using the acquisition mode of a 
predefined acquisition time, that the acquisition will be terminated as quickly as 
possible after the acquisition time has been reached.  It currently acquires (and 
hence still exposes the sample) for about a maximum of 100ms after the desired time 
has been reached.

38. Within a T-Series, modified the ‘Wait’ command to be implemented more correctly.
39. Modified Prairie View such that when the Linescan Control dialog is open, if the LUT 

(Lookup Tables) are used, the linescan image will be updated.  If you are going to 
exercise this feature, then you should activate the ‘Freeze’ button on the image 
display(s) to keep the LUT adjustments from affecting the image display windows.

40. Added logic such that if one or more 2-P lasers are being controlled by Prairie View, 
when the operator chooses to exit Prairie View, if the laser shutter is open, the 
operator will be prompted as to whether the shutter should be left open or closed.

Version 3.3.7.0

1. Expanded the available features and controls for the Prairie built Piezo objective 



controller.

Version 3.3.6.0

1. Added new features for use when in AOD mode.  This new mode allows the operator to 
set/freeze one of three parameters (image resolution, dwell time, or optical zoom) and 
then as one of the other two parameters is adjusted, the software will attempt to 
automatically adjust the third parameter to provide a proper image.

a. The operator may choose to not set/freeze any of the parameters and then the 
software will operate just as it has in the past in AOD mode.

Version 3.3.5.4

2. Corrected some problems with linescan acquisitions.  These problems were related to 
very large linescan acquisitions (where the linescan was stored as several discrete 
pieces instead of a single file).

3. Corrected a problem where moving the mouse over the linescan image during a linescan 
acquistion could cause Prairie View to lock up.

Version 3.3.5.3

4. Fixed a problem with creating a new label when a label is currently selected.  
Sometimes incorrect ‘channel’ selections could appear.

5. Fixed a problem with BOT data handling.

Version 3.3.5.2

6. Added logic for dual scan systems (AOD/Galvo) such that when the scan mode is changed 
(AOD to galvo or between different AOD slider positions) if the system is currently 
imaging with a defined ROI, the ROI mode will be first turned off.  This was necessary 
to correct some issues with the calculation of the scan settings once the ROI mode was 
disabled.

7. Added logic to prevent an error condition when the ‘Scale Bar’ is being displayed and 
the operator is in AOD mode and moves the zoom selector to the ‘Infinity’ position.  
If the ‘X Scan Amplitude’ for that mode was 0.0, then no scale bar may be displayed to 
prevent an error condition.

8. Added logic to disable the ‘Circle’ linescan option during AOD mode.
9. Added logic such that if the ‘Circle’ or ‘Freehand’ linescan method is currently 

selected (in Galvo mode) and then the operating mode is switch to AOD, then the 
linescan method will be automatically switched to ‘Line’.

Version 3.3.5.1

10. Corrected a problem where the hard shutter was performing an additional open/close 
(very rapidly) at the end of a ‘Max-speed’ T-Series.

11. Fixed a problem with BOTs.  When previously acquired BOT data that included ‘Function’ 
definitions (e.g. {2}-{1}) was re-loaded into Prairie View, the color and name of the 
function were not being properly set.

Version 3.2.0.0



53. Added support for the quad servo controller.

Version 3.2.0.0

54. Added ‘Custom Outputs’.

Version 3.2.0.0

55. Added support for the Physic Instrumente E-665 piezo controller.
a. While Prairie View will control a standard E-665 piezo controller, to take full 

advantage of the device requires an E-665 that has been specially modified for 
use with Prairie View.

b. The E-665 allows for 400um of travel in closed loop mode (Servo switch set to 
‘ON’) and 460um of travel in open loop mode (Servo switch set to ‘OFF’).

c. When used with Prairie View, Prairie View will always display the current 
position (offset) of the piezo regardless of the state of the switch (ANALOG/
DIGITAL).  When this switch is in the ‘ANALOG’ setting, the position of the 
piezo is controlled via the ‘DC-OFFSET’ knob on the E-665 controller.  Any 
movement commands from Prairie View will be ignored.  When this switch is in 
the ‘DIGITAL’ setting, the ‘VOLTS’ and ‘MICRONS’ display on the E-665 will go 
blank and the ‘DC-OFFSET’ know will no longer affect the piezo position and now 
movement commands from Prairie View will be executed.

d. To take advantage of the higher speed acquisition capabilities of the piezo 
controller (selected by checking the ‘Fastest Acquisition’ checkbox on the Z-
Series tab (only available when the Z-Series device is the E-665 piezo 
controller) requires an input trigger to control the stepping of the piezo 
controller.

i. Typically this signal will be the ‘End of Frame’ trigger.
ii. The trigger signal is configured via the ‘File’ menu option, 
then select the ‘Preferences’ option, and then select the ‘Output 
Trigger Type’ option.

iii. This signal is found at the ‘PFI8’ connector on the BNC-2090A 
box (connected to the PCI-6052E NI DAQ card).

iv. The software configuration and necessary wiring information is 
provided below under the discussion for ‘Version 2.5.2.0‘.

v. This trigger signal is input to the E-665 on the ‘I/O Connector’ 
on the back of the controller via pin 9 (this is a DB-9 connector).

56. The ‘Mark’ button on the image window in Prairie View is now active during Playback 
mode if TriggerSync is running.

a. This allows the operator to ‘Mark’ points off of an acquisition such as a Z-
Series or T-Series.  This includes the ability to ‘Mark’ points from a MIP 
(Maximum Intensity Projection) image.

57. Added new features to the ‘Linescan’ dialog.
a. A new acquisition mode ‘Circle’ has been added to the previous ‘Line’ and 

‘Freehand’ methods.
i. If the ‘Circle’ option is selected, then a circle is displayed 
on the image window with two boxes on the circle.

1. The size and position of the circle is adjusted by left clicking 
on either of the boxes and while holding the mouse button, 
dragging the box to set the circle size and location.

2. The minimum size of the circle is a function of the current scan 
settings (especially zoom and dwell time) and the operator will 
not be allowed to draw a circle smaller than the scan settings 
allow.

3. The ‘starting’ point for the circle (and subsequently the 
‘ending’ point) is indicated with a chevron that bisects the 
line.  The direction that the chevron ‘points’ indicates the 
direction of the scan.  This position and direction are not user 
definable.

b. When the ‘Freehand’ acquisition mode is selected, there is a new control 
available labeled ‘Scan continuously’.  This control is located next to the 



‘Input Trigger’ controls.
i. ‘Scan continuously’, when checked, indicates that there will be 
a continuous scan/acquisition, with no time delay required for the 
‘retrace’ between the end of one line of acquisition and the next line 
of acquisition (this is the time it takes the galvos to reposition from 
the end of one line trace to the start of the next line trace).

1. When the ‘Circle’ acquisition mode is selected, the ‘Scan 
continuously’ option is automatically enabled since there is no 
need for a ‘retrace’ time interval.

2. When ‘Freehand’ acquisition mode is selected, if the operator 
selects the ‘Scan continuously’ option, the linescan definition 
will have to be ‘mirrored’ on itself.  In this case if the 
original freehand linescan pattern was 500 pixels long, when 
‘Scan continuously’ is checked, the linescan pattern will now be 
1000 pixels long where it will go from the starting point, to 
the ending point, and then back to the starting point.

a. The ‘Minimum Line Period’ will be updated to indicate the 
proper time period for the freehand linescan based upon 
the ‘Scan continuously’ setting.

b. When ‘Scan continuously’ is on, the minimum line period 
is not double the time when the option is off.  This is 
because when it is on, there is no ‘retrace’ time to be 
accounted for.

58. Added a new capability, ‘Actions’ to Prairie View.
a. The ‘Actions’ dialog is accessed by selecting the ‘Tools’ menu option and then 

selecting ‘Actions…’.
b. Actions are external programs or scripts used to automate repetitive tasks. 

There are two types of actions: actions and rules.  Actions simply perform a 
task, rules determine another action to perform based on some criteria.

c. Actions consist of a name, filename and set of arguments.
i. Name:  Used to distinguish the action from others and give some 
indication of it's behavior.  Action will be referenced by their names 
throughout the application.

ii. Filename:  The path to a program or script which will be 
executed.  For example "notepad" would launch a text editor.

iii. Arguments:  A list of arguments passed to the program or script 
specified.  The arguments can contain tokens specified to the left of 
the text box, for example in the screen shot above '<image:ch1>' would 
be replaced by the path and filename for the image containing the data 
for channel one.

d. Rules consist of a list of criteria with corresponding actions to perform if 
the criteria for a given line are met.  In the screen shot above actions can be 
performed based on the current scan type being acquired.

i. Note: A rule can point to another rule, but if a rule references 
itself directly or indirectly it will terminate rather than continue in 
an infinite loop.

ii. Buttons to the right of the grid allow lines in the rule to be 
moved up or down as well as remove lines from the rule.

e. There are a number of different types of actions available in different places 
throughout the application:

f. After Frame Complete
i. These actions are run automatically after a frame is acquired 
with the exception of max speed acquisitions.  In order for an after 
frame complete action to be performed it must first be specified on the 
‘Misc’ tab of the main window.

ii. The only token available for use in the arguments field is 
'<image:ch#>' where '#' is replaced by a channel number 1-4.  This token 
will be replaced by the path and filename of the image containing the 
channel data for the frame that just completed.

g. After Scan Complete/Playback
i. These actions are run automatically after a scan has completed.  
In order for an after scan complete action to be performed it must first 
be specified on the ‘Misc’ tab of the main window.

ii. After scan complete actions are also available to be performed 



manually in ‘Playback’ mode from the image window.  Rule type actions 
are disallowed in this context.

iii. The only token available for use in the arguments field is 
'<metadata>'.  This token will be replaced by the path and filename of 
the metadata file associated with the scan which has just completed (or 
the scan which is currently open in playback mode).  The metadata file 
is in an XML format and contains all information about the scan.  The 
program or script specified must be able to parse the metadata file in 
order to retrieve scan data.

h. Brightness Over Time Region Generation
i. These actions are run manually from the ‘Brightness Over 
Time’ (BOT) dialog and are used to automatically generate brightness 
over time regions based on the current image data.

ii. There are two tokens available for use in the arguments field:
1. '<image:ch#>' where '#' is replaced by a channel number 1-4. 

This token will be replaced by the path and filename of the 
image containing the current image data for the channel 
specified.

2. '<outfile>' which replaced by the path and filename of a 
temporary file created to pass region data from the program or 
script specified into Prairie View.

iii. The format of the output file is a comma delimited list of 
vertices that make up polygon based regions.  Each vertex is made up of 
an X and Y coordinate again separated by a comma that range from 0.0,0.0 
(upper left corner) to 1.0,1.0 (lower right corner).  Each polygon is 
terminated by the channel number the region should be created for 
prefixed by a '-' (minus sign).

iv. For example an output file which would create a square region in 
the center for channel two and a triangle above it for channel one would 
look something like the following:

1. .3,.5,.7,.5,.7,.8,.3,.8,-2,.2,.5,.5,.2,.8,.5,-1
i. Freehand Linescan Path Generation

i. These actions are run manually from the ‘Linescan’ (LS) dialog 
and are used to automatically generate freehand line scan paths based on 
the current image data.

ii. There are two tokens available for use in the arguments field:
1. '<image:ch#>' where '#' is replaced by a channel number 1-4. 

This token will be replaced by the path and filename of the 
image containing the current image data for the channel 
specified.

2. '<outfile>' which replaced by the path and filename of a 
temporary file created to pass line scan path data from the 
program or script specified into Prairie View.

iii. The format of the output file is a comma delimited list of 
points that make up the path to line scan.  Each point is made up of an 
X and Y coordinate again separated by a comma that range from 0.0,0.0 
(upper left corner) to 1.0,1.0 (lower right corner).

j. Mark Points Point Generation
i. These actions are run manually from the ‘Mark Points’ (Mark) 
dialog and are used to automatically generate a set of points to mark 
based on the current image data.

ii. There are two tokens available for use in the arguments field:
1. '<image:ch#>' where '#' is replaced by a channel number 1-4. 

This token will be replaced by the path and filename of the 
image containing the current image data for the channel 
specified.

2. '<outfile>' which replaced by the path and filename of a 
temporary file created to pass point data from the program or 
script specified into Prairie View.

iii. The format of the output file is a comma delimited list of 
points that make up the path to line scan.  Each point is made up of an 
X and Y coordinate again separated by a comma that range from 0.0,0.0 
(upper left corner) to 1.0,1.0 (lower right corner).

k. Photo Activation Mask Generation



i. These actions are run manually from the image window when the 
‘Photo Activation’ (PA) mask editor is enabled and are used to 
automatically generate photo activation masks based on the current image 
data.

ii. There are two tokens available for use in the arguments field:
1. '<image:ch#>' where '#' is replaced by a channel number 1-4. 

This token will be replaced by the path and filename of the 
image containing the current image data for the channel 
specified.

2. '<outfile>' which replaced by the path and filename of a 
temporary file created to pass mask data from the program or 
script specified into Prairie View.

iii. The format of the output file is a comma delimited list of 
vertices that make up polygon based regions.  Each vertex is made up of 
an X and Y coordinate again separated by a comma that range from 0.0,0.0 
(upper left corner) to 1.0,1.0 (lower right corner).  Each polygon is 
terminated by the palette number the polygon should use when added to 
the current mask prefixed by a '-' (minus sign).

iv. For example an output file which would create a square region in 
the center using palette two and a triangle above it using palette one 
would look something like the following:

1. .3,.5,.7,.5,.7,.8,.3,.8,-2,.2,.5,.5,.2,.8,.5,-1
v. Note: There is only one palette available (palette number one) 
on systems not using national instruments cards to drive laser powers.

l. Application Menu Extensions
i. These actions are run manually from the ‘Applications’ menu on 
the main window.

ii. Actions defined here will added to the menu and add the ability 
to launch other applications directly from Prairie View.

m. Actions Using MATLAB
i. Actions can make use of any number of third party tools one of 
which is MATLAB.  Unfortunately MATLAB does not provide command line 
support so an intermediary program has been provided, PrairieMLL.exe 
(Prairie MATLAB Link).

ii. To use this program in an action select PrairieMLL.exe as the 
filename (should be found in the same directory as PrairieView.exe) and 
add any number of MATLAB commands in double quotation marks in the 
arguments field.

iii. For example, to display channel one in MATLAB after each frame 
the arguments would be something like:

1. "image = imread('<image:ch1>')" "imagesc(image)" 
"colormap(gray)" "axis('square')" "axis('off')"

iv. It is also possible to reference M files by changing to the 
directory where the M file is found.  For example, if the command in the 
previous example were found in "C:\ShowImage.m" then the arguments would 
be something like:

1. "cd c:\\" "ShowImage('<image:ch1>')"
v. Once run, PrairieMLL.exe continues to run until explicitly 
terminated. This allows it to continue to use the same MATLAB command 
window thus saving the time required to load a new command window each 
time; as well as preserving the state in the command window allowing 
variables to be saved and referenced again between actions.  To 
terminate PrairieMLL.exe pass /x as an argument. Once the /x argument is 
reached PrairieMLL.exe will stop running any other commands passed after 
the /x and will close the MATLAB command window it was using.  Calling 
PrairieMLL.exe again afterwards will create a new MATLAB command window 
and execute commands normally.

Version 3.1.0.0

59. Added a new feature to compute and set up the system for Nyquist sampling.  This will 
automatically adjust the scan settings so that the pixel size will meet the Nyquist 



sampling theorm and also the z step size for Z-Series acquisitions.  The reasoning 
behind this is to set up the spatial acquisition parameters (x, y and z) for optimal 
image data collection.  These system settings will help to eliminate unnecessary over 
sampling of the data and to protect against under sampling of the data.  The Nyquist 
sampling algorithm will be executed when the operator selects ‘Nyquist Sampling…’ 
under the ‘Tools’ menu option or when he/she presses the F9 key.

a. Since there are several variables involved in these calculations, under the 
‘File’ menu option, under ‘Preferences’ there is a new option ‘Nyquist 
Sampling…’.  When this option is selected, a dialog will appear that allows the 
operator to define the various default values/choices regarding the Nyquist 
calculations.

i. The first control ‘Parameter Adjustment Selection’ allows the 
operator to choose between having the number of pixels (x and y) 
adjusted or by having the optical zoom adjusted.  Basically there are 
two methods for getting the desired pixel size; one is to adjust the 
number of pixels (increase or decrease), and the other is to adjust the 
optical zoom (increase or decrease).  This control allows the operator 
to indicate the first parameter to be adjusted when setting the Nyquist 
sampling values.  Depending upon the system settings, sometimes it might 
be necessary to adjust both the number of pixels and the optical zoom.

1. For example, if the operator preference was to adjust the 
optical zoom, but the computed optical zoom would be less than 
1.0 (the system minimum), then it would be necessary to also 
adjust the number of image pixels to achieve the desired pixel 
size.

ii. The second control allows the operator to select the laser 
source to be used for the Nyquist calculations.  There is a difference 
in the equations if the laser source is a 2-P (two photon) laser versus 
a 1-P (single photon) laser.

iii. The third parameter allows the operator to specify the over 
sampling constant to use.

iv. The fourth parameter allows the operator to indicate if he/she 
should always be prompted for the desired wavelength value and laser 
type (1-P or 2-P) when the Nyquist settings are to be invoked.

1. This option is particularly useful with system configurations 
that include both 1-P and 2-P lasers.  Since when the Nyquist 
option is invoked, the software won’t know in advance what 
wavelength to use.

2. The setting for the second control ‘Laser Type’ will be the 
default laser type shown in the dialog outlined in (b) below.

v. The fifth parameter is only active if the system has more than 
one 2-P laser being controlled by Prairie View.  If more than one laser 
is being controlled by Prairie View, then the operator may select via 
this control which laser to use for determining the wavelength for the 
Nyquist sampling calculation.

b. When the operator selects the ‘Nyquist Sampling…’ option under the ‘Tools’ menu 
option or presses the F9 key, the Nyqusit sampling algorithm will be activated.  
What happens next is based upon the current system settings.

i. If the currently selected objective lens has not been 
calibrated, then a message will be displayed to the operator informing 
him/her of the situation and the necessary corrective action.

ii. If the currently selected objective lens is calibrated and 
either the laser source (item a.ii above) is 1-P or the laser source is 
2-P but the laser is not controlled via Prairie View, or the item a.iv 
above is checked, then a dialog will appear prompting the operator to 
enter the wavelength to use for the Nyquist sampling calculation.  At 
this time the operator may also specify the laser type (1-P or 2-P) to 
be used for the calculations.  If the operator clicks on the ‘Cancel’ 
button, then no changes will be made to the system settings.  If the 
operator clicks on the ‘O.K.’ button, then the system settings will 
change as necessary necessary based upon the operator selections for the 
Nyquist sampling preference values.

iii. If the currently selected objective lens is calibrated and the 
laser source is 2-P and the laser is being controlled by Prairie View, 



then the system settings will change as necessary based upon the 
operator selections for the Nyquist sampling preference values.

c. As noted previously, besides adjusting either the number of pixels in the x and 
y dimension and/or adjusting the optical zoom, the Nyquist sampling logic will 
also set the proper Z-Series step size.  This action will only happen if on the 
‘Z-Series’ tab the radio box next to the ‘Step Size’ IS NOT set to ‘Calculate’.

d. The equations used for determining the desired pixel size or z step size are as 
follows;

i. In the following equations use these definitions; ‘lambda’ is 
the specified laser wavelength in nanometers, ‘NA’ is the Numerical 
Aperture of the current objective lens, ‘over sample constant’ is the 
desired over sample value, and ‘sqrt’ stands for square root.

ii. For 1-P laser
1. Desired x and y pixel size (in nanometers) = ((0.61 * lambda) / 

NA) / over sample constant
2. Desired z step size (in nanometers) = (((0.61 * lambda) / NA) / 

over sample constant) * (pi / NA)
iii. For 2-P laser

1. Desired x and y pixel size (in nanometers) = ((0.61 * (lambda / 
sqrt(2))) / NA) / over sample constant

2. Desired z step size (in nanometers) = (((0.61 * (lambda / 
sqrt(2))) / NA) / over sample constant) * (pi / NA)

60. The main interface was modified so that now there are three lines of status 
information at the bottom.  The first line still displays the Scanline Period, Frame 
Period, and Framerate.  The second line now displays the Field of View (in microns and 
pixels) and now the Pixel Size.  The third line displays the X, Y, and Z motor 
positions.

61. Modified the ‘Optical Zoom’ control so that the minimum value is 1.0.
62. Within the Z-Series Preferences dialog (accessed under the ‘File’ menu option under 

‘Preferences’, then ‘Z-Series…’, a new option has been added.  This new feature allows 
the operator to indicate the location the z motor should move to when the Z-Series has 
completed.  This option can be useful for people that might be performing Z-Series on 
cells that are ‘patched’.  By choosing the ‘Stop’ position option for example, it will 
keep the z motor from making a large move at the end of the Z-Series and potentially 
severing the patch.  The options are ‘Default’, ‘Start’, ‘Middle’, and ‘Stop’.

a. If the ‘Default’ option is selected, then the z motor will return to the 
location it was at before the Z-Series was started.

b. If the ‘Start’ option is selected, then the z motor will return to the start 
position of the Z-Series definition.

c. If the ‘Middle’ option is selected, then the z motor will return to the middle 
position of the Z-Series definition.

d. If the ‘Stop’ option is selected, then the z motor will stay at the stop 
position of the Z-Series definition.

e. This setting will also determine the z motor placement when executing Z-Series 
from within the T-Series protocol.

63. Modified Prairie View so now when the ‘Max Speed’ option is checked for a T-Series 
acquisition cycle, the image display will be updated as the images are acquired when 
acquiring images in galvo mode.  Previously, during ‘Max Speed’ acquisitions the image 
display was not updated.  When acquiring images in AOD mode (for those systems 
equipped with an AOD), there will still be no image update.

64. Within the ‘Linescan Control’ display the operator may now move the mouse over the 
linescan data and see a readout of the x and y value based upon the cursor location.  
The ‘y’ value will be the time value for the start of that particular line trace.

65. Within the objective lens calibration process a problem was corrected where an error 
message was generated if the operator entered a value such as ‘10x’ in the ‘Power’ 
column for an objective lens.  With this fix, if the operator enters a value such as 
‘10x’, it will automatically be changed to ‘10’ and no error message will be 
displayed.

66. Corrected a problem when a ‘Labels’ file (‘Labels.xml’) does not contain the ‘Current 
Settings’ label, after the file was read, the ‘Current Settings’ label was being added 
to the end of the labels list instead of being inserted into the beginning of the 
list.  This would create problems in how the ‘Current Settings’ label was being 
executed.

67. Modified Prairie View so that if no objective lenses are loaded when the program is 



started (the objectives.xml file is either missing, corrupted, or empty), one default 
objective lens will be created.

a. Prairie View was further modified so that all of the objective lenses may not 
be deleted from the program.  By default there will always be at least one 
objective lens.

68. Made modifications to the parameters that are saved when the T-Series configuration is 
saved (either from a T-Series acquisition or the ‘Save T-Series Settings…’ option 
under the ‘File’ menu option is selected).

a. Previously, if a cycle in the T-Series included a Z-Series selection, no 
information for that cycle would be saved.  Now the cycle is saved and when 
read back, the ‘Current’ Z-Series will be selected by default.

b. Previously, if a cycle was a ‘TriggerSync Experiment’, it would be read back 
and the cycle set even if TriggerSync was not running.  Now, if TriggerSync is 
not running when the T-Series settings are loaded, any TriggerSync experiment 
cycles will be left out automatically.

c. Previously, for an image sequence cycle, if the ‘TriggerSync Experiment’ 
checkbox was checked, no record of that was saved with the T-Series 
configuration.  Now, this state is saved.  When this cycle is read back, if 
TriggerSync is not running, then this setting is automatically ignored.

69. Corrected a problem within T-Series where for certain acquisition setups some images 
are overwritten with subsequent cycles/iterations.

70. If TriggerSync is running and Prairie View is in linescan mode and the operator has 
chosen to ‘Synchronize’ the linescan acquisitions with TriggerSync, then if 
TriggerSync is terminated, the linescan acquisition will automatically stop trying to 
synchronize subsequent linescan acquisitions without having to exit linescan mode and 
return to linescan mode.

71. Now using TriggerSync 1.3.3
a. Modified the logic for handling multiple cycle experiments.  This modification 

was made to improve memory usage when specific multiple cycle experiments are 
performed.  In previous versions of the program, when a multiple cycle 
experiment was defined, the program allocated memory for all of the experiment 
cycles even if the waveforms were identical for all of the cycles. In this 
version, if the waveforms for all of the cycles are identical, then only one 
copy of the necessary waveforms will be generated and then that copy will be 
used for all of the cycles.  This change will only improve the memory useage 
aspects of the program if the operator is performing a multiple cycle 
experiment and the waveform(s) required for all cycles are identical.  This 
correction works as desired by reducing the amount of memory that is consumed 
in this particular situation (where all cycles are the same).  However, it does 
not circumvent the overriding problem that this version ofLabVIEW is very 
inefficient in memory management.

b. Added additional TCP/IP communication commands to allow another application to 
control specific assets that TriggerSync has control over.  This includes being 
able to open/close the hard shutter, setting the output value for the 
photolysis control DAC (typically the uncaging pockels cell), and the position 
of the uncaging galvonometers.  This was added for the 'Point Scan' acquisition 
mode new to Prairie View in version 3.1.0.0.

c. Added an additional parameter to the Puse/Train protocol.  This parameter is 
labeled 'Time Delay to First Pulse Train (ms)'.  This parameter is only applied 
as a time delay before the very first Pulse/Train.  This is separate from the 
'First Pulse Delay' parameter which may be defined for each Pulse/Train.

d. Modified the program so that when an image is acquired in Prairie View, the 
'Single Image' window is not opened in TriggerSync.  This window is mainly a 
throwback to the time when this program supported digital cameras.

e. Corrected a problem in the 'Point Calibration' dialog where when the  operator 
selects to perform an 'Automatic' calibration, the image window was not labeled 
'Original Image' as the instructions listed in the dialog indicated.  Instead, 
the image window was labeled 'Upper Left Hand Corner Image'.

f. Corrrected a problem where if the specified uncaging calibration file did not 
exist, TriggerSync still would perform as if it did exist and potentially cause 
the program to "lock".

g. Corrected a problem where if the main graph window was panned/zoomed, the 
displayed Y-axis values were not properly updated.

h. Fixed a problem in the Mark Points Calibration dialog when performing a 



'manual' calibration, the selected input channel from Prairie View was not 
necessarily being displayed, but instead, the first channel that was turned on 
in Prairie View was being displayed.

72. Now using LinescanViewer 3.4
73. Within the Z-Series tab, the operator may now manually edit any of the values in the 

first or last row in the ‘Z-Series Slice Data’ table.  Previously the operator would 
have had to physically move the z motor to the start or stop position, set the values 
for the controls to the desired settings and then press one of the ‘Set’ start or stop 
position buttons.  Now, if the operator wishes to change the laser power value for the 
start position value, he/she can simply go to the first row, double click on the laser 
value, type a new value, and hit the enter key.  As soon as the enter key is pressed, 
the table will be recomputed.

74. Support has been added for multiple users.
a. There is a single file ‘PrairieView.log’ that exists in the same directory as 

the ‘Prairie View.exe’ file.  
i. When Prairie View is started and stopped, an entry will be added 
to this file indicating the date, time, and user name.

ii. When an acquisition is executed, an entry will be added to the 
file that also indicates the directory where the acquisition was saved.

iii. When the ‘Scan Settings’ dialog has its controls activated 
(necessary for editing purposes) an entry will be added to the file.

b. ‘Labels’ are specific to each operator.
75. Modified how the XY and Z motors are utilized during a T-Series.

a. When performing a T-Series, if it does not include XY Stage locations, then the 
XY Stage may be moved by the operator without interfering with the T-Series or 
having the T-Series attempt to move the XY Stage back to the location it was 
started at for each frame.

b. When performing a T-Series, if it does not include the XY Stage or Z Motor(s), 
then the XY Stage and Z motor(s) may be moved by the operator without 
interfering with the T-Series or having the T-Series attempt to move the XY 
Stage or Z motor(s) back to the location it was started at for each frame.

76. To correct for a problem with the Coherent Chameleon laser the laser tuning software 
has been modified.  When a software command is used to change the operating wavelength 
of the laser, sometimes the laser will improperly respond that the tuning has 
completed (even though it hasn’t).

a. This can even be seen on the Chameleon’s LCD display.  Using the Prairie View 
software to change the wavelength, watch the LCD display and sometimes it will 
change from ‘Status: tuning’ to ‘Status: OK’ and then jump right back to 
‘Status: tuning’ where it will stay until it is finished tuning and permanently 
displays ‘Status: OK’.

b. The solution to this problem is to keep querying the laser until at least five 
(5) responses in a row from laser indicate that the tuning process has 
completed.

77. The XY Stage ‘Step Size’ value is now saved when Prairie View is terminated and then 
recalled wben Prairie View is next started.

78. Corrected a problem where when the ‘Shift…’ button on the XY Stage tab is pressed, the 
X and Y positions were only being adjusted by a value of –1.0.  The proper action 
should be that the currently selected XY stage location will be defined by the current 
XY stage location and all other XY stage locations will have their values adjusted by 
the difference between the old and new position values for the current XY stage 
location.

79. Within the T-Series, if a Z-Series is selected within a cycle, the ‘BOT’ option is now 
available.  This allows the operator to collect BOT data during a Z-Series.

80. Modified all of the text entry fields within Prairie View.  In previous versions, if 
the operator did not hit the ‘Enter’ key after typing in a new value, the desired 
setting would not take affect.  With this change if the operator doesn’t hit the 
‘Enter’ key after typing the new value, then when the next control in Prairie View is 
‘clicked’, then the setting will take affect.  For example, the operator types in a 
new optical zoom value of ‘2.0’ and doesn’t hit the ‘Enter’ key.  When the operator 
presses the ‘Live Scan’ button, the system will set the optical zoom to 2.0 before 
starting the scan.

81. Under the ‘Tools’ menu option, the ‘Manual Lasers…’ option was removed.
82. Under the ‘File’ menu option, under ‘Preferences’, the ‘Automatically convert images 

after T-Series?’ option was removed.



83. Added new flexibility for the control of the laser power (typically a pockels cell) 
within a Z-Series.  The new control group is labeled ‘Laser Power Gradient’.

a. The settings listed below are retained for each Z-Series definition.  So 
completely different gradient values can be used for different Z-Series 
definitions.

b. Located just below the group label is a control that allows the operator to 
specify the laser control that the gradient control operation will be applied 
to.  This control is only active if the system configuration includes more than 
one laser used for imaging.

c. Below this control is a checkbox that allows the operator to indicate if the 
desired gradient control operation should be applied to all lasers, or only to 
the indicated laser.

d. Below these controls are two radio buttons labeled ‘Default’ and ‘Custom’.  If 
the ‘Default’ button is selected, then the gradient mapping for the laser(s) 
within the Z-Series definition will work as it always has within Prairie View.  
If the ‘Custom’ button is selected, then the text box and the graph button next 
to the radio button become active.

i. If the operator clicks on the graph button, a dialog will appear 
labeled ‘Custom Laser Gradient for All Lasers’, or if the ‘Applies to 
all Lasers’ check box is not checked, then the dialog will be labeled 
‘Custom Laser Gradient for Laser Line 1’ (for example).

ii. The x-axis (horizontal) of the graph represents the z position 
of the current Z-Series while the y-axis (vertical) of the graph 
indicates the laser power/setting as a function of the z position.

iii. The graph will show two curves, the ‘Default’ curve shows the 
relationship of laser power to z position if the operator selects the 
‘Default’ laser power gradient option (radio button).  The second curve 
shows the relationship of laser power to z position as the ‘Adjust 
Gradient’ control is adjusted.  As the ‘Adjust Gradient’ slider is 
adjusted, the graph will automatically update with the new relationship 
between the laser power and z position.  In addition, the operator may 
type in a ‘Gradient’ value in the text box located below the ‘Adjust 
Gradient’ slider.

iv. If more than one imaging laser is present, then the operator may 
click on the ‘Show All Laser’ check box to display the graphs of all 
laser powers as a function of z position for the current Z-Series 
definition.

v. If the operator hits the ‘Cancel’ button, the dialog will be 
dismissed and the gradient setting will revert to the value when the 
dialog was first opened.

vi. If the operator hits the ‘Accept’ button, then the new gradient 
setting will be applied to the selected laser line(s).

vii. Additionally, if the operator knows the desired gradient value 
he/she wishes to use, they could just type it into the text box located 
next to the ‘Custom’ radio button on the Z-Series tab.

84. The numeric controls within Prairie View were modified such that a red ‘-‘ button 
symbol and a green ‘+’ button symbol are displayed next to the numeric controls and 
can be used for incrementing or decrementing the numeric value.

85. Under the ‘Display’ menu option, the ‘Overlay Color…’ and ‘Overlay Font…’ menu options 
have been replaced with ‘Fonts and Colors…’ menu option.  This new dialog will allow 
the operator to select the color and font for the general overlay graphics as well as 
setting the ‘mask’ colors associated with the Photo Activation feature.

86. Overlay font and color selections are now saved between sessions of Prairie View. 
87. Interlaced Scan Pattern:  The ability to have this feature enabled is dependent upon 

your system configuration.  While this feature is available for systems with only a 
single laser, its usefulness with a single laser setup is limited at best.  This 
feature is primarily useful when a system has more than one laser (either 1-P or 2-P).

a. If the system can support this option, then within the 
‘PrairieConfigUtility.exe’ program, on the ‘Laser’ tab, there is a new ‘Device 
Type’ option ‘PVAnalogOutputDAQBuffered’.  This must be the selected ‘Device 
Type’ for each of the laser lines.

i. If one or more laser line is configured for this device type, 
then when Prairie View is executed, there will be a new checkbox located 
at the bottom of the laser controls on the ‘Laser,Pmt,DAQ’ tab 



‘Interlaced scan pattern’ and a new button ‘Setup’.
ii. If one or more 2-P lasers are configured to be controlled by 
Prairie View, then the ‘2-P Laser’ column on the ‘Laser’ tab in 
‘PrairieConfifUtility.exe’ is used to indicate which laser should be 
associated with each laser control.  By making this association, the 
‘Pockels Cell Calibration’ (covered below) process will be more 
streamlined for the operator.

b. With this feature, the operator can set up the system so that every nth line in 
an image can be controlled with a different laser or different laser setting 
and multiple images will be generated in the process.

i. The simplest example would be a system with two imaging lasers, 
one tuned to 800nm and one tuned to 900nm.  Using this feature, the 
operator can scan a 512x512 image where the first line is with the 800nm 
laser line and is saved in channel 1, the second line is acquired with 
the 900nm laser line and is saved in channel 2, the third line is 
acquired with the 800nm laser line and saved in channel 1, and so on.  
Based upon a ‘Preference’ setting, at the end of the image the operator 
will either have two images at 512x512 resolution or two images as 
512x256 resolution.

c. Under the ‘File’ menu option, under ‘Preferences’ there is a new option 
‘Interlaced Scanning’ with a pull-right option of ‘Preserve Framerate’.

i. If this option is unchecked, then when the interlaced option is 
being used, the resultant images will be the same size as the current 
image size.  To achieve this image resolution however, then the total 
time to acquire the image will be based upon the number of interlaced 
lines to be acquired.  For the simple example outlined previously, there 
will have to be 1024 lines actually acquired (512 at 800nm and 512 at 
900nm) to generate the two 512x512 images, so the actual image time will 
be about twice what it would have been for a single 512x512 image.

ii. If this option is checked, then when the interlaced option is 
being used, the resultant images will have a reduced y resolution 
(dependent upon the number of interlaced lines being acquired).  Once 
again using the previous example, there would be a total of 512 lines 
acquired (256 at 800nm and 256 at 900nm) so the actual image time 
(framerate) will be unchanged.

iii. If this option is changed while the ‘Interlaced scan pattern’ 
checkbox is checked (on), then the change will not take affect until the 
checkbox is unchecked and then checked again.  The recommended order of 
operation if you wish to change this setting is to first turn off the 
‘Interlaced scan pattern’ and then to change the preference selection 
before turning the ‘Interlaced scan pattern’ on again.

d. To configure the interlaced scan pattern, first check the ‘Iterlaced scan 
pattern’ checkbox and then click on the ‘Setup’ button.  The ‘Interlaced Scan 
Pattern Setup’ dialog contains information to guide the operator through the 
setup process.

i. Up to four different ‘Tracks’ may be defined.  Each track will 
contain its own list of laser line selections and laser powers.

ii. The first step is to select the laser line(s) and the desired 
laser power settings for each line and to associate these settings with 
desired ‘Track’.

1. Click on the ‘checkbox’ for the desired ‘Track’ (located on the 
label for ‘Track 1’, ‘Track 2’, and etc. in section ‘2’ (blue 
number ‘2’)).

2. In section ‘1’ (blue number ‘1’) select the desired laser line 
and either leave the ‘Current’ checkbox checked, or uncheck it 
and set the laser power with the scrollbar control.

3. Back in section ‘2’ for the desired Track, click on the add 
laser line button for the desired track (red laser symbol with a 
‘+’).  The current laser and power value will be displayed in 
the ‘Track’ settings.

4. If desired, select another laser line and power setting and add 
it to the current Track or add it to another Track as desired.

5. If you wish to delete a laser line from a Track, simple select 
the desired line within the Track settings by clicking on, and 



then press the delete button (big red ‘X’).
iii. After the desired Track definitions have been made, it is then 
necessary in section ‘3’ (blue number ‘3’) to define the channel that 
the desired signal should be collected on (‘Source Channel’) control and 
the ‘Track’ that should be used for that particular ‘Source Channel’.  
This is also where the association is made between the acquired data 
channel (Source Channel) and the ‘Display Channel’.  Please note that 
this means that even if the ‘Source Channel’ is ‘Ch2’ for example, it 
could still be displayed in the ‘Ch1’ memory.

e. Whenever the ‘Interlaced scan pattern’ checkbox is checked, the defined 
interlaced settings will be used.  This applies to Live Scan, Single Scan, T-
Series, Z-Series, and etc.

88. Photo Activation Enhancements/Changes.
a. When clicking on ‘Add Ellipse’, ‘Add Rect.’ or ‘Add Polygon’ the operator can 

just continue to add mask elements of that type instead of only being able to 
draw just one and then having to click on the shape button again.

b. When the ‘Copy to Next’ or ‘Copy to Previous’ button is pressed, in addition to 
copying the current image mask, the image display will automatically change to 
the next or previous image as appropriate.

c. The mask transparency setting is now saved between Prairie View sessions.
d. Mask colors can now be edited under the ‘Fonts and Color…’ menu option under 

the ‘Display’ menu option.
e. Photo Activation can now be enabled for any scan.

i. The ‘PA’ button will function as it always has in playback mode, 
but now, when pressed outside of playback mode, it will open a new 
single frame mask to edit (overwriting the current mask if one exists.)

ii. Photo Activation masks can now be selected for non Z-Series 
cycles within T-Series.

iii. An additional mask selection for single frames (including ‘Live 
Scan’ and ‘Single Scan’) has been added to the ‘Misc’ tab.  The single 
scan mask will also affect Z-Series, W-Series, and will be used in T-
Series if not other mask is specified.

f. If the system is configured such that it supports the ‘Interlaced Scan Pattern’ 
outlined above, then even more features are available under Photo Activation.

i. Photo Activation masks are no longer simply on/off states.  
Laser powers can be set independently to different values for different 
masks within the same scan area.

ii. When the Photo Activation controls are active, there will be an 
additional column of controls under a heading of ‘Laser Palette’.

1. There are eight available user configurable palettes.
2. If more than one palette is used for defining the photo 

activation masks, then if the ‘Invert Mask’ button is pressed, 
the operator will be notified that this option is not available 
and the ‘Invert Mask’ operation will not be preformed. 

3. The first palette, by default, has all lasers at their current 
settings.  This palette is represented by a solid color when the 
operator is drawing the mask(s).

a. Like all of the palettes, the operator may click on the 
‘Edit’ button and edit the laser selection and/or power 
values for a custom setting.

b. When the ‘Edit’ button is pressed, a new dialog will 
appear that allows the operator to define the laser 
selection (if more than one laser line is available) and 
the desired laser power to be used when that particular 
photo activation palette is selected.  After the dialog 
is closed, the specified laser settings will be shown in 
the text area to the right of the palette symbol.

4. To use a desired palette, simply click on the palette symbol 
(pattern icon) and then draw the desired photo activation masks.  
The display of the photo activation mask will be the same as the 
selected palette symbol (pattern).

5. Below the Palette selections, there is another set of controls 
under the heading of ‘Background Power’.

a. These controls are used to define what laser(s) (if any) 



and the laser power setting for the selected laser to use 
for the region of the image outside of any photo 
activation masks.

b. If ‘All Off’ is selected, then all lasers will be ‘off’ 
outside of the photo activation mask areas.

c. If ‘All Current’ is selected, then the laser(s) will be 
at the current setting of the laser slider controls in 
Prairie View for the region of the image outside of any 
photo activation masks.

d. If the ‘Custom’ option is selected, then the ‘Edit…’ 
button is active and this will allow the operator to set 
the laser selection and power setting exactly how it is 
done for a ‘palette’.  The difference of course being 
that this applies to the region of the image outside of 
any photo activation masks.

89. Laser Power Calibration.
a. Laser Power Calibration extends the operating capabilities of the Prairie 

Technologies Ultima system.  Once the proper system measurements have been made 
and the laser power calibration procedure completed, the operator will have the 
ability to specify the desired laser power to be delivered to the sample in 
milliWatt units.  In addition, once the laser power setting has been made, if 
the operator changes the wavelength of the 2-P laser, the drive voltage to the 
pockels cell will be automatically adjusted to maintain a constant laser power 
to be delivered to the sample.

b. The proper implementation of the Pockels Cell Power Calibration is dependent 
upon the initial pockels cell installation as well as software.  Any 
adjustments to the light path after the setup and calibration(s) have been 
performed would most likely result in the necessity to perform the 
calibration(s) again.

c. Software Configuration:
i. Start the program ‘PrairieConfigUtility.exe’.
ii. Load the appropriate ‘configuration.xml’ file (starting with 
Prairie View version 3.1.0.0 the configuration.xml file should be loaded 
automatically when the program is started).

iii. To obtain finer control over the output laser power, it is 
recommended that the ‘Display Max’ setting for the laser controls on the 
‘Laser’ tab be set to 1000 (instead of the default value of 100).

iv. On the ‘Laser’ tab, there is a new ‘Device Type’ option 
‘PVAnalogOutputDAQBuffered’.  For maximum flexibility, it is recommended 
that this ‘Device Type’ be used.  However, the default option of 
‘PVAnalogOutputDeviceControlBox’ will work.

1. Please pay attention to the ‘note’ regarding the 
‘PVAnalogOutputDAQBuffered’ type at the bottom of the ‘Laser’ 
tab.  This note provides information on the desired setting for 
the ‘OUT Max’ parameter based upon the ‘Device’ selection.

v. If one or more 2-P lasers are integrated into the control of 
Prairie View (e.g. Coherent Chameleon or Spectra Physics Mai Tai), then 
the control in the ‘2-P Laser’ column will be active.  Use this control 
to specify the association between the laser control (pockels cell) and 
2-P laser.

d. Pockels Cell Installation/Setup:
i. Always exercise extreme caution when working with the 2-P laser 
beam.  Safety goggles are recommended.

ii. Extreme caution should be exercised when working with a pockels 
cell.  Misalignment of the laser beam into the pockels cell could result 
in permanent damage to the device and render it unusable.  Always 
consult with Prairie Technologies before attempting to make any changes 
to the 2-P laser light path (pockels cell rotation, etc.).

iii. If more than one 2-P laser is integrated for imaging on the 
system, then the calibration process needs to be carried out for each 
laser/pockels cell combination independently.

iv. For initial setup, the pockels cell is NOT yet rotated 90 
degrees to the incoming laser.  This means that with no drive voltage 
applied, all of the laser light will pass through the pockels cell.  



Also, the drive voltage (usually a line from the Device Control Box or a 
line from one of the National Instruments DAQ  boards) should not even 
be connected to the pockels cell controller.

1. Preferably there are no optical components between the laser and 
the ½ wave plate (this includes mirrors).  This is important 
since any optical movement of the beam before it reaches the 
pockels cell would basically invalidate any previous 
calibration.

2. Modify the position (rotation) of the ½ wave plate to get 200mW 
of laser power at the input side of the pockels cell.

3. If 200mW of laser power is going into the pockels cell, we 
should get about 95% of that power on the backside (output) of 
the pockels cell, this would be 190mW.

4. If you are getting much less than 95% out based upon the input 
power, then something is either improperly aligned or not 
working properly.

v. Pockels Cell bias adjustment.
1. Turn off Con Optics box.
2. Remove laser trap from the pockels cell (the pockels cell 

extinction port should be parallel to the table surface).
3. Place an iris in front of the pockels cell to get the proper 

beam height setting for the iris.
4. Place the iris as far away as possible from the pockels cell on 

the rejected light path (where the beam trap was removed) and 
make sure that the pockels cell is properly rotated to get the 
laser parallel to the table and oriented 90 degrees to the 
incoming laser light.

5. Measure the laser power on the output path of the pockels cell.  
With this orientation and no power applied to the drive voltage, 
approximately 95% of the incoming laser power should be measured 
at the output.

6. Make certain that the rejected light from the polarizing beam 
splitter is at the same height as the rejected light from the 
pockels cell in the previous step.

7. Turn on the Con Optics box.
8. Adjust the bias on the pockels cell controller to get minimum 

output power.  The bias should be between +/- 100.  If it is 
outside of this range, either the alignment is wrong or 
something else is wrong.

9. Bias should basically not be adjusted ever again (even when the 
operating wavelength is changed).  A good idea would be to label 
the Con Optics box near the bias control knob with the 
calibrated bias setting.  In this manner, the proper bias 
setting will not be forgotten and may be quickly reset to the 
proper value.

vi. Determining the extinction ratio.
1. Connect the drive voltage to the pockels modulator (usually 

either a line from the Device Control Box or a line from an 
analog output from one of the National Instruments DAQ boards 
(via a BNC-2090 or BNC-2110 box)).

2. Adjust the half wave plate until we have 200mW of power going 
into the pockels cell.

3. Increase the drive voltage until we have minimum power at the 
output of the pockels cell.  This might not be exactly 0mW, but 
it should be close.

4. Compare the output power at 0V drive (max power) and at the min 
power settings and calculate the ratio.

5. This ratio should be at least 400:1 or something close.  Higher 
is better here.  Record this value in the ‘Laser Power 
Calibration’ dialog within Prairie View.  This dialog is 
activated when the operator selects the ‘Tools’ menu option and 
then selects ‘Calibrate Laser Power…’.  The extinction ratio is 
recorded in the ‘Constants’ area of the dialog in the field 
labeled ‘Extinction Ratio’.  If the calculated extinction ratio 



is 250:1 for example, the value to enter in this field is 250.
a. If more than one 2-P laser is being used for imaging on 

the system, be sure to specify the desired laser line 
that is being calibrated within the ‘Laser Power 
Calibration’ dialog.  There is a control labeled ‘Laser 
Selection’ at the top left hand corner of the dialog with 
an associated control that will be active if more than 
one 2-P laser is being used.  Use this control to select 
the laser that is being calibrated.

vii. Replace the laser trap on the pockels cell.
viii. Now the pockels cell can be rotated 90 degrees and with the 
drive voltage set to the value in step ‘c’ above, we should now have the 
maximum laser power at the output of the pockels cell.

ix. At the typical imaging wavelengths of 800nm or so, there is so 
much energy coming out of the lasers that we should use the ½ wave plate 
to reduce the power coming into the pockels cell to less than or equal 
to 2W (maybe something closer to 1.5W would work for most needs).

1. The main purpose for this is that we can bring our minimum 
pockels cell output power down closer to 0 since there is a 
certain amount of ‘bleed-through’ with the pockels cell since it 
is not a perfect device for extinguishing the beam.

x. Determine the maximum drive voltage across the wavelength range.
1. Adjust the half wave plate until we have 1.5 to 2 W of power 

going into the pockels cell.
2. Choose two different wavelengths, e.g. 780nm and 1050nm.

a. In the ‘Laser Power Calibration’ dialog, in the 
‘Constants’ field, enter these two wavelengths in the 
‘Wavelength #1[nm]’ and ‘Wavelength #2[nm]’ fields.

3. With the setup that has been performed to this time, 0.0V for 
the drive voltage should result in the minimum output power from 
the pockels cell at all wavelengths.

4. Tune the laser to one of the desired wavelengths.
a. If Prairie View has the 2-P laser control integrated into 

its controls, then the operator may press the ‘Goto’ 
button and have the software automatically tune the laser 
to the specified wavelength.

b. If Prairie View does not have the 2-P laser control 
integrated into its controls, then the operator must 
manually tune the laser to the specified wavelength.

5. Adjust the drive voltage to get the maximum power, measured at 
the back of the pockels cell.  The drive voltage is adjusted via 
the appropriate Laser slider control on the ‘Laser, PMT,DAQ’ tab 
in Prairie View.  Record this value for the appropriate 
wavelength in the ‘Laser Power Calibration’ dialog by pressing 
the ‘Set’ button.

6. Repeat steps ‘d’ and ‘e’ for the other wavelength.
7. These two drive voltages and their respective wavelength 

settings will allow us to map (based on a linear approximation), 
the necessary drive voltage to achieve maximum output at the 
pockels cell at any wavelength.  We’ll refer to this value as V.

8. Press the ‘Save’ button located in the ‘Constants’ label in the 
‘Laser Power Calibration dialog.

9. Press the ‘Accept’ button and the ‘Laser Power Calibration 
dialog will close.

a. You will now notice an additional control associated with 
the laser power slider in Prairie View for the laser(s) 
that were just configured in the previous steps.

b. This new control is labeled ‘Mode’ and the associated 
combo box has two options; ‘Default’ and ‘Attenuation’.

i. When this control is set to ‘Default’ the 
laser slider will operate like it always has.  
This means that potentially the operator could 
adjust the drive voltage for the pockels cell past 
its maximum output and the actual laser power 



output from the pockels cell will not be 
necessarily higher as the laser slider is 
increased.

ii. When the control is set to ‘Attenuation’ 
the laser slider is internally rescaled such that 
based on the current operating wavelength for the 
associated 2-P laser the drive voltage for the 
pockels cell will go between 0 volts and the 
calibrated voltage that will generate the maximum 
pockels cell output for the wavelength.

1. The laser control label will include the 
symbol ‘[%]’ after the laser line label 
when Attenuation mode is selected.

2. The laser slider value will go from 0.00% 
to 100.0% (regardless of the scale used 
when in ‘Default’ mode).

iii. By just having set the values for the 
extinction ratio and the drive voltage values 
across the wavelength range we’ve improved the 
usability of the system with the addition of the 
‘Attenuation’ mode.

e. Power Calibration:
i. The purpose of the Laser Power Calibration is to provide one or 
more calibration files that will allow the operator to set the desired 
laser power in milliwatts at the sample via the ‘laser’ slider 
control(s) in Prairie View.

1. This option will be in addition to the two operating modes 
already available; Default and Attenuation.

ii. The actual power calibration is performed by stepping through a 
range of wavelengths and at each wavelength, and setting the drive 
voltage to the proper V.  Then, after the system has had a few seconds 
to settle at the new wavelength and drive voltage, record the laser 
power at the objective lens.  This would create a table like the 
following:

1. Wavelength(nm) Power(mW)
a. 700 200
b. … …
c. 800 400
d. …
e. 1050 50

2. Using the information in the table, when in the ‘power’ mode, we 
can control the laser power to the sample between 0mW and 50mW 
from 700nm to 1050nm.

iii. The actual calibration process is conducted with the ‘Laser 
Power Calibration’ dialog within Prairie View.

1. Place a power meter below the objective lens.
a. Rather than place the power meter at the focal plane for 

the objective, place it slightly above or below the focal 
plane.  The meter will probably deliver better results if 
the laser light isn’t focused to such a fine spot size.

2. To perform a calibration, first the various fields in the 
‘Constants’ section must be properly filled in.  This is 
outlined above.

3. Next, press the ‘New’ button and in the ‘Selected Calibration’ 
area, enter the name of the calibration file in the ‘Name’ field 
in the ‘Selected Calibration’ section.

a. The calibration name should reflect the objective lens 
being used as well as the range of wavelengths that will 
be used in the calibration.

4. Enter the values for the ‘Minimum Wavelength [nm]’, ‘Maximum 
Wavelength [nm]’, and ‘Step Size [nm]’ fields to be used for the 
calibration.

5. Press the ‘Start’ button.
a. If 2-P laser control is integrated for the selected 



laser, the software will automatically tune the laser to 
the ‘Minimum Wavelength’ value for the calibration.  If a 
2-P laser control is not integrated for the selected 
laser, the operator must manually tune the laser to the 
‘Minimum Wavelength’ value for the calibration.

b. After the laser has finished tuning (changing 
wavelengths), wait a couple of seconds for the reading on 
the power meter to stabilize and then enter the power 
meter reading (in milliWatts) in the ‘Power’ field and 
hit the ‘Enter’ key.  The entered value will now appear 
in the calibration table across from the current 2-P 
laser wavelength.

c. After hitting the ‘Enter’ key, if 2-P laser control is 
integrated for the selected laser, the software will 
automatically change the laser wavelength to the next 
value in the calibration table.  If a 2-P laser control 
is not integrated, then the operator will need to 
manually tune the laser to the appropriate wavelength.

d. Repeat steps ii and iii until the calibration has been 
completed.

e. Press the ‘Accept’  button to utilize the calibration 
file.

6. After at least one calibration file has been generated, then the 
‘Mode’ control associated with the calibrated laser line will 
include the names of the calibration file(s) (in addition to 
‘Default’ and ‘Attenuation’ as outlined above).

a. When one of the calibration files is selected the laser 
control label will include the symbol ‘[mW]’ after the 
laser line label.

b. When one of the calibration files is selected then the 
laser slider is internally rescaled such that based on 
the current operating wavelength for the associated 2-P 
laser the drive voltage for the pockels cell will go 
between the minimum achievable output power (not 
necessarily 0mW) and the maximum output power that can be 
attained at all wavelengths within the calibration range.  
For example, if the calibration wavelength range was 
780nm to 950nm and the lowest maximum power measured 
across that range was 50mW, then when this calibration 
file is used, the maximum output power at any of the 
calibrated wavelengths will be 50mW.

c. If the association between the 2-P laser and the laser 
control was set in ‘PrairieConfigUtility.exe’, then when 
the operating wavelength is changed, the laser setting 
will be automatically adjusted to maintain the desired 
sample power.

f. Additional Software Information:
i. The selected laser mode (Default, Attenuation, or Power 
Calibration file) and laser setting will be retained when a ‘label’ is 
created/used in Prairie View.  The laser setting displayed in the ‘Laser 
Power(s)’ column will include ‘mW’ or ‘%’ if the label was created when 
a calibration file or the Attenuation mode was in effect.

ii. The selected laser mode and laser setting will be retained for 
the ‘Interlaced scan pattern’.  The selected laser mode will also be 
reflected in the laser sliders for the setup dialog for the ‘Interlaced 
scan pattern’.

iii. The selected laser mode and laser setting will be retained for 
the Photo Activation masks and settings. The selected laser mode will be 
reflected in the laser sliders for the Photo Activation palette edit 
dialog.

iv. As mentioned previously, all optical components in the light 
path between the pockels cell and the light meter (placed to measure the 
light output at the objective lens) will have an impact on the power 
delivered to the sample.  Therefore it is necessary to perform a 



calibration for at least each objective lens used on the system to take 
proper advantage of this calibration process.

v. Since the maximum sample power for a given calibration is 
limited to the ‘lowest’ measured power through the calibration 
wavelength range, the operator might wish to make several calibrations 
for a given objective lens at various wavelength ranges.

vi. If a laser control is configured to use a calibration file and 
there is a 2-P laser integrated into Prairie View and associated with 
the particular laser control, if the operator attempts to tune the laser 
to a wavelength outside of the range of the calibration file, the 
operator will be warned that that is an illegal operation and the 
wavelength change will not take place.

vii. If the system is equipped with the high-speed optics option 
(AOD), it might not be necessary to perform the pockels cell 
calibration.  This is due to the fact that the AOD system is set up and 
optimized for a single wavelength.  It might be better to simply take a 
couple of power measurements at the objective lens in ‘Attenuation’ mode 
and then manually determine which setting in Attenuation mode will 
provide the desired sample power.

90. Corrected a problem when Prairie View is starting, if there is a USB controlled Dodt 
detector, where the incorrect Dodt filter position could be indicated.

91. Added a new (optional) control to the ‘Misc’ tab, ‘Secondary Laser Beam Route’.
a. This feature is a TTL level signal that is intended to drive a switch for 

systems that have two 2-P lasers, where the second laser can be used as an 
imaging laser or as an uncaging laser.

b. This feature is enabled/disabled and configured within the 
‘PrairieConfigUtility.exe’ program at the bottom of the ‘Misc’ tab.  This 
signal may be configured to use a digital output line from any of the National 
Instruments DAQ boards.

c. This parameter is part of a ‘Label’ definition.  This allows the operator to 
create labels that use either just one laser or potentially both lasers.  This 
also allows the operator to control the ‘routing’ of the second laser for use 
in uncaging experiments with TriggerSync (e.g. First image using both lasers, 
then via a label, change the routing of the second laser, then uncage with 
TriggerSync, and so on).

92. Modified the ‘PrairieConfigUtility.exe’ program.
a. When the program is started it will automatically load the ‘configuration.xml’ 

file found in the ‘Configuration Files’ directory where the 
‘PrairieConfigUtility.exe’ program is located.

b. When the ‘Load’ button is pressed, the program will automatically select the 
‘configuration.xml’ file found in the ‘Configuration Files’ directory where the 
‘PrairieConfigUtility.exe’ program is located as the default file.

93. In ‘Playback’ mode, there is a new checkbox ‘Wrap’ that determines the looping method 
when the play forward or play reverse buttons are pressed.  If ‘Wrap’ is not checked, 
then for example, the sequence of images will proceed from 1 to 2 to 3 and so on up to 
the last (nth) image and then display the nth-1, nth-2, and so on back to the first 
image.  If the ‘Wrap’ option is checked, then the sequence of images will proceed from 
1 to 2 to 3 up to the nth image and then go back to 1 and repeat the sequence.

94. Corrected a problem when acquiring a Z-Series from within a T-Series, the text fields 
on the Z-Series tab for ‘Start Position’, ‘Stop Position’, etc. were not being 
disabled.

Version 3.0.0.5

95. Modified the ‘Free Draw’ linescan implementation.  With this new implementation, the 
number of pixels in the free draw linescan will be equal to the line length (instead 
of being equal to the number of pixels in the x dimension from the reference image).

a. When the operator is finished drawing the free draw linescan, the Linescan 
Control inteface will show the line period based upon the new line definition 
and an additional field has been added that will display the number of pixels 
on the line definition (Pixels Per Line).

b. The minimum allowed free draw line length is 8 pixels.



c. When the program is in free draw mode, if the shift key is held down while the 
mouse is being dragged (with the left mouse key depressed), the program will 
generate a straight line segment between the point where the shift key was 
depressed and where it was released.  In this manner, if the shift key is 
depressed before drawing any of the line and then release at the final 
destination, the operator may easily draw a straight linescan line with any 
desired orientation.

d. Two additional buttons have been added to the Linescan Control dialog; ‘Load…’ 
and ‘Save…’.  These buttons allow the operator to save/recall free draw 
linescan patterns.

e. There is now a ‘green’ box drawn around the starting point of the free hand 
waveform and a ‘red’ box drawn around the ending point of the free hand 
waveform.

i. If the operator left clicks the mouse in either one of these 
boxes, they can extend the starting or ending point of the free hand 
pattern.

ii. If the operator right clicks the mouse in either one of these 
boxes, they can then move the free hand pattern.

f. After the linescan acquisition has completed, if the operator left clicks on 
the displayed linescan data (in the ‘Linescan Control’ dialog), then a yellow 
vertical line will be displayed and a yellow box corresponding to the location 
of this linescan data will be drawn in the image window(s).

i. Any time the operator left clicks in the linescan data, the 
yellow line and box will move accordingly.

ii. If the mouse is placed over the yellow box in the image window, 
then the cursor will change to a ‘hand’ and then by left clicking the 
mouse, the box may be moved along the free hand pattern.  As the box is 
moved, the vertical indicator line in the linescan data will move to the 
corresponding location.

g. The vertical scrollbar in the Linescan Control dialog will now only scroll the 
linescan data, always leaving the linescan controls visible.

96. Fixed a problem in the linescan acquisition where if the ‘Define’ option is set next 
to the ‘Acquisition Time’ control (so that the ‘Number of Lines’ will be computed), 
certain acquisition times would result in a strange behavior where after each linescan 
acquisition, the setting for the ‘Number of Lines’ would increment by one.

Version 3.0.0.3

97. Modified the T-Series software so that if a ‘Label’ cycle is placed just before a 
‘TriggerSync’ experiment cycle, then the label settings will take affect before the 
TriggerSync experiment executes.  This is especially important if the TriggerSync 
experiment needs to be performed at a different wavelength than the image acquisition.

98. Modified the T-Series software so that if a ‘XY Stage’ cycle is placed just before a 
‘TriggerSync’ experiment cycle, then the system will move to the appropriate XY stage 
coordinates before the TriggerSync experiment executes.

99. To correct for a problem with the Coherent Chameleon laser the laser tuning software 
has been modified.  When a software command is used to change the operating wavelength 
of the laser, sometimes the laser will improperly respond that the tuning has 
completed (even though it hasn’t).

a. This can even be seen on the Chameleon’s LCD display.  Using the Prairie View 
software to change the wavelength, watch the LCD display and sometimes it will 
change from ‘Status: tuning’ to ‘Status: OK’ and then jump right back to 
‘Status: tuning’ where it will stay until it is finished tuning and permanently 
displays ‘Status: OK’.

b. The solution to this problem is to keep querying the laser until at least five 
(5) responses in a row from laser indicate that the tuning process has 
completed.

100. Modified the .xml and .lsd files that are created when linescan images are 
acquired.  A new value that specifies the length of the linescan (straight or free 
hand) in microns is now automatically saved.

101. Modified the objective lens calibration procedure so that the scan rotation no 



longer is required to be set to 0 in order to perform the calibration.
102. Modified the logic for turning the ‘Power’ on for the Mai Tai 2-P lasers.  The 

program will now wait up to 5 minutes (3 minutes in previous versions) for the laser 
to reach a ‘warm up’ value of 100% before turning the laser on.  Once the laser is 
turned on, it may still be several minutes before the output power of the laser 
reaches its maximum.  If the laser does not reach a ‘warm up’ value of 100%, the 
operator is informed via a message box and the ‘Main Power’ control will still display 
‘Off’.

103. When the ‘0’ button is pressed associated with the Z motor movement and the 
system is configured with an L&N Z motor, the z motor position on the L&N controller 
will be set to 0 (with no associated motor movement).

104. Made several changes for the XY Stage controls.  This was primarily intended to 
create a more consistent operation with the corresponding Z motor controls.

a. When the ‘0’ button is pressed associated with the XY Stage motor movement, if 
the XY Stage supports it, the current X and Y motor positions will be set to 
0.0 (with no associated motor movement).

i. If the system is configured with an L&N XY Stage motors, the X 
and Y motor positions on the L&N controller will be set to 0 (with no 
associated motor movement).

ii. Previously, pressing the ‘0’ button would drive the X and Y 
stage motors to the 0.0 location for each motor

b. Added a new XY ‘Home’ button.  When this button is pressed, the X and Y stage 
motors will move to the location displayed in the ‘Home’ text field.

c. Modified how the ‘Set’ button located next to the XY Stage ‘Home’ field works.  
Previously, pressing this button would set the current position for the X and Y 
Stage motors to 0.0 (with no associated motor movement).  Now, pressing this 
button will result in the current X and Y Stage motor positions being saved as 
the new ‘Home’ position.

105. Made a small modification to the data displayed in the ‘Metadata’ window while 
in Playback mode.  If there is one or more integrated 2-P lasers when the data was 
acquired, then the 2-P laser wavelength and output power will be displayed when the 
‘Channel’ element listed below the ‘Frame’ is selected.  Previously this information 
was displayed when the ‘Frame’ was selected.  This corrects a problem of the 2-P laser 
data not updating when a single frame might have multiple channels where each channel 
was acquired with a different wavelength (executed using Label Groups).

106. Modified the logic associated with dual scan (Galvo and AOD) systems.  When the 
system is in AOD mode, if the software reads that none or more than one of the AOD 
state lines (indicating the AOD ‘zoom’ mode) are active, the software will resort back 
to Galvo mode.  This is intended to protect the galvos in the event of an electronics 
problem that could result in the AOD scan ramps being sent to the Galvos 
inadvertently.

107. Corrected a problem where if no channels are turned on when the Z-Series 
‘Start’ button is pressed, even after a channel is turned on when the ‘Start’ button 
is pressed it would not start the Z-Series.

a. Corrected the same problem associated with T-Series.
b. Corrected the same problem associated with W-Series.

108. Corrected a problem where if more than one label ‘group’ is defined, and the 
second or later label ‘group’ is selected when a Z-Series is started, then Prairie 
View will display that no channels are turned on and will not perform the acquisition.

a. Corrected the same problem associated with T-Series.
b. Corrected the same problem associated with W-Series.

109. Modified the W-Series acquisition so that the table of wavelengths will be 
automatically scrolled through during the W-Series acquisition as an additional aid to 
the operator for monitoring the acquisition status.

110. When setting up a W-Series acquisition, the operator may no longer enter a 
starting or ending wavelength that is outside of the operating range of the currently 
selected 2-P laser.

111. Correction made to the waveforms for AOD scanning mode.

Version 3.0.0.2

112. Corrected a problem when running a T-Series with a Photo Activation mask, if 



the T-Series was aborted, the Photo Activation mask was still being applied when 
attempting to perform a Live Scan or Single Scan.

113. Corrected a problem in the TIFF image files generated in Prairie View.  The 
problem only affected images that had eight (8) or fewer pixels in the Y dimension.

Version 3.0.0.1

114. Modified some software logic to correct for a condition on some systems where 
the ‘Mark Points Wizard’ dialog will fail to open when the ‘Configure’ button is 
pressed in the ‘Mark Points’ dialog.

115. Made a modification to correct the image display when the ‘Freeze Channel’ 
option is turned on for a given channel and then the channel display is turned on or 
off.

116. Made modifications to the parameters that are saved when the T-Series 
configuration is saved (either from a T-Series acquisition or the ‘Save T-Series 
Settings…’ option under the ‘File’ menu option is selected).

a. Previously, if a cycle in the T-Series included a Z-Series selection, no 
information for that cycle would be saved.  Now the cycle is saved and when 
read back, the ‘Current’ Z-Series will be selected by default.

b. Previously, if a cycle was a ‘TriggerSync Experiment’, it would be read back 
and the cycle set even if TriggerSync was not running.  Now, if TriggerSync is 
not running when the T-Series settings are loaded, any TriggerSync experiment 
cycles will be left out automatically.

c. Previously, for an image sequence cycle, if the ‘TriggerSync Experiment’ 
checkbox was checked, no record of that was saved with the T-Series 
configuration.  Now, this state is saved.  When this cycle is read back, if 
TriggerSync is not running, then this setting is automatically ignored.

117. Corrected a problem within T-Series where for certain acquisition setups some 
images are overwritten with subsequent cycles/iterations.

118. Within the objective lens calibration process a problem was corrected where an 
error message was generated if the operator entered a value such as ‘10x’ in the 
‘Power’ column for an objective lens.  With this fix, if the operator enters a value 
such as ‘10x’, it will automatically be changed to ‘10’ and no error message will be 
displayed.

119. Corrected a problem when a ‘Labels’ file (‘Labels.xml’) does not contain the 
‘Current Settings’ label, after the file was read, the ‘Current Settings’ label was 
being added to the end of the labels list instead of being inserted into the beginning 
of the list.  This would create problems in how the ‘Current Settings’ label was being 
executed.

120. Modified Prairie View so that if no objective lenses are loaded when the 
program is started (the objectives.xml file is either missing, corrupted, or empty), 
one default objective lens will be created.

a. Prairie View was further modified so that all of the objective lenses may not 
be deleted from the program.  By default there will always be at least one 
objective lens.

121. Modified how the ‘Freeze’ channel and ‘Freeze’ image window works to correct 
for a problem.

122. When a new image window is created (‘New Window’ button is pressed), if any of 
the channels are currently frozen, the corresponding channel buttons in the new image 
window will appear as frozen as well.

123. Corrected a problem where an error was generated if in a T-Series cycle the 
operator had checked the ‘BOT’ box, unchecked the ‘Max Speed’ box, and set the number 
of frames to average to be greater than 1.

124. Corrected a problem with trying to play back T-Series that included at least 
one cycle with the ‘BOT’ option checked and at least one additional image acquisition 
cycle.

125. Fixed a problem in the computation of the FWHN (Full Width Half Maximum) when 
the ‘Z mode’ box is checked in the ‘Line Profile’ dialog.  This option is only 
available when displaying a data set in Playback mode and the ‘MIP’ display option is 
currently set.



Version 3.0.0.0

126. The control of the new style preamplifier is now integrated into Prairie View.  
These controls are configured via the ‘PrairieConfigUtility.exe’ program.  The 
controls are located on the ‘Laser,PMT,DAQ’ tab, behind the PMT controls.  You can get 
to these controls by click on the vertical green button located to the left of the PMT 
controls.

a. To modify a preamplifier setting, first use the ‘Channel Selection’ combo box 
to select the channel you’d like to change the control setting for.  Then use 
the ‘Gain’ ‘Offset’, and ‘Filter Bank’ controls to modify the desired 
parameter.

b. * NOTE *  When you change the ‘Filter Bank’ value for one channel, it will 
change the filter bank selection for all channels.

c. Under the ‘Tools’ menu option, a new option has been added ‘Reset 
Preamplifier’.  When this option is selected, the preamplifier will be reset to 
it’s default operating parameters.  The primary purpose for this menu option is 
that on a rare occasion, when Prairie View is started, the control of the 
preamplifier might not initialize properly, so by selecting this menu option, 
the preamplifier should be reinitialized and properly communicating with 
Prairie View.

127. An addition has been made to the context menu associated with the channel 
buttons (and channel color controls) in the image windows.  If you right click on 
either control, the new menu item is ‘Freeze Channel’.  If this option is selected, a 
snowflake icon will appear behind the channel name in the button.  In addition, when 
the channel is ‘frozen’ the data in that channel will not be modified when the ‘Live 
Scan’, ‘Single Scan’ or other image acquisitions are run.  This will affect the frozen 
channel in all image windows.  This ‘Freeze Channel’ control acts like a toggle, so 
simply select the option in the menu to turn it off.  When it is turned off the 
snowflake will no longer be visible.

128. An additional button has been added to the image windows.  This button is 
called ‘Freeze’.  When this button is pressed it will freeze the image display (all 
channels).  So any subsequent image acquisition will not affect the data displayed in 
this image window.  When you want to turn this action off, simply click the ‘Freeze’ 
button again.

129. TriggerSync
a. Starting with version 1.3.2, the operator may now select to save acquired data 

in the ‘Igor’ program format.  Whenever the operator selects to save data, he/
she will be prompted for the file format (TriggerSync, Spreadsheet (e.g. 
Excel), or Igor).  When the automatic data saving option is selected, the data 
will be stored in the format that is specified in the ‘Preferences’ dialog.

b. When TriggerSync is being used in conjunction with Prairie View on a dual galvo 
system (imaging galvos and uncaging galvos), there has been an additional 
control added to the main dialog and on the ‘Mark Points’ dialog as well called 
‘Galvo Selection’.  This control allows the operator to select which galvo set 
to use for an experiment within TriggerSync that involves marked points.

i. To make this feature work, the BNC-2110 ‘AO 5’ signal which is 
normally connected to the ‘X Input’ on the uncaging galvo driver box, 
must now be ‘teed’ and also connected to the ‘X2 Input’ on the imaging 
galvo driver box.  Similarly, the ‘AO 7’ signal on the BNC-2110 which is 
normally connected to the ‘Y Input’ on the uncaging galvo driver box 
must now be ‘teed’ and also connected to the ‘Y2 Input’ on the imaging 
galvo driver box.

ii. Also, the ‘Switch’ signal on the imaging galvo driver box must 
be properly configured and wired. To validate the configuration, start 
the program ‘PrairieConfigUtility.exe’ and load the ‘configuration.xml’ 
file.  Navigate to the ‘TriggerSync’ tab.  Click on the box ‘Beam 
Control 1 Enabled’ (you should see a check in the box).  The remainder 
of the controls should be set as follows; Device Type = 
PVDigitalOutputActiveX, Polarity = 0, Device = 1, Port = 0, and Line = 
0.  After making the necessary changes, save the changes to the 
‘configuration.xml’ file.  To check the necessary wiring, there should 
be a BNC cable that has one end connected to the ‘Switch’ BNC connection 



on the back of the imaging galvo driver box and the other end should be 
connected to the BNC connection ‘USER 2’ on the BNC-2090A box (connected 
to the PCI-6052).

c. When the ‘Save Point Images’ button on the ‘Mark Points’ dialog is pressed, if 
the operator selects to not over write an existing file, the program will no 
longer display an error message or accidentally over write the files.

d. Previously, sometimes when the 'Acquire' button was pressed, an error similar 
to the following 'error -10010 AO Control...' would appear.  This seems to be 
happen when the number of analog output waveforms was an odd number and the 
number of samples in each output waveform was an odd number as well.  This was 
corrected by simply adding a copy of the last value in each waveform output to 
the end of the output waveform to generate an even number of output samples 
when necessary.

130. LinescanViewer
a. Version updated to 3.3
b. The program has been updated to work with linescan data that is spread across 

multiple files when it is acquired in Prairie View.  When a selected linescan 
is spread across multiple files, a new control ‘Line Segment’ is enabled 
directly below the list of linescan lines.  This control allows the operator to 
select which image from the sequence that constitutes the linescan he/she 
wishes to see.  At the same time, in the graph window, two vertical black 
cursors are displayed showing the time segment of the profile data that 
corresponds to the currently selected image.

c. Under the file menu, when the operator chooses to export all data, he/she will 
be prompted for the export data type; Spreadsheet format (e.g. Excel) or Igor 
format.  If the operator chooses Igor format, then for each linescan in the 
data set will have potentially two files generated for it.  If there was 
TriggerSync data acquired with the linescan image, then the TriggerSync data 
will be exported in Igor format in one file, and if any ‘profiles’ exist for 
the line, then the profile data will be written to another file.

131. Mark Points
a. The ‘Mark Points’ wizard (activated from the ‘Mark Points’ dialog by pressing 

the ‘Configure’ button, now includes an additional control ‘Galvo Selection’ if 
the system includes two sets of galvos (imaging galvos and uncaging galvos).  
This control allows the operator to select which galvo set to use for an 
experiment within TriggerSync that involves marked points.  If the system does 
not contain two sets of galvos, this control is not visible.

b. An additional option has been added to the list of ‘mark point’ choices for the 
operator.  In addition to the previous choices of ‘Point’, ‘Line’, and ‘Grid’, 
the option ‘Freehand’ has been added.  When the operator selects this option, 
he/she may draw a line in the window (click and drag).  Then after the line has 
been drawn, the number of points along the line may be set and the software 
will automatically determine the proper placement of the points along the line.

c. As a reminder, to quickly define a group of random points, simply right click 
the mouse in the image on the desired location and a point will be ‘marked’ 
there.

132. In the linescan dialog, there is a new button ‘Append Linescan(s)’.  By using 
this button, each linescan that is acquired is appended to the current linescan data 
set.  When the ‘Start Linescan(s)’ button is pressed, only those linescans in the 
current definition (based on the setting in the ‘Repetitions’ field) will comprise the 
linescan data set.

133. Many general interface changes have been made to generate a more consistent 
look to the GUI (Graphical User Interface).

134. The narrow vertical green buttons that have been used to switch between ‘panes’ 
on the user interface have had left and right arrows added to them to make it more 
apparent that these are actual controls.

135. In the main interface window, the panning and stage controls have been 
unstacked so that both are visible at all times.  The panning controls have been moved 
to the left hand side above the various control tabs.  Controls related to stage 
movement that had been duplicated in some of the tabs (Z-Series and XY Stage) have 
been removed.

136. Removed the menu option that allowed the operator to set the active channel 
button color in the image windows.  The active channel color is always green to match 
all other buttons.



137. Image Window(s)
a. All of the buttons were made to look like those in the main window.
b. When playback mode is active, the play buttons are now highlighted.
c. When the ‘Metadata’ window is popped up when am image set is loaded, the first 

tree node is automatically expanded to show the sequences.
d. When the image window is enlarged, scrollbars will appear around the image 

instead of the image window so controls are always visible.
e. When scrolling an image, he scale bar and playback information overlays scroll 

with the image, always displaying in the appropriate corners.
f. If scrollbars are displayed, the operator may click and drag anywhere on the 

image to move the image.
g. When the MIP (Maximum Intensity Projection) mode is activated during playback, 

if the image window combined with the XZ and YZ views won’t fit on the screen, 
the image window will be automatically resized to allow the necessary space.

h. If the MIP image is larger than the current image window and scrollbars are 
used, then the XZ and YZ views will automatically scroll as well.

i. The XZ and YZ windows displayed during MIP no longer have minimum height and/or 
width restrictions.

138. Photo Activation
a. Removed some buttons that duplicated functionality.
b. Added the ability to save/load photo activation masks within the current 

execution session of Prairie View (these are lost when the program exits).  
These actions use the ‘Save’, ‘Load’, and ‘Delete’ buttons along the right side 
of the image window that are shown when the photo activation mode is active.

c. Added the ability to import/export photo activation masks to a file.  This 
allows the same masks to be used across multiple sessions of Prairie View.  
These actions use the ‘Import…’ and ‘Export…’ buttons along the right side of 
the image window that are shown when the photo activation mode is active.

d. A transparency slider control has been added.  This allows the operator to 
control the opacity of the display of the photo activation masks.

e. Added a new drawing option, the brush tool.  This tool will allow the operator 
to ‘paint’ areas of the image for the photo activation definition.  There are 
three brush sizes available; small (2% of display), medium (4% of display) and 
large (8% of display).  The brush tool also has the ability to erase as well.  
Click on the ‘Brush’ button or context menu button and select the ‘Erase’ 
option, then draw in the image where you wish to erase part of a previously 
drawn mask area.

f. Added a ‘Selection Tool’ button that can be used to select/move/resize/copy a 
portion of a mask.  When using the selection tool to select a rectangular 
region of the mask, left click and dragging will move the selection, while 
right click and dragging will move a copy of the selection.  By clicking and 
dragging on the handles of the selection box the selection will be resized.  If 
the ‘Invert’ or ‘Clear’ buttons are pressed while a selection is active, then 
those operations will only be performed on the selected region.

g. Fixed a couple of problems where drawing overlapping mask elements would 
sometimes result in areas where the mask was being cleared accidentally.

139. Prairie View can now support multiple simultaneous z motor devices.  This 
requires setting up each device in the ‘PrairieConfigUtility’ program.  When multiple 
z motor devices exist, there is a new ‘Z Device’ control located in the ‘Stage 
Control’ section that allows the operator to select the desired device.  The selected 
device is the one that will be moved interactively via the z motor controls.  In 
addition, when a Z-Series is defined, it is associated with the selected device.  In 
this manner, separate Z-Series may be defined for each of the devices.

140. Within the Z-Series tab, there is now the ability to generate multiple Z-Series 
definitions.  Each definition is completely independent of one another.  After 
defining the Z-Series, click on the ‘Save’ button and the current Z-Series definition 
will be added to the ‘Saved Z-Series’ list.

a. A separate photo activation definition may be associated with each Z-Series 
definition as well.

141. In the T-Series tab, the ‘Z-Series’ column has been changed from a check box, 
to a drop down control.  To execute a Z-Series within the T-Series, simply select the 
desired Z-Series from the list of currently defined Z-Series.  The drop down options 
are; ‘None’ (default), ‘Current’ (currently defined Z-Series), or any of the ‘saved’ 
Z-Series.



142. In the T-Series tab, the ‘PA’ column has been changed from a check box, to a 
drop down control.  To execute a photo activation scan(s) within the Z-Series, simply 
select the desired photo activation sequence from the list of currently defined photo 
activation masks.  The drop down options are; ‘None’ (default), ‘Current’ (currently 
defined photo activation masks), or any of the ‘saved’ photo activation masks.  If the 
selected photo activation mask does not match the selected Z-Series for the number of 
frames and image size, that photo activation mask can not be selected.

143. In the T-Series tab, when TriggerSync is not running, the colums in the T-
Series cycle grid are not displayed.  This allows for greater visibility of the 
remaining columns.  If TriggerSync is started, the necessary columns will 
automatically become visible.

144. In the T-Series, when XY Stage locations are added as a cycle, the location was 
always being set to (0, 0, 0).  This has been fixed.

145. Corrected a problem where on the 2-P laser tab, sometimes the updating of the 
current laser status information (shutter state, wavelength, and power) would stop.

146. ‘Drop Down’ buttons (narrow buttons with downward pointing arrows) have been 
added to the ‘ROI’ and ‘MIP’ buttons in the image windows.  This is used to more 
clearly indicate to the operator that there is a context menu associated with the 
button.  The context menu may be selected by either right clicking on the ‘ROI’ or 
‘MIP’ button or by left or right clicking on the new drop down button.

147. All context menus now include a ‘Cancel’ option.
148. Additional help/information has been added for some image window operations. 

For example, when the ROI button is clicked, a message now appears which says “Left 
click to start dragging region”.  This also applies when editing Photo Activation 
masks and a few other places.

149. When the main image window has focus during image playback, the arrow keys on 
the keyboard may be used to switch between frames (up and down arrows) or data sets 
(sequences) (left and right arrows).  The arrow keys will not work in this manner if a 
text box is active or if a scrollbar is active since these controls already make use 
of the arrow keys.

150. ROI (Region of Interest)
a. The context menu associated with the ROI button in the image windows was 

modified to be more intelligent.  The save option is not displayed if you are 
not in Roi mode, the load/delete options are not displayed if there are no 
saved ROIs.

b. The ‘Delete All ROIs’ menu option that used to be located under the ‘Tools’ 
menu option has been placed in the ROI button context menu and is called 
‘Delete All’.

c. The operator now has the ability to delete individual ROI definitions via the 
ROI button context menu.

d. The interface for loading saved ROIs has been redesigned.  The previous 
behavior had been to display nothing and then when the user clicked on the 
image window, the region would appear at its original location and then re-
center on the mouse position.  The region would then move as the mouse was 
moved until the mouse button was released.  The new behaviour is to show the 
saved region on the screen at its original location with ‘handles’ to resize it 
and the ability to click and drag the region location.  There are two ‘buttons’ 
displayed in the upper right hand corner to either cancel the ROI or accept the 
ROI size and location.

e. The pop-up dialog for saving ROIs will now check for duplicate ROI names and 
will not allow them.

151. Fixed a problem when fluorescent unmixing was being used with frame averaging.
152. Within the ‘Mark Points’ dialog, the random point order functionality was added 

to lines and grids.
153. A new display option has been added to the ‘Display’ menu option.  This new 

option is ‘Interpolation Mode’.  There are five possible settings for the 
interpolation mode; Nearest Neighbor, Bilinear, Bicubic, High Quality Bilinear, and 
High Quality Bicubic.

a. This parameter controls how an image is displayed in an image window when the 
image window is larger than the actual image.  For example, if the current 
image size is 512x512 and the image window is 512x512, then the interpolation 
mode will have no impact on the image display since there is no more than one 
display pixel for each image pixel.  If the image size is 64x64 and the display 
size is 512x512, then the interpolation mode will determine how the image 



pixels are interpolated to generate the necessarily larger image display.
154. When the image size is smaller than the display size (e.g. 64x64 image size 

versus a display size of 512x512), then when the operator clicks on the ‘ROI’ button 
to create an ROI, as he/she draws the ROI, the display box that represents the ROI 
will automatically bind itself to the edge of a pixel based on the actual image size 
and not based on the display size.

a. Using the example of a 64x64 image size with a display size of 512x512, then as 
the ROI is being drawn, the ROI box will jump eight (8) pixels on the display 
as the box is enlarged or shrunk.

155. Copyright information was added to the ‘Splash’ screen that is displayed while 
Prairie View is initializing.

156. Under the ‘Tools’ menu option, the ‘Reset Dodt Controller’ option was added.  
This option is only active if the system has a USB controlled Dodt detector installed.  
This operates in the same manner as the ‘Reset Preamplifier’ button in that it will 
attempt to reset the communication link to the Dodt controller.

157. Under the ‘File’ menu option, the three ROI related items (Load ROI 
Definitions, Save ROI Definitions, and Save ROI Reference Image) have been removed and 
placed within the context menu associated with the ‘ROI’ button in the image windows.

158. Corrected a problem in the ‘Mark Points’ configuration dialog (wizard) where 
the program did not recognize when the operator entered a new base directory/name for 
saving TriggerSync data.

159. Modified the optional ‘Start of Frame’ trigger logic so that the trigger will 
only be generated during ‘Live Scan’ or in a T-Series when the ‘Max Speed’ option is 
checked.  As previously, this trigger will start with the second frame in the 
sequence.

160. Modified the optional ‘End of Frame’ trigger logic so that when frame averaging 
is enabled (the control for averaging frames is set to something greater than 1), the 
trigger will not be generated until the end of the last frame (e.g. if the number of 
frames to average is four (4), the end of frame trigger will only be generated at the 
end of frame number 4).

161. Within the ‘Line Profile’ dialog additional display values were added for the 
location of the left/right cursors and the distance between them.

162. On the bottom of the ‘Metadata’ window that is shown during image playback, a 
checkbox control has been added.  This control is labeled ‘Automatically show when 
entering playback mode?’ and the default value is that it is checked.  When this 
button is checked, then whenever the program goes into playback mode (end of a T-
Series, Z-Series, and etc.), then this Metadata window will be displayed as well.  If 
this box is not checked, then when the program goes into playback mode, the Metadata 
window will not be shown by default.  In either case, if the ‘Info.’ Button is 
pressed, the Metadata window will be turned on/off as it always has been.

163. Added two new buttons next to the Z-motor controls.  These buttons are used to 
set the ‘Start’ and ‘Stop’ positions (and associated PMT/Laser settings if the ‘Adjust 
PMT & Laser’ checkbox on the ‘Z-Series’ tab is checked).  These buttons work just like 
the ‘Set Start Limits’ and ‘Set Stop Limits’ buttons on the ‘Z-Series’ tab.

a. The new ‘Start’ position button is shown as a group of horizontal lines where 
the top line is shown in red and the other lines are shown in black.

b. The new ‘Stop’ position button is shown as a group of horizontal lines where 
the bottom line is shown in red and the other lines are shown in black.

164. In the dialog that is displayed when ‘About…’ menu option is selected under the 
‘Help’ menu option, the copyright years was updated from ‘2005’ to ‘2005-2007’.

165. Modified ROI creation so that the number of pixels in the ROI in the X 
dimension must be a multiple of 4.  As the operator draws the ROI, the ‘box’ boundary 
will automatically align on the proper pixel boundary.

166. Modified the menu options for Prairie View.  A new item ‘Applications’ has been 
added to the top-level menu.  Under this option, is either one or two other options 
depending upon the system configuration.  The option ‘LinescanViewer’ should be 
present on every system since this application is part of all software version/
customer configurations.  The option ‘TriggerSync’ will only be present if the 
customer has purchased the TriggerSync (formerly VClamp) option.  When either of these 
items is selected, the appropriate application will be started.

167. On the ‘Linescan Control’ dialog, two new controls have been added.  Located 
directly below the ‘Free draw linescan mode’ checkbox, is a new checkbox called ‘Open’ 
and a combo box control next to it for a channel selection.  These controls are only 
active if the LinescanViewer program is currently running.  If the ‘Open’ checkbox is 



checked, then at the end of any linescan acquisition, the acquire linescan data (and 
TriggerSync data if appropriate) will be automatically loaded and displayed within the 
LinescanViewer application.  If more than one channel of linescan data is being 
acquired, the operator may select which channel of linescan data to load into the 
LinescanViewer application (currently LinescanViewer does not support the display/
analysis of multiple channel data, each channel must be processed independently).

168. The LUT (LookUp Table) is now active during image acquisition.  This gives the 
operator the ability to adjust the image display via the LUT while live scanning.

169. Corrected a problem with linescan image data.  If the image resolution (e.g. 
512x512) is changed after linescan mode is turned on, then when the ‘Start 
Linescan(s)’ or ‘Append Linescan(s)’ button is pressed, the operator will be 
instructed that a new reference image must be acquired before the linescan acquisition 
can be executed.  Before this issue was corrected, the problem would manifest itself 
when processing the linescan image data with the ‘LinescanViewer’ application.

170. In Playback mode the default ‘Delay’ between images was changed from 100 to 10 
miliseconds.

171. If the cursor is placed in an image window while an image is being updated, the 
pixel intensity information based upon the cursor location was not being updated 
unless the cursor itself was moved.

172. Corrected a problem when the “Live Scan” or various “Start” acquisition buttons 
are pressed too rapidly, there could be an occasional software lock-up or crash.

173. If the operator defines an ROI and saves it and then later, if the operator 
should ‘Load’ the ROI, if the operator changes either the location or size of the ROI, 
an additional ‘button’ will appear in the image window ‘Save ROI’.  If the operator 
presses this button, the new ROI definition (size and location) will be used with this 
particular ROI.

174. Modified the scrollbars for the number of pixels per line and the number of 
lines per frame to have a new maximum value of 2048 instead of 1024.
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175. With the ‘Mark Points’ dialog, when the ‘Configure’ button is pressed and the 
configuration wizard dialog appears, support has now been added to allow the use of an 
I/V protocol for synchronization with marked points (previously only a Pulse/Train 
protocol was able to be used for synchronization with marked points.

176. Corrected a problem in the ‘Mark Points’ interface where the displayed distance 
between points for a ‘line’ definition was being incorrectly computed.

177. The ‘New Window’ button was moved from the location next to the ‘Live Scan’ 
button and placed in with the group of controls located below the ‘Optical Zoom’ 
controls.  This group of controls has been renamed from ‘Window Size’ to ‘Image 
Windows & Size’.

178. Next to the ‘Live Scan’ button have been added a checkbox control that allows 
the operator to turn on/off a ‘Running Average’ capability when using the ‘Live Scan’ 
option.

a. Next to the checkbox is a control that allows the operator to select the number 
of frames to use when Running Average is enabled.  The current range is 2 to 8 
frames.

b. This ‘Running Average’ feature is only available during ‘Live Scan’.  It is not 
applied when the ‘Max. Speed’ option is checked in the ‘T-Series’ or during a 
‘BOT’ acquisition.

179. TriggerSync
a. The format for the binary file that is used within TriggerSync for saving 

experiment data is as follows:
i. The file begins with 616 bytes of header (starting with ‘DTLG’), 
which appears to be irrelevant for the purposes of extracting data.

ii. The next byte (first important value) at a hex address of 268 is 
the number of channels/sets of data stored as a 4 byte long.

iii. The value after that at address 26C is the number of data points 
in the sample stored as a 4 byte long.

iv. The rest of the file starting at address 270 is a listing of all 
of the data values in the following order;



1. Channel 1:Value 1, Channel 1:Value 2 . . . Channel 1:Value N
2. Channel 2:Value 1, Channel 2:Value 2 . . . Channel 2:Value N
3. Channel M:Value 1, Channel M:Value 2 . . . Channel M:Value N

v. Each of these values is stored in a 32 bit IEEE single precision 
floating point format.

vi. All values are stored as big endian.
b. In the main window of TriggerSync, as well as the Mark Points dialog window and 

the Photolysis Calibration Window, there is a new control called ‘Image Channel 
to Display’.  This control allows the operator to select the image channel to 
display from Prairie View.  Previously, only the first channel that was turned 
on in Prairie View was displayed in TriggerSync.  With this limitation, if the 
operator wanted to use the image from channel 2 in the Mark Points dialog of 
TriggerSync, he/she would first have to turn off channel 1 in Prairie View.  
With this modification, the operator may leave both channels 1 and 2 turned on 
in Prairie View and simply select the channel they wish to see within 
TriggerSync.

180. The color associated with a channel in the image windows may now be changed by 
right clicking on the channel button in the image windows as well as the original 
method of right clicking on the color indicator located next to the channel button.

181. Brightness Over Time (BOT) dialog and capabilities have been greatly enhanced.
a. First and foremost, the BOT dialog can be activated when ‘Playback’ mode is 

active.  This allows you to perform BOT analysis on images after they have been 
collected as well as the previous capability of being able to perform the BOT 
analysis during some image acquisition.  This means that the BOT analysis 
capabilities may be applied to Z-Series, all T-Series cycles, W-Series, and so 
on.

b. All of the new features will work during acquisition or during Playback 
analysis.

c. New ‘Region’ shapes are available.  In addition to the previously available 
‘rectangle’, the operator may also select an ‘ellipse’ or a ‘polygon’.

d. In playback mode, after creating/editing the regions, to update the graph, 
press the ‘Start’ button.  The program will cycle through the current data set 
and generate the graph of data.

e. Along the right hand side of the graph window are the controls for the graph 
display.

i. For the horizontal scale (x-axis), the operator may select from 
‘Seconds’ or ‘Frames’.  This will control the ‘units’ for the x-axis.

1. The operator may select from ‘Best Fit’ (auto. Scale) or ‘Fixed’ 
for the scale width.

2. When ‘Fixed’ is chosen, the control located below the selection 
item is used to specify the number of seconds or frames that the 
graph width should display.

3. The ‘Offset’ control located directly below allows the operator 
to specify the left limit for the graph (essentially the first 
value of the graph x-axis).  This is only applicable when the 
‘Fixed’ option is selected.

ii. For the vertical scale (y-axis), the operator may choose a 
linear scale (default when ‘Log Scale’ is not checked) or a logarithmic 
scale (if ‘Log Scale’ is checked).

1. The operator may select from ‘Best Fit’ (auto. Scale) or ‘Fixed’ 
for the scale width.

2. When ‘Fixed’ is chosen, the control located below the selection 
item is used to specify the intensity range that the graph 
height should display.

3. The ‘Offset’ control located directly below allows the operator 
to specify the lower limit for the graph (essentially the first 
value of the graph y-axis).  This is only applicable when the 
‘Fixed’ option is selected.

f. Located below the Horizontal and Vertical scale controls is a control that 
allows the operator to ‘average’ the data over a number of frames.

g. Located below the controls used for creating regions and selecting region 
shapes is a control that allows the operator to select the action that should 
be ‘attached’ to the right mouse button.

i. If ‘Resize’ is chosen, then when the mouse is placed over the 



number for the region in the image window and the operator clicks and 
holds the right mouse button, the selected region my be resized.  The 
resizing will stop when the right mouse button is released.

ii. If the  ‘Rotate’ option is chosen, then when the mouse is placed 
over the number for the region in the image window and the operator 
clicks and holds the right mouse button, the selected region my be 
rotated.  The rotating will stop when the right mouse button is 
released.

iii. If the  ‘Clone’ option is chosen, then when the mouse is placed 
over the number for the region in the image window and the operator 
right clicks the mouse button, the selected region will be exactly 
duplicated (size, location, and channel association).

h. When ‘Add New’ is turned off and ‘Move All’ is off, when the cursor is moved 
over the region number it will automatically turn into a ‘hand’ cursor and this 
indicates that you can move this particular region.  To move the region, click 
and hold the left mouse button and move the mouse and release the left mouse 
button to place the region in the desired location.

i. When the ‘Move All’ button is pressed, all of the regions will be shown in the 
selected highlight color of cyan.  Then simply place the cursor over any region 
number in the image display window so that the hand cursor is shown, then click 
and hold the left mouse button and move the mouse to move all of the regions.  
Release the left mouse button to fix the regions in the desired locations.  As 
soon as the mouse is released, the ‘Move All’ button is turned off.

j. When the ‘Save Changes’ button is pressed, the current region definitions and 
data will be saved with the images.

k. When the ‘Save Changes As’ button is pressed, the current regions definitions, 
data, and a screenshot of the current image window will be saved in a new set 
of files from the original data, but in the same directory.  This includes 
creating a new .xml file that is associated with the data so that if the 
operator wishes to reload the data, they can choose from different .xml files 
and hence see different region definitions and data.

l. In the upper right hand corner of the ‘Brightness Over Time Regions’ table is a 
control that lets the operator change the units that are used in the table 
between pixels and microns.  When the shape of the region is an ellipse or a 
polygon, the ‘Width’ and ‘Height’ values indicate the size of the bounding box 
that would encompass the shape.  The value for the ‘Area’ is the area of the 
shape of the region, not the bounding box.  When microns are chosen for the 
values, the computations are based upon the currently selected objective lens.

m. If the operator clicks the right mouse button over any of the defined regions 
in the region table, a pop-up menu will appear that will allow the operator to 
very quickly set up some basic region math.  This could be simply specifying 
that region 2 should be subtracted from region 1, or possibly subtract region 2 
from all other regions.

i. When a mathematical relationship is defined via the pop-up menu, 
the region name will indicate the relationship.  For example, if it was 
specified to subtract region 2 from region 1, the label in region one 
would change from ‘1’ to ‘1-2’.

ii. If the ‘Region Alone’ option is selected in the pop-up menu, 
then the defined mathematical relationship for that region will be 
removed.

iii. If the ‘All Alone’ option is selected in the pop-up menu, then 
all defined mathematical relationships that were generated previously in 
the pop-up menu will be removed.

iv. The ‘Import Regions..’ and ‘Export Regions..’ buttons allow the 
operator to save a set of region definitions to a file and to recall 
them later.  This could be useful if the operator wishes to use 
consistently sized regions over multiple data sets.  He/she could save a 
set of regions using the ‘Export Regions..’ button and then when a new 
data set is loaded, use the ‘Import Regions…’ button to load the 
regions.  The region locations could then be manually set where desired.

n. Located below the table of region definitions is a set of controls for ‘Region 
Group’.

i. To create a region ‘Group’, first create the regions in the 
image window via the ‘Add New’ button.  Next, place a check in the box 



next to the region number in the ‘Display?’ column that you wish to be 
part of the region group.  Uncheck any regions you do not wish to have 
part of the group.  Now press the ‘Create Group’ button and a group will 
be created that consists of the specified regions.

ii. To change a group definition, first check/uncheck the desired 
regions in the region table, then select the desired ‘group’ (left click 
on the group and it will be highlighted), and then press the ‘Update 
Selected’ button and the group definition will be changed.

iii. By clicking on the checkbox next to the group number, the 
operator can alter what region graphs are displayed.

o. Located below the ‘Region Groups’ is a set of controls for ‘Regions Functions’.  
This section allows the operator to create mathematical graphs that are 
mathematical manipulations of the data from one or more defined region.  This 
is in addition to the predefined mathematical options presented by right 
clicking the mouse over a region definition as outlined above in section m.  In 
addition, these ‘functions’ will display as new graph data.

i. To create a ‘function’, click on the ‘Create Function’ button.  
After you click on the ‘Create Function’ button, it will turn ‘green’ 
showing that this mode is activated, if you want to exit this mode 
without actually entering a formula or equation, simply click on the 
‘Create Function’ button again.

1. This will activate a control, just below the buttons that allows 
the operator to select from a list of pre-defined mathematical 
functions (e.g. f/f0).  Also activated, is a control just below 
the list of functions that allows the operator to modify the 
pre-defined equation, or to enter an equation of their own 
choosing.

2. Located just below the control/field where the equation is shown 
is a string shown in blue that reads ‘Need help with function 
syntax?’.  If you click on this string, a help dialog will 
appear with additional information about the proper syntax for 
the mathematical functions.

3. Some sample equations are as follows:
a. Let’s say that instead of looking at the average 

intensity of a region over time (standard graph of a 
region) we want to see the relative change in the region 
intensity information over time.  Basically we want to 
look at the difference between the intensity values from 
one frame to the next.  If the region we were interested 
in was region 2, the equation would be:  {2} – {2:-1}

b. Many standard mathematical functions are available by 
using the following syntax: Math.Log(), Math.Min(), and 
etc.  For example;

i. To compute the logarithm for the data in 
region 3, the syntax would be: Math.Log({3})

ii. To generate the absolute value of 
subtracting the value of region 1 from region 2, 
the syntax would be: Math.Abs({2} – {1})

182. In the Playback ‘Meta’ Data window, the setting for the laser power (Pockels) 
is now displayed along with the other parameters.

183. Corrected a problem where some combinations of image size and dwell time would 
result in corrupted images.  This was mostly the result of image sizes of 512x512 or 
1024x1024 with large dwell times.

184. Activated the 2048x2048 image size for galvonometer scanning.  This option is 
not available with the AOD scanning option.  If the image size is set to anything 
larger than 1024x1024 when AOD mode is activated, the image size will be automatically 
set to 512x512.

185. Corrected a problem in previous versions when after having ‘Live Scan’ turned 
on, and then turned off, if the operator pressed the ‘camera’ button in the image 
window, the last image was not being saved (as a matter of fact, no image was being 
saved).
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186. When the image height is greater than 1000 pixels (e.g. 1024x1024), a vertical 
scroll bar will automatically appear in the image window allowing the operator to have 
access to the entire image and all Prairie View controls.

187. The ‘Oz’ tab has been replaced with a ‘Labels’ tab.  The label controls have 
been moved from the ‘Misc’ tab to the ‘Labels’ tab.  The controls that were on the 
former ‘Oz’ tab have been moved to a separate dialog that is accessed from the ‘Oz…’ 
menu option under the ‘Tools’ menu option.

188. Controls for the new USB controlled Dodt Detector device have been added to the 
‘Misc.’ tab.  The configuration parameters for this new device are found on the 
‘Misc.’ tab in ‘PrairieConfigUtility.exe’.

189. A new feature has been added to the T-Series acquisitions for customers that 
also have the TriggerSync software option.  This feature allows the operator to set up 
a sequence of images to acquire, and have TriggerSync start its experiment on whatever 
image number in the sequence that the user desires.  This all happens without any 
break in the image acquisition sequence.  What this allows then is for the operator to 
acquire a sequence of images where the first ‘n’ images represent a baseline before 
the TriggerSync experiment is launched and the remaining image represent the changes 
to the image after the TriggerSync experiment and there is no time lag between these 
two groups of images.  This feature will also work if the ‘BOT’ option is checked in 
the T-Series.

a. A new item has been added to the ‘File’ menu option.
i. Under the ‘Preferences’ menu option, there is a new option 
‘Output Trigger Type’.  This option has a pull-right menu with two 
options available to the operator, ‘Start of Frame Trigger’ and/or ‘End 
of Frame Trigger’.

ii. The operator selected ‘Output Trigger Type’ is the signal that 
will be used to trigger the start of the TriggerSync experiment for this 
feature.  Therefore the operator can choose to trigger the TriggerSync 
experiment with a signal at the start of a frame or the signal at the 
end of a frame.

iii. The necessary wiring for this feature is as follows:
1. On BNC-2110 (connected to PCI-6713), insert a wire jumper 

between ‘PFI8’ and ‘USER2’ in the ‘push’ connector.
2. Add a wire jumper between ‘PFI8’ on BNC-2090A (connected to 

PCI-6052) and ‘CTR1OUT’ on BNC-2110 (connected to PCI-6713) in 
the ‘push’ connectors.

3. Add a BNC cable between ‘USER1’ BNC connection on BNC-2090B 
(connected to PCI-611x) and ‘USER2’ BNC on BNC-2110 (connected 
to PCI-6713).

iv. The necessary software configuration for this feature is as 
follows:

1. Start the program ‘PrairieConfigUtility.exe’
2. Load the ‘configuration.xml’ file.
3. Click on the ‘Misc’ tab.
4. Set the value for ‘End of Frame Trigger’ to 2.
5. Set the value for ‘Start of Frame Trigger’ to 2.
6. Click on the ‘UI’ tab.
7. Save the ‘configuration.xml’ file.

b. Two new columns have been added to T-Series, ‘TriggerSync Experiment’ and 
‘TriggerSync Image #’.

i. The column labeled ‘TriggerSync Experiment’ will display a 
checkbox whenever the current operating parameters would allow this 
feature to be used.  When this feature is not available ‘---‘ will be 
displayed instead of a checkbox.  Several examples are listed below:

1. When TriggerSync is not running this feature will not be 
available.

2. When TriggerSync is running, the ‘Output Trigger Type’ is set to 
‘Start of Frame Trigger’ and ‘Max. Speed’ is not checked, this 
feature will not be available.

3. When TriggerSync is running, the ‘Output Trigger Type’ is set to 
‘End of Frame Trigger’ and ‘Max. Speed’ is not checked, this 
feature will be available.

4. When ‘Z-Series’ is checked, this feature will not be available.



ii. The column labeled ‘TriggerSync Image #’ is the column where the 
operator will specify the desired image number within the image sequence 
to start the TriggerSync experiment.

1. When the ‘TriggerSync Experiment’ column is not checked (or not 
allowed), the operator may enter any number in the ‘TriggerSync 
Image #’ column.

2. When the ‘TriggerSync Experiment’ column is checked, then the 
value that is entered into this column will be processed such 
that it can never be less than ‘1’, and it can not be greater 
than the number of images in the image sequence.  Any attempt to 
enter a number outside of this range will result in the program 
automatically setting it to the nearest legal value when the 
‘Enter’ key is hit.

190. Under the ‘Help’ menu option, a new option, ‘Luigs & Neumann Technical Note’ 
has been added.  When selected, this will pop up a dialog that displays important 
technical information for systems that have the X-axis, Y-Axis, and/or Z-Axis 
controlled by an L&N controller and that control is currently configured for Prairie 
View control as well.

191. When an operator attempts to acquire a ‘Free Hand’ linescan without first 
defining the line, a message will be displayed to the operator informing them of the 
issue and then cleaning returning the linescan control dialog to the proper state.  
Previously, a standard Windows error message was displayed and the code did not return 
to a clean state.

192. All Prairie View windows will now automatically minimize or maximize when the 
main window is minimized or maximized.

193. All Prairie View windows will be set to ghost mode and not just the main 
window.

194. Corrected a problem so that Free Draw Linescans will work when the Scan 
Rotation is something other than 0.

195. When playback mode is active and a MIP (Maximum Intensity Projection) is 
displayed, if the ‘Camera’ icon is pressed to save the current MIP view, the XZ and YZ 
renderings will be saved as well.

196. When playback mode is active, the vertical controls will be used for playing 
through Z-Series data while the horizontal controls will be used for playing through 
T-Series data (or changing data sets when playing through time-lapse Z-Series).

197. When the ROI mode is activated and an ROI is drawn, the image memory will be 
automatically remapped so that the image in the image windows looks correct.

198. Within the ‘Scan Settings’ dialog, the button which had been labeled 
‘Configure’ has been changed to ‘Apply’.

199. The image display has been corrected to allow for the use of ‘Pseudocolor’ or 
‘Range Check’ on one channel along with either ‘Pseudocolor’, ‘Range Check’ or any of 
the other color selections for the other channels being displayed in the same image 
windows.

200. Added additional tool tip help messages.
201. Modified the scrollbar controls so that if the control has ‘focus’ the arrow 

keys on the keyboard may be used to adjust control values.
202. Modified the ‘tab’ order for the controls so that the operator may use the 

‘tab’ or ‘shift-tab’ keyboard buttons to move through the controls.
203. Corrected a couple of problem with the ‘timestamp’ values stored with BOT 

(Brightness Over Time) data.
a. One problem was that the first timestamp associated with images acquired during 

a T-Series did not always correctly match.
b. Another problem was when acquiring data from within the BOT dialog directly, 

the ‘average’ time difference between successive images across the entire group 
of images was correct, but the variability in the individual timestamps did not 
properly represent the image acquisition rate.

204. TriggerSync Changes:TriggerSync Changes:
a. When an experiment is saved in TriggerSync, the .prm file (which contains all 

of the experiment parameters) will be saved when the operator selects the 
‘Spreadsheet’ formatsave option.  Previously the .prm file was only saved when 
the operator selected the ‘TriggerSync’ format save option.

Version 2.5.1.6



205. In the ‘Linescan Control’ dialog the field ‘Time Delay Between Lines [ms]’ was 
changed to read ‘Line Period [ms]’.  In addition, this value now represents the exact 
‘Period’ between successive lines in the linescan acquisition.  In the previous 
addition, this value defaulted to ‘0.0’ and to determine the true ‘Period’ for 
linescan timing, you had to add this value to the current ‘Scanline Period [ms]’.  To 
that end, the minimum value that will now be displayed in this field is the same as 
the current value in ‘Scanline Period [ms]’.

206. Corrected a problem with the value for the ‘scanlinePeriod’ being saved in 
the .xml file associated with linescan acquisitions.  The saved value didn’t match the 
‘Line Period [ms]’ field value, but rather had been the value in the ‘Scanline Period 
[ms]’ field.

207. Previously, if TriggerSync was running and ‘connected’ to Prairie View, if 
TriggerSync crashed or exited abnormally, Prairie View would not clean up the 
connection and TriggerSync could not be restarted and ‘connected’ to Prairie View 
without first restarting Prairie View.  With this version, if TriggerSync exits 
abnormally (crash, via Task Manager, etc.), Prairie View will automatically clean up 
the connection thereby allowing TriggerSync to be restarted without having to restart 
Prairie View as well.

208. Corrected a problem where an incorrect value was being saved for the 
‘micronsPerPixel_Xaxis’ and ‘micronsPerPixel_Yaxis’ in the .xml and .cfg files when 
the optical zoom is greater than 1 and an ROI definition is being used.

209. The version of Prairie View is now written to the .xml files.  The version is 
also displayed in the ‘MetaData’ window during playback.

210. LinescanViewer Changes:
a. LinescanViewer has been updated to version 3.2
b. This new version includes a display section labeled ‘Linescan Image Parameters’ 

which displays many of the system settings that were used in the acquisition of 
the linescan image.

211. TriggerSync Changes:TriggerSync Changes:
a. TriggerSync has been updated to version 1.3.
b. Added the ability to ‘synchronize’ the ‘Marked Points’ with an I/V protocol in 

addition to the previously supported Pulse/Train protocol.  The ‘next’ point 
will be moved to at the end of an individual ‘epoch’ if the next epoch has a 
‘potential’ other than 0.0.  In this manner, a stepped pulse could be created 
where the point would move synchronized with the pulse epoch.  If the duration 
of the epoch is less than the ‘move time’ of the marked points, then that 
particular epoch will be skipped and the next point will be moved to at the end 
of the next epoch that has a duration longer than the ‘move time’.  If 
‘replicate points’ is turned on, the maximum number of points will be 26, since 
there are only 26 epochs.

c. In the ‘Mark Points dialog, an ‘Image Adjustment’ group of controls was added.  
If the ‘Auto. Scale’ option is on (default) the image displayed is 
automatically mapped to the dynamic range of the image (e.g. 55 – 1683).  If 
‘Auto. Scale’ is off, then the image is forced to the full display range 
possible for the data (0 – 4095).  If ‘Auto. Scale’ is off, then the ‘Scale’ 
control will become active.  The two sliders work similar to the LUT control in 
Prairie View.  Drag the lower and/or upper slider to the desired value and then 
press the ‘Update Image Display’ button.  Depending upon the size of the image 
(512x512 and etc.) it might take several seconds before the image is updated.  
Any newly acquired image will be automatically processed based upon these 
control settings.

d. In the ‘Preferences’ dialog five new options have been added.  The first is a 
control that lets the operator decide whether the data that is exported for use 
in spreadsheets should be scaled or left in its raw value.  The second option 
allows the operator to specify how to save data when performing a marked points 
experiment with the ‘Acquire Loop’ option selected and ‘Sequential’ is turned 
on.  The operator can choose to have the data for each point stored in a 
separate file or to have the data for all of the points stored in one file.  
The third option allows the operator to specify that if they are running a 
‘mark point’ experiment (acquire loop, functional mapping, or fast method), 
then when they save the experiment, they can choose to have the software 
automatically save the ‘Point Images’.  What image/images(s) that would be 
saved would be based upon what the operator had selected in the ‘Save Points’ 



dialog reached from the ‘Mark Points’ dialog.  The fourth option allows the 
operator to specify the number of seconds that the software should pause after 
moving to a new point location before acquiring an image during the ‘Point’ 
calibration process.  The fifth option allows the operator to determine if he/
she wants the program to automatically reset the ‘marked points’ acquisition 
mode to the most recent selection after the operator has deleted all of the 
marked points and started marking new points.

e. Added four buttons in the lower left hand corner of the main window that allow 
the operator to load a ‘parameter’ file without having to go through the 
standard ‘File’ menu option.  The buttons are set up through the ‘Load 
Parameter Buttons…’ menu option found under the ‘Configuration’ menu option.  
The parameter files associated with each of the buttons is recorded and 
automatically reloaded with TriggerSync is started.

f. In the ‘Mark Points’ dialog, a field has been added that will allow the 
operator to adjust the ‘Ext. Sensitivity (mV/V)’ parameter for the DAC output 
that the marked points are being synchronized with (if the ‘Use Marked Points 
During Acquisition’ switch is ‘ON’).  This allows the operator to quickly 
change the output voltage for the synchronized waveform (pulse/train or I/V) 
without having to close this dialog and open the ‘Acquisition and DAC Output 
Setup’ dialog.

g. Under the ‘File’ menu option, when the operator selects ‘Save Experiment’ the 
operator will now be prompted as to whether the data should be saved in the 
native TriggerSync format, or if the data should be saved in a format for use 
in a spreadsheet program.

Version 2.5.1.5

212. When acquiring linescans (straight line or freehand), the entire linescan 
definition is now part of the .xml and the .lsd files associated with a linescan 
acquisition.

213. Corrected a problem when acquiring images in a T-Series in AOD imaging mode 
with the ‘Max Speed’ option checked, some of the images were corrupted.

Version 2.5.1.4

214. Stopped displaying the message ‘Acquisition took x.xx seconds’ in the bottom 
line of the main window, at the end of acquisitions.

215. Corrected a problem where the dwell time value was being improperly set if the 
dwell time was being adjusted by ‘dragging’ the dwell time slider.

216. Corrected a problem where the ‘startOfFrameTrigger’ and ‘endOfFrameTrigger’ 
were not being generated.

217. Corrected a problem with trying to configure the software to use an ‘ActiveX’ 
control for a PMT instead of the usual ‘Device Control Box’ option.

218. Corrected a problem when the ‘Bidirectional Z-Series’ option in the ‘T-Series’ 
was selected.  In previous versions, if an odd number of Z-Series were acquired when 
this option was selected, then when the a second T-Series was started after completion 
of the first T-Series, the Z-Series would start at the ‘stop’ position and proceed to 
the ‘start’ position, instead of beginning at the ‘start’ position (basically the bi-
directional sequencing was continuing in the second acquisition where it left off from 
the first acquisition).

219. Modified the ‘Measurement’ tool dialog so that it is no longer resizable.

Version 2.5.1.3

220. Modified the software so that a new USB based controller could be used for 
driving the servo mechanism for switching between galvo mode and AOD mode for dual 
scan systems.

221. Corrected a problem when displaying the ‘Scale Bar’ with the Playback mode 



turned on (either after an acquisition has completed or manually loading in a previous 
acquisition) with a data set that includes images acquired with multiple ROI 
definitions.

Version 2.5.1.2

222. Added a new capability to linescan acquisition.  A new parameter has been added 
to the ‘Linescan Control’ dialog, ‘Time Delay Between Lines [ms]’.  This parameter 
allows the operator to define a time delay to use between each of the lines that are 
acquired based upon the setting for the parameter ‘Number of Lines’.  To allow the 
linescan acquisition to work properly, the ‘Time Delay Between Lines’ must be an 
integer multiple of the ‘Scanline Period’ (which is displayed in the Linescan Control 
dialog as well as the main Prairie View window).  All the operator has to do however 
is to type in the desired time delay and hit the ‘Enter’ key.  When the ‘Enter’ key is 
pressed, the software will evaluate the entered time delay and modify it by setting it 
to the nearest integer multiple of the ‘Scanline Period’.

a. For example, if the ‘Scanline Period’ is 2.696 ms and the operator enters a 
time delay of 1.0 ms, then when the ‘Enter’ key is pressed, the time delay 
value will be recomputed and it will be set to 0.0 (1.0 is closer to 0.0 than 
it is to 2.696 which is the time delay step size).

b. Another example, once again assume that the ‘Scanline Period’ is 2.696 and the 
operator enters a time delay of 10.0.  When the ‘Enter’ key is pressed, the 
time delay value will be recomputed as 10.784.

c. This feature is available for all linescan acquisitions including the ‘Free 
Draw’ option and when scanning in the AOD mode (if your system is equipped with 
the high speed AOD option).

223. Added a new capability to linescan acquisition.  A new parameter has been added 
to the ‘Linescan Control’ dialog, ‘Leave Hard Shutter Open for Duration of Linescan 
Acquisition’.  When this option is checked (default state) and the number of 
‘Repetitions’ for the defined linescan is greater than one (1), then the hard shutter 
will remain open until all linescan acquisitions have been completed.  If this option 
is unchecked, then the hard shutter will close in between each of the linescan 
acquisitions.

224. Made a change to the software to correct an issue where the image display was 
not always fully updated at the end of an image acquisition during Z-Series or T-
Series.  The correct image data was always being saved, but sometimes the bottom 
portion of the image display was not always fully updated as each successive image was 
acquired.

225. Added a new button to the ‘Image Size’ section to set the image size to 64x64 
pixels.

226. Corrected a problem in the ‘Linescan Control’ dialog.  If multiple linescan 
acquisitions were being acquired, the program was not waiting for the specified period 
of time between the acquisition of each linescan.

Version 2.5.1.1

227. Modified the ‘Fluorescence Unmixing’ dialog so that the maximize and minimize 
buttons in the upper right hand corner of the dialog are disabled.

228. Modified the logic for better interaction of the software when using the Nikon 
Remote Focus Accessory for Z-motor (focus) control.

229. Added the objective lens NA and magnification values to the data that is 
recorded with images.

230. Corrected a problem where the value being saved in the .xml file for the x and 
y ‘microns per pixel’ was not being properly scaled based upon the number of pixels in 
the x or y dimension for the image.

231. Corrected a problem where ROIs were not properly registered if the scan 
rotation was any value except 0 degrees.

232. Added support for communication with the L&N (Luigs & Neumann) stage controller 
via the USB port in addition to the existing support for the serial port.

233. Modified the XYZ stage control software when configured for the L&N (Luigs & 



Neumann) stage controller to offer more precise stage movement synchronization with 
image acquisition.

Version 2.5.1.0

234. Modified the channel buttons for the image windows so that the channel buttons 
will only have a ‘green’ background when that particular channel is being displayed in 
that particular image window.

235. On the ‘XY’ tab, the ‘Step Size [um]’ control has been relabeled as ‘X & Y Step 
Size [um]’ to better indicate that this value only impacts the step size for the X and 
Y axes, not the Z axis.  In addition, a new ‘Z Step Size [um]’ control has been added 
to this tab to allow the operator to set the desired Z step size either here, or on 
the ‘Z-Series’ tab.

236. Added a new feature called ‘Fluorescence Unmixing’.  The interface for this 
feature is accessed under the ‘Tools’ menu option.  When this option is selected, a 
new dialog will be brought up that allows the operator to set the various operating 
parameters for the Fluorescence Unmixing option.  The basic premise is that a selected 
percentage of a given channel is subtracted from another channel, and added back to 
the original channel.

a. The first column of controls is labeled ‘Enable’.  By ‘checking’ the box, the 
Fluorescence Unmixing for this selection will be applied.

b. The ‘Source Channel’ control allows the operator to select the channel to use 
as the reference signal to be subtracted from the channel specified in the 
‘Channel to Subtract From’ column.

c. The ‘Percentage’ control allows the operator to control (in 1/10 of 1% 
increments) the amount of the ‘Source Channel’ to be subtracted from the 
‘Channel to Subtract From’.

d. These controls will work either on a static image (acquired with the ‘Single 
Scan’ button, or while in ‘live’ mode (when the ‘Live Scan’ option is on).

e. For example, let’s say that there is some bleed through of channel 1 into 
channel 2.  So our goal is to subtract out the channel 1 signal from channel 2 
and add it back to channel 1.

i. Place a ‘check’ in the box under the ‘Enable’ column.
ii. For the ‘Source Channel’ select channel 1.
iii. For the ‘Channel to Subtract From’ select channel 2.
iv. While either ‘live scanning’ or after having acquired the images 
on channels 1 and 2 with the ‘Single Scan’ button, slowly move the 
‘Percentage’ control up and as you do this, you should see the signal 
from channel 1 that is present in channel 2 diminish.  At the same time, 
you’ll see the signal in channel 1 increase by the same amount as this 
data is ‘recovered’ into channel 1.

1. One idea on how to do this visually so that not too much signal 
is subtracted from channel 2, is to place channel 2 into ‘Range 
check’ color mode, and then as the ‘Percentage’ slider is 
increased, when you start seeing some ‘blue’ or zero intensity 
pixels in the area where channel 1 was bleeding into channel 2, 
you know that you’ve subtracted out just enough of channel 1 
from channel 2.

Version 2.5.0.18

237. Corrected a problem in the T-Series acquisitions.  If BOT data is being 
collected in any of the cycles in the T-Series, then after the T-Series finishes, it 
would not display the BOT data during the ‘Playback’ that was automatically started.  
If the T-Series data was re-loaded via the menu option ‘Load Images’, then the BOT 
data would be displayed.  This problem has been resolved.

Version 2.5.0.17



238. Corrected a problem in the T-Series acquisitions.  If the T-Series is aborted 
while collecting data in a cycle that includes collecting BOT (Brightness Over Time) 
data, the BOT data acquired up to the time of the abort was not being saved.  This has 
been corrected.

Version 2.5.0.16

239. Corrected a problem with the ‘Playback’ of multi-channel data.

Version 2.5.0.15

240. Corrected a problem when collecting BOT (Brightness Over Time) data.  
Sometimes, during the data acquisition, the internal setting for the dwell time would 
be changed which would result in incorrect BOT ROI intensity calculations.

241. Modified the BOT dialog.  When the ‘Seconds/Frames’ button is pressed, the 
graph will be redrawn with the new X axis.  The dialog was further modified so that 
while BOT data is being acquired, or a playback loop is running, the various BOT graph 
controls are disabled.

Version 2.5.0.14

242. Added logic to limit X, Y, or Z travel if the ‘Travel Limits’ option is checked 
for any of these axes in the ‘PrairieConfigUtility’ program.  It should be noted that 
these travel limits only pertain to the Prairie View software and if the hardware is 
allowed to travel greater distances via external control, then these limits could 
still be exceeded.

243. Under the ‘Tools’ menu option, added a new option ‘Clear Current ROI 
Definitions’.  When this option is selected, and operator confirms that they wish to 
delete all of the current ROI definitions, then the currently defined ROIs will be 
deleted.

244. Modified the T-Series software so that if the ‘No ROI’ option is selected and 
added/inserted as a cycle, the proper scan area will be used.

245. Within the T-Series, for an ROI cycle, the ‘note’ associated with the ROI name 
now shows the starting location (X, Y) of the ROI and the ROI size, in pixels.

246. Within the T-Series, an XY Stage location cycle can have its position (X, Y, 
and Z) reset without having to delete the cycle and insert/add a new cycle.  This 
greatly facilitates the ability to define a T-Series protocol that contains XY Stage 
cycles and to reuse that T-Series with only having to redefine the desired XY stage 
locations.

a. Example 1, create a T-Series that uses two defined XY stage locations (listed 
as ‘XY-1’ and ‘XY-2’ in the T-Series cycles.  After executing the T-Series, you 
wish to run this T-Series again, but at two different locations.  Simply delete 
the list of XY Stage locations (from the ‘XY’ tab) and define the two new 
locations that you want.  Those new positions will now be automatically 
programmed into the XY-1 and XY-2 cycles in the T-Series.

b. Example 2, load a T-Series definition into Prairie View that contains XY Stage 
location cycles.  After loading the T-Series definition, simply define the 
necessary number of XY Stage locations, and they will automatically be mapped 
to the corresponding cycles in the T-Series.

c. Example 3, there are 3 defined XY Stage locations, and the operator loads a T-
Series configuration that includes 3 XY Stage cycles.  When the T-Series 
configuration is loaded, the XY Stage cycles will automatically be set to the 
values of the first three defined XY Stage locations.

247. Corrected the ‘T-Series Preferences’ dialog so that when it is opened, the 
values for the controls ‘T-Series Execution Order’ and ‘TriggerSync Execution’ are 
properly initialized. 

248. Added ‘Keyboard Shortcuts’ menu option under the ‘Help’ menu option.  When 



selected, a dialog will appear that identifies the currently defined keyboard 
shortcuts and their associated actions.

249. Modified the Z-Series acquisition.  On the Z-Series tab, the ‘Start with Input 
Trigger’ checkbox was removed.  This was replaced with a selection box with three 
choices; ‘No Input Trigger for Z-Series’, ‘Start Z-Series with Input Trigger’, and 
‘Use Input Trigger for each Image’.

a. If ‘No Input Trigger for Z-Series’ is selected, then the Z-Series will start 
immediately when the ‘Start Z-Series’ button is pressed.

b. If ‘Start Z-Series with Input Trigger’ is selected, then after the ‘Start Z-
Series’ button is pressed, the z-motor will move to the position of the first 
slice/image, the Laser and/or PMT settings will be set, the hard shutter will 
open, and then the software will wait for the arrival of an external input 
trigger before acquiring the first slice/image.  After that, all subsequent 
slices/images are acquired automatically.

c. If ‘Use Input Trigger for each Image’ is selected, then after the ‘Start Z-
Series’ button is pressed, the z-motor will move to the position of the first 
slice/image, the Laser and/or PMT settings will be set, the hard shutter will 
open, and then the software will wait for the arrival of an external input 
trigger before acquiring the first slice/image.  This process is then repeated 
for each subsequent slice/image in the Z-Series.

d. This control does not have any impact on Z-Series that are executed as a 
‘cycle’ in a T-Series.  To that end, there is no option in the T-Series that 
allows the operator to require an Input Trigger for each image of a Z-Series 
acquired from within a T-Series.

250. In the T-Series tab, relabeled the control ‘T-Series Iterations’ to 
‘Iterations’ and added the ‘Period’ control next to the ‘Iterations’ control.  This 
new ‘Period’ control allows the operator to specify the desired time period to use 
when the number of T-Series ‘Iterations’ is greater than 1.  This control adds another 
element of flexibility for creating T-Series and control the timing of the various 
events.

251. Corrected a problem in the T-Series.  When the Z-Series preference was set to 
‘Align Z-Series center to stage location’ and then in the T-Series software at least 
one cycle has the ‘Z-Series’ box checked, and either XY stage locations are included 
as cycles in the T-Series or the ‘Perform T-Series at all XY Stage Locations’ box is 
checked, the computed Z motor positions were incorrect.  This has been fixed.

Version 2.5.0.13

252. Modified the software so that the ‘Scan Mode’ button and status label are set 
to the proper state (enabled/disabled) based upon the system configuration.

253. Removed the ‘Preamp Controls’ menu option from the ‘Tools’ menu option.
254. Corrected a problem with ROIs within a T-Series.  Essentially, Prairie View 

would not allow the operator to enter their desired value for the ‘Period’ value.  
Also, the ‘Time’ field was calculated incorrectly for certain combinations.

255. Modified the T-Series software such that as cycles are added and/or deleted, 
the affected remaining cycles will be reconfigured as necessary.  For example, if 
there is an ROI definition in cycle 2, and cycle 3 is an image acquisition sequence 
with the ‘Max Speed’ option checked, if cycle 2 is deleted, then the ‘Period’ for 
cycle 3 needs to be recomputed to indicate the different frame rate due to the removal 
of the ROI definition.

Version 2.5.0.12

256. Added additional information to the XML file that indicates whether the 
acquired data (images) are valid or not.  This is needed for image acquisition 
sequences acquired at the current scan speed.  During the image acquisition the 
software monitors to make sure that no image frames are ‘dropped’.  If this happens, a 
flag is set for every frame in that sequence indicating that the validity of the data 
is suspect.  Unfortunately, the software does not indicate at what frame the error 
first appears.



257. Fixed a problem where if the system was configured for a single galvo set, 
TriggerSync could not get control of the galvos for uncaging/pointing experiments.

Version 2.5.0.11

258. In the objective lens calibration dialog, two additional fields have been 
added, ‘X Microns/Pixel’ and ‘Y Microns/Pixel’.

Version 2.5.0.10

259. When the ‘Center Galvos’ option under the ‘Tools’ menu option is selected while 
the system is in AOD scanning mode (only pertains to dual scan systems), the X galvo 
will be driven to 0.0.

260. Modified the Z-Series algorithm such that if the computed Z-Series will have 
more than 500 steps/slices, the operator will be asked if the program should continue 
with computing the Z-Series parameters.

261. Modified the objective lens calibration so that there is only one calibration 
value for each objective lens.  Prior revisions required separate calibration values 
for both the galvo imaging mode and the AOD imaging mode on dual scan systems.

262. Corrected a problem where ROIs defined while scanning in the AOD mode were not 
being properly positioned in the x axis.

Version 2.5.0.9

263. Corrected a problem with the ‘Initial Pan Settings’ for the X axis.  The 
previous implementation did not work properly with some of the scan settings being 
used for system configurationa.

Version 2.5.0.8

264. Corrected a problem where ROIs could not be properly defined when operating in 
the AOD mode (applies to dual scan system and PC-Oz systems only).  The correction 
requires that the x dimension of the ROI (number of pixels) must be a multiple of 4.  
If the operator does not create an ROI that meets this requirement, the software will 
automatically adjust the size (and if necessary the location) of the ROI to meet this 
requirement.

265. Corrected a problem in the calculation of the ‘Time’ for a given T-Series 
imaging cycle when the number of frames to average is greater than 1.

266. Corrected a problem that was generated when the number of frames to average was 
greater than 1 and the ‘Max Speed’ box was checked in a T-Series.  Basically, when the 
‘Max Speed’ button is checked, no frame averaging will take place.  A ‘note’ to that 
affect is displayed in the ‘Max Speed’ column (accessible by placing the cursor over 
the red triangle in the upper right hand corner).

267. Modified the ‘Background Subtraction’ option so that it will now work from 
within a T-Series cycle when the ‘Max Speed’ box is checked.  The first implementation 
of Background Subtraction in version 2.5.0.7 did not support the ‘Max Speed’ option 
within a T-Series.

268. Corrected a problem where the ‘BOT’ data was not being acquired when the ‘BOT’ 
box is checked within a T-Series.

269. Corrected a problem with the Playback of BOT data where the data for the first 
BOT region was being displayed as all 0s and the subsequent BOT ROIs graphs were all 
offset by one.

270. Corrected a problem when there is no XY stage automation present.  The XY stage 
controls located ‘behind’ the Pan controls were not properly disabled.



Version 2.5.0.7

271. Added an image background subtraction capability.  On the ‘Misc’ tab there is 
now a button labeled ‘Record Background Image’  When this button is pressed, the 
current image(s) (channels 1..4) will be recorded in memory.  Below this button is a 
checkbox control labeled ‘Subtract Background Image’ that allows the operator to turn 
the background subtraction on or off.

a. Currently background subtraction is not applied when acquiring T-Series images 
and the ‘Max Speed’ box is checked.

272. Corrected a problem where the ‘Intial Pan Settings’ for the X and Y axis were 
not being applied when running in AOD mode for dual scan systems.  These values are 
used to register the images between AOD and galvo imaging modes.

Version 2.5.0.6

273. Corrected a problem where ROIs were not being properly registered when working 
at an optical zoom other than 1.0.

274. Corrected a problem where Prairie View would hang up or perform improperly if 
the directory that data should be saved in when performing a Z-Series, T-Series, and 
etc. is not successfully created.  This problem could arise for example if data is 
being acquired to a removable memory stick, and then after the memory stick is 
removed, the operator forgets to change the default path for image/data storage.  
Another possible cause could be if the operator had been previously using a network 
drive that is no longer mounted or available to the computer.  If the desired 
destination does not exist, an error message to that end will be displayed and the 
acquisition will not continue.

Version 2.5.0.5

275. Modified Prairie View so that it can control more than one Two Photon laser.
276. Modified the logic that remembers the image window locations when Prairie View 

exits, and will not allow a position for the x or y coordinate that is less than 0 
(zero).  There was a random problem where the image window coordinate was being 
incorrectly saved and then when Prairie View was started again, the image window was 
not on the screen.

277. Corrected a problem where the photo activation feature did not work on dual 
scan Ultimas (systems that used the PCI-6115 card).

278. Within the T-Series tab, the ‘Time Remaining’ field is now updated while a T-
Series is executing.  Since the ‘Time Remaining’ is an estimated value, it is possible 
that while the T-Series is running, the value displayed in the ‘Time Remaining’ field 
could go negative (but that is O.K.).  Also, if the T-Series uses the ‘input trigger’ 
option, basically, no time estimate can be accurately made for the T-Series, so the 
‘Time Remaining’ field will start at 0, and go up when the T-Series is running, 
basically showing the ‘Elapsed Time’ of the acquisition

279. Modified the ‘Line Profile’ interaction such that if the Playback data is in 
‘MIP’ mode, and the ‘Z Mode’ button in the ‘Line Profile’ dialog is checked, if the 
‘MIP’ mode is then turned off, the ‘Line Profile’ will automatically return to the 
‘XY’ mode (‘Z Mode’ is turned off).  Also, if during Playback, the ‘MIP’ mode is on 
and the ‘Z Mode’ button in the ‘Line Profile’ dialog is checked, if the Playback mode 
is turned off, the ‘Line Profile’ will automatically return to the ‘XY’ mode (‘Z Mode’ 
is turned off).

280. For dual scan systems (those that include the AOD option), when acquiring 
‘single’ frames while in AOD mode (including if the number of frames to average is 
greater than one), there is no image update until the entire image is acquired.  This 
differs from imaging in Galvo mode where the image is updated even as the individual 
frames to average are acquired.

281. When in Playback mode, if MIP is turned on, there is now a context menu for the 
MIP button.  This allows the operator to choose from ‘1:1’ or ‘Fit to Window’ option 
for the XZ and YZ data views.  If ‘1:1’ is selected, the XZ view will be sized in the 



x dimension to match the number of pixels in the x dimension of the image, and the y 
dimension will equal the number of frames in the data set.  The YZ view will be sized 
in the x dimension to match the number of frames in the data set and the y dimension 
will match the y dimension of the image.  In the ‘Fit to Window’ option the image data 
in the XZ or YZ views will be ‘scaled’ to fit the size of the frame that is being 
used.

282. When in Playback mode, if MIP is turned on, there is additional information 
displayed in the image window.  Along the bottom, where the pixel intensity values are 
displayed, an extra group is displayed similar to the following Z={000 : 000 : 000: 
000}.  This field displays the particular z slice number that corresponds to where the 
data for the given pixel in the MIP image was derived from.

Version 2.5.0.4

283. Modified the starting dialog syntax (splash screen).
284. Modified the controls on the ‘2-P Laser’ tab for selecting the wavelength so 

that they will allow the operator to correctly select the desired wavelength.
285. Fixed a problem where by when a ‘Label’ is deleted, any ‘Label Groups’ that 

include this label will need to be deleted as well.
286. On the ‘Laser, PMT, DAQ’ tab, the group of laser controls had their bounding 

box changed to read ‘Laser’ and it had previously read ‘1-P Laser’.
287. On the ‘Z-Series’ tab, the check box ‘Adjust PMT’ was changed to read ‘Adjust 

PMT & Laser’.
288. On the ‘2-P Laser’ tab, on the back panel (behind the standard laser controls 

and displays) when the ‘Write Laser Status to File’ button is pressed, the data will 
be appended to the given file.  In previous versions, this data would overwrite the 
previous laser status information.  In addition, the current date and time are added 
to the file before the laser status information.  In this way, a running log of laser 
performance may be maintained.  The path and file name that are used are displayed in 
the bottom status bar of the Prairie View interface after the file has been written.

289. Modified the Meta Data interface to display the X and Y microns per pixel 
values for each image as well as the FOV (Field Of View) value for each image.

290. Modified the software such that on the ‘Z-Series’ tab, in the table of settings 
that is displayed indicating the parameter settings for each slice in the Z-Series, 
the value for the laser and PMT settings will not include any fractional values (e.g. 
PMT1 Gain will read 536, not 535.86).

291. Modified the image playback controls and capabilities.  This included adding a 
set of vertically oriented controls for scrolling/looping through the data similarly 
to the horizontally oriented controls already there.  The way these new controls work 
in conjunction with the data are as follows:

a. If the image data to be used in playback follows a strict ‘matrix’ definition, 
then the new controls will be active.  The definition for a strict ‘matrix’ is 
that there must be more than one data set and each of the data sets must 
contain the same number of images.  This could be accomplished in many ways.  
One common method would be to define a Z-Series and then in the T-Series logic, 
acquire the Z-Series multiple times (4-D imaging).  Another method would be to 
create a T-Series with the same number of images in each of the cycles.

b. If the data does not adhere to the strict ‘matrix’ definition, the vertical 
controls will be disabled and the remaining playback controls will work as 
previously defined.

c. If the data does adhere to the strict ‘matrix’ definition, then the vertical 
controls will be enabled.  In this mode, the horizontal scrollbar and its 
associated controls will be used for selecting the data set to view.  The 
vertical scrollbar and its associated controls will be used for selecting the 
desired image frame within the data set.

i. For example, lets say that 5 Z-Series of 30 images each were 
acquired.  The horizontal scroll bar has a range of 1 to 5 (1 data set 
for each Z-Series), while the vertical scroll bar has a range of 1 to 30 
(30 images for each data set).  Varying the value of the horizontal 
scroll bar will display the same image from each of the data sets.  In 
this manner, the operator could select a particular Z-Series image/slice 
using the vertical scroll bar, and then quickly view the same image/



slice in each of the data sets simply by using the vertical scroll bar 
(or its associated controls).

292. In the PMT controls, a new button was added.  The label associated with the 
button is ‘PMT Master’.  Initially, the button is labeled ‘Zero’.  When this button is 
pressed, the high voltage settings (gain) for all of the PMTs will be set to zero.  
The label on the button will then change to ‘Previous’.  When this button is pressed 
again, the PMT high voltage settings will return to their previous settings.

a. If the control is in the zero state (button will read ‘Previous’) and a label 
is selected/changed, then the button will automatically change back to read 
‘Zero’ and the PMT settings for the selected label will be applied.

b. If a label is currently selected when this button is labeled ‘Zero’ and it is 
pressed, the operating values for the PMT settings for the label will not be 
set to zero.

293. In the ‘2-P Laser’ tab an additional column was added in the ‘2-P Laser 
Control’ group.  This additional column is labeled ‘Shutter’ and it allows the 
operator to see the status of the internal hard shutter for each of the lasers that 
are being controlled by Prairie View.  This is in addition to being able to see the 
current wavelength and laser output power for each laser.

294. When in image playback mode, if the MIP (Maximum Intensity Projection) button 
is turned on in one image window, the MIP button in the other image windows will be 
disabled until the MIP mode is turned off in the image window in which it was 
originally turned on in.

295. Fixed a problem whereby when a new Image window was created, the MIP button 
wasn’t initially disabled.

Version 2.5.0.3

296. Modified the software for support of the L&N controller for X, Y, and Z axis 
control.

Version 2.5.0.2

297. Modified the Mark Points dialog.  The ‘Delete’ button was changed to read 
‘Delete Selected’ indicating that only the currently selected item will be deleted.  
The ‘Clear’ button was changed to read ‘Clear All’ indicating that all items (points, 
lines, and grids) will be deleted.  Also added a control that allows the operator to 
select the color to display the marked points in.  The current list of available 
colors is; red, green, blue, white, yellow, cyan, and magenta.

Version 2.5.0.1

298. Added acquisition status information to the ‘Status’ window in the linescan 
acquisition dialog.

299. Changed the labels for the two checkboxes in the linescan dialog to make their 
use easier to understand.

300. Added additional information to the ‘status’ box when T-Series are being 
executed.

301. In the ‘Measure’ dialog, the ‘New Line’ button has been removed.
302. In the ‘Mark Points’ dialog, if only individual points have been generated (no 

lines or grids), then a third option ‘random’ is available for the point order along 
with ‘forward’ and ‘reverse’.

303. When an image loop is running during image playback, the controls in the 
‘Metadata’ window are disabled.

Version 2.5.0.0



304. In the ‘T-Series’ tab, added a ‘T-Series Iterations’ numeric control.  This 
allows the operator to indicate how many times the define T-Series cycles should be 
executed.

305. In the T-Series Preferences dialog, a combo box has been added that allows the 
operator to indicate the execution order for the T-Series.  This is necessary for when 
the operator has set the number of T-Series Iterations to a value greater than 1 and 
has checked the ‘Perform T-Series at all XY Stage locations’ box is checked.

306. In the T-Series Preferences dialog, a combo box has been added that allows the 
operator to indicate how a VClamp cycle should be handled within a T-Series.  If the 
operator chooses the option ‘Wait for VClamp experiment to finish before next cycle is 
started’ then the T-Series will wait until the VClamp experiment is finished before 
the next cycle in the T-Series is started.  If the operator chooses the option ‘Start 
the next cycle immediately’ then the T-Series will continue immediately with the next 
cycle.

307. Added a new free form linescan capability.
308. When saving an ROI definition, the operator is now prompted for a name they 

might want to associate with the ROI.  A default name giving the ROI specification is 
automatically generated so that the operator does not have to type in a new name 
unless desired.

309. Added a parameter to the data saved with each image that indicates the system 
type when the image was acquired.  For example, ‘System Type: Ultima Galvo Mode’ or 
‘System Type: Ultima AOD Mode’.  This information is displayed in the ‘Meta Data’ 
window during playback mode.

310. Modified the linescan control dialog to include a section for specifying the 
file directory and name to use for linescan data.  This had originally been part of 
the ‘Misc.’ tab in the main Prairie View dialog and was also the same values used for 
the saving of individual images.

311. Added the following parameters that can be querried by TriggerSync;
a. PIXELS_PER_LINE
b. LINES_PER_FRAME
c. SCAN_LINE_PERIOD
d. FRAME_PERIOD
e. FRAME_RATE
f. STAGE_X
g. STAGE_Y
h. STAGE_Z
i. DWELL_TIME

312. Added a pair of Z motor movement arrow buttons next to the XY stage arrow 
buttons to allow for movement in all three directions from one location.

313. In the status bar that displays the current X, Y, and Z motor positions, we’ve 
now added a FOV (Field Of View) display.  This field displays the current Field Of 
View in pixels and microns.

314. When drawing ROIs (either for ROI image acquisition or ROIs for the BOT 
(Brightness Over Time) utility) the current ROI size in pixels and microns is 
displayed in the upper left hand corner of the window so the operator will know the 
size of the ROI that they are creating.

1. Added a new menu item under the ‘Tools’ menu option called ‘Notes…’.  When selected, 
this will bring up a dialog that allows the operator to enter whatever text/notes that 
they want.  This information will be saved with all subsequent data acquisitions 
(images, Z-Series, T-Series, etc.).  These ‘notes’ will then be displayed in the 
MetaData viewer during image playback. Added keyboard shortcuts for the following 
operations:

a. F8 Acitvate Notes dialog
315.
316. Added a new menu item under the ‘File’ menu option called ‘Save ROI Reference 

Image’.  When selected, this will bring up a dialog asking the operator to select 
which of the current ROI definitions to include as an overlay of the image currently 
displayed in image window 1.

317. Modified the ‘Linescan’ dialog.  Now the operator may choose between defining 
the linescan by setting the number of lines to acquire, or by specifying the amount of 
time that they wish to scan and the software will automatically compute the number of 
lines necessary.

318. When editing values in the ‘Scan Settings’ window, it is now necessary to press 
the ‘Enter’ key after typing in the desired value before pressing the ‘Configure’ 



button.
319. For new dual scan (galvo and AOD) systems, there is now a control located next 

to the ‘Hard Shutter’ button that allows the operator to change scan modes.  For 
previous systems this selection was controlled via a manual ‘plunger’ on the scan 
head.

Version 2.2.1.3

320. Modified the Prairie View start logic to trap an error that may occur when the 
program is first starting and it is looking for other instances of Prairie View that 
might already be running.

Version 2.2.1.2

321. Corrected a problem with executing multiple Z-Series from within the T-Series 
on systems that have the automated XY Stage software enabled.

Version 2.2.1.1

322. Corrected a problem where the direction of the XY stage movement was not 
changed when the appropriate parameters in the config.ini file where modified.

Version 2.2.1.0

323. Modified all of the acquisition setups so that the operator may manually 
override the “increment” value when performing Z-Series, T-Series, W-Series, and etc.

324. Added an additional status bar at the bottom of the main Prairie View window 
that displays the current x, y, and z motor positions.

Version 2.2.0.8

325. Modified internal use of a performance counter for timing purposes.

Version 2.2.0.5

326. In the ‘Scan Settings’ dialog, modified the controls for x and y lag time to 
allow for up to four digits of precision to the right of the decimal point.  
Previously you were limited to integer values.

Version 2.2.0.4

327. Added the ability to save and reload ROI definitions.
a. Up to 10 ROI definitions can be defined at one time.
b. This group of 10 ROI definitions can be saved, and loaded at any time.

i. This allows for multiple groups of ROI definitions to be 
created.

ii. Use the menu options ‘Load ROI Definitions’ and ‘Save ROI 
Definitions’ under the ‘File’ menu option to save/load ROI definitions 
(group of 10).



c. Creating an ROI definition
i. Left click on the ‘ROI’ button in the image window.
ii. Draw the desired ROI in the image window.
iii. Right click on the ‘ROI’ button in the main image window (Image 
Window – 1) and then left click on one of the ten available ROI menu 
options listed in the menu.

d. Selecting an ROI definition
i. Make certain that the ‘ROI’ mode is currently turned off.
ii. Right click on the ‘ROI’ button in the main image window (Image 
Window – 1) and then left click on one of the ten available ROI 
definitions listed in the menu.

iii. Using the mouse, place the ROI on the image in desired location 
and press the left mouse button.

328. Modified the data saved when acquiring a Z-Series.  Now, the laser control 
value(s) and PMT control value(s) for each slice will be saved.  This is necessary 
since the operator can set up the Z-Series to have different laser and/or PMT settings 
at each slice.

329. Added an FFT (Fast Fourier Transform) image analysis option.  This feature is 
accessed under the ‘Tools’ menu option as ‘FFT’.  Once you go to the ‘FFT’ menu 
option, there is a pull right menu allowing the operator to select which image channel 
to perform the FFT calculations on.

a. What frequency range.
b. How does it work.

330. Modified the image playback capabilities.
a. Metadata is now presented during playback.  This information includes the 

various system operating values when the image(s) were acquired.
331. Modified the Z-Motor/Z-Series ‘0’ (Reset) button action.  This button, located 

in between the up and down arrow buttons is currently only enabled with certain z 
motors.  For devices where this feature is enabled, when the operator presses the 
button, the current z motor position will be set to 0.0 and any current Z-Series 
definition will be erased.  Erasing the Z-Series definition is essential to ensure 
safe Z-Series acquisition.  For example, if the current Z-Series definition went from 
a location of 2000.0 to 2100.0, and then the “0” button is pressed, when the ‘Start Z-
Series’ button is pressed, the z motor will move 2000 microns (2 millimeters) before 
the Z-Series is started.

332. Added a new section to the config.ini file ‘[beamControl2]’.  This section and 
its associated logic is used to control a switch box that is only present at this time 
in dual scan mode (Galvo and AOD) systems that do not contain a set of uncaging 
galvos.

333. Modified the T-Series cycle setup so that when a “Wait” cycle is added or 
inserted, the operator sets the wait time by setting the value in the “Period” column.  
Previously this value was entered in the “Time” column.

334. Added a “Load T-Series Configuration” and “Save T-Series Configuration” menu 
option.  This allows the operator to save/recall T-Series setups.

335. Modified the format of the configuration files (formerly .cfg files) from a 
binary format to an ASCII based XML format.  This will allow for greater flexibility 
and forward and backward compatibility as the Prairie View software changes.

Version 2.2.0.1

336. Within the image windows the ‘Channel’ buttons have been slightly modified.
a. When ‘labels’ are not being used, whenever a ‘channel’ is turned on in one of 

the image windows, the background color for the channel button will be set to 
the ‘Channel Enabled Color’.  The default color is light green.  The operator 
may select a different color by clicking on the ‘Display’ menu option, then 
selecting the ‘Channel Enabled Color’ option and choosing a new color from the 
color dialog.

b. When ‘labels’ are being used, then whenever a ‘channel’ that is associated with 
the currently selected label is turned on in an image window, the background 
color for the channel button will be set to the ‘Channel Enabled Color’. .  The 
default color is light green.  The operator may select a different color by 
clicking on the ‘Display’ menu option, then selecting the ‘Channel Enabled 



Color’ option and choosing a new color from the color dialog.
337. Added a ‘Note’ to the first column in the T-Series sequence display for a 

‘Label’ command.  The presence of the red triangle in the upper right hand corner 
indicates that a ‘Note’ (similar to tool tip help) is available for this cell.  If the 
cursor is placed over this red triangle, a text message will be displayed.  In the 
instance of a ‘Label’ command, the message is the full name of the label or label 
group.  This allows the operator to see the entire label name without having to make 
the column wider.

338. Modified the ‘Single Scan Auto. Save’ feature (checkbox) located on the ‘Misc’ 
tab.  When this control is checked, then the ‘Single Scan’ button will be changed to 
read ‘Single Scan & Save’.  In this mode, whenever the ‘Single Scan & Save’ button is 
pressed, a new image(s) will be acquired and automatically saved.  Previously, when 
the ‘Single Scan Auto. Save’ feature was turned on, the operator had to press the 
‘Camera’ button in an image window to have a new image(s) acquired and automatically 
saved.  Now, he ‘Camera’ button in each image window will only save the image(s) that 
are displayed in that particular image window and will not initiate an image 
acquisition.

Version 2.2.0.0

339. Removed the ‘Ghost’ button from the main interface.  Moved the ‘Ghost’ menu 
option from under the ‘Tools’ option and renamed it ‘Ghost Mode’ under the ‘Display’ 
option.

340. Removed the ‘Update Map’ button from the ‘Pan Controls’.
341. Moved the ‘Objective Lens’ selection control from the ‘Misc.’ tab and placed it 

just below the ‘Label Select’ control in the main control group.
342. Moved the control for specifying the number of frames to average from the 

‘Misc.’ tab and placed it with the ‘Single Scan’ button in the main control group.
343. Modified the display of the T-Series cycle information during a T-Series 

acquisition.  All of the cells are set so that the operator may not change them during 
the acquisition, but the view can be scrolled left/right and up/down.

344. Fixed an issue that limited the valid scan direction and pan direction 
combinations.

345. Added a ‘Measure’ feature to the image window.  This new feature is activated 
by clicking on the button directly below the ‘Camera’ button in the image window.  
This new button looks like a ruler with a histogram above it.

a. For the ‘Measure’ feature to be useful, the objective lens being used must 
first be calibrated.  See item 9 under ‘Version 2.1.0.0’ below.

Version 2.1.0.4

346. Within the T-Series commands, the ‘Trigger Cycle’ option was removed for the 
‘Wait’ command and the ‘Vclamp Trigger’ command.

347. Corrected a problem when acquiring a large number of image sequences within a 
T-Series.  At the end of the acquisition, the time stamps were not being correctly 
saved.

348. Corrected a problem with the displaying of the pixel intensity information when 
using frame averaging.

Version 2.1.0.3

349. Within the T-Series commands, the ‘Trigger Cycle’ option was removed for the 
‘Wait’ command and the ‘Vclamp Trigger’ command.

350. Corrected a problem with linescan acquisition of multiple channels.  The 
individual channels were acquired and displayed, but only the first channel was being 
saved.  This has been corrected.  The fix also allows for synchronized acquisition of 
multiple channel linescan data with VClamp and subsequent playback using 



LinescanViewer.

Version 2.1.0.2

1. Modified the objective lens calibration procedure so that the process of drawing the 
calibration line is restricted to the horizontal dimension only.

2. During linescan acquisitions, the ‘Linescan On/Off’ button in the image windows is 
disabled.  This will prevent the operator from accidentally turning off the linescan 
mode in the middle of a linescan acquisition.

3. During Brightness Over Time (BOT) acquisitions, the ‘BOT On/Off’ button in the image 
windows is disabled.  This will prevent the operator from accidentally turning off the 
BOT mode in the middle of a BOT acquisition.

4. Corrected problem with objective lens selection always reverting back to first 
objective lens.

5. Added the following items to the ‘configuration’ file definition:
a. Scale Bar State (On/Off)
b. Scale Bar Location
c. Scale Bar Units
d. Scale Bar Font
e. Scale Bar Color
f. Playback Display Font
g. Playback Display Color
h. Automatically Start Image Playback After Acquisition (On/Off)
i. Automatically Convert Images After T-Series (On/Off)

6. Corrected a problem during image playback where the LUT (Lookup Table) was not always 
updated as the image changed.

Version 2.1.0.1

2. Added keyboard shortcuts for the following operations:
a. F1 Live Scan On/Off
b. F2 Single Scan
c. F3 Start/Stop Z-Series
d. F4 Start/Stop T-Series
e. F5 Start/Stop W-Series
f. F6 Start/Stop Linescan Acquisition
g. F7 Start/Stop BOT Data Collection

3. Brightness Over Time (BOT)
a. Added the ‘Save Graph’ button to the BOT dialog.  When this button is pressed, 

the operator will be prompted for the file name and location to store a copy of 
the current graph view.

b. Corrected problem with BOT where during data acquisition, once a certain number 
of data points was reached, the first data points collected were ‘pushed’ out 
of memory by the newest data points.

c. Added text field at top of BOT dialog explaining keyboard and mouse controls 
for the graph display.

d. Modified the ‘Start/Stop’ button and F7 keyboard shortcut so that it is only 
active if at least one region is defined.

4. Modified the ‘Scan Single’ button so that while an individual image is being acquired, 
pressing the button again will abort the image acquisition.  This is particularly 
useful when a very long dwell time and/or a large number of images to average have 
been specified for the image acquisition.

5. Corrected a problem in controlling the Z-motor on a Luigs & Neumann stage.

Version 2.1.0.0

1. Added the Brightness Over Time (BOT) feature.  This feature is accessible via the 
'BOT' button on the image windows.



2. Modified the input trigger software to tightly couple receipt of input trigger with 
the start of image scanning.

3. Modified the logic so that if the 'Save Path' for any of the acquisitions (Z-Series, 
T-Series, and etc is changed, the new path/directory will be used by all acquisitions.

4. Added this revision history.
5. Added the display of the ‘Iteration’ value next to the Base Directory to show the 

value that is appended to the Base Directory when then the ‘Increment Base-Directory’ 
checkbox is checked for Z-Series, T-Series, and etc.

6. Added the ability to acquire Z-Series in a bidirectional manner.  When the 
‘Bidirectional Z-Series’ option is checked in the T-Series tab, then if the ‘Z-Series’ 
checkbox for a cycle in the T-Series is checked as well, two Z-Series will actually be 
acquired.  The first Z-Series will go from the ‘Start’ position and go towards the 
‘Stop’ position and the second Z-Series will go from the ‘Stop’ position towards the 
‘Start’ position.  The total number of acquired Z-Series will be two times the value 
in the field ‘# Images/Stacks’ in the T-Series cycle.

a. If there is a Physik Instrumente E-662 piezo controller being used for the 
focus assembly, then if the ‘Fastest Acquisition’ option is checked and the 
‘Bidirectional Z-Series’ option is checked, the maximum number of slices 
allowed in the Z-Series is 100.  Also when both of these items are checked, 
each pair of Z-Series is stored as a single data set.  For example, if there 
were 50 slices in the Z-Series, then the final stored data for one Z-Series 
would include 100 images.  The first 50 slices will be the Z-Series going from 
the ‘Start’ position to the ‘Stop’ position, while the next 50 slices will be 
the Z-Series going from the ‘Stop’ position to the ‘Start’ position.

7. Corrected a problem when two or more channels are acquired in a T-Series with a 
‘Period’ of 00:00:00.00.  In previous versions, the first channel of data was 
correctly saved, but subsequent channels were corrupted.

8. Modified so that the default placement of the image window is next to the main control 
panel and not behind the main control panel.

9. Added an objective lens calibration dialog and the display of a scale bar in the image 
window.  Each objective lens must be calibrated independently.

a. To take advantage of the scale bar, it is necessary to first calibrate the 
desired objective lens.

i. Under the ‘Tools’ menu option, click on ‘Calibrate Objective 
Lens’.

ii. Click on ‘Add New Objective’ to create a new objective lens 
entry.

iii. To change the name of the objective lens, simply select the text 
in the ‘Objective Name’ field and type in the desired name, e.g. 
‘Olympus 40x water’.

iv. In the ‘Magnification’ field enter the magnification of the 
objective lens.

v. Enter the known distance to calibrate against in the field 
‘Enter calibration distance here (um):’.

vi. Click on ‘Calibrate Selected Objective.  At this time go into 
the image window and draw a line in the X dimension only covering the 
distance entered in step v.

vii. The calibrated microns/pixel value will be automatically 
computed and stored in the ‘Microns Per Pixel’ field.

viii. If this is a dual scan system (Galvo and AOD), it is necessary 
to calibrate the objective lens for both scan modes.

ix. Close the dialog.
b. Use the ‘Objective Lens’ control on the ‘Misc’ tab to select the desired 

objective lens.
c. All of the scale bar controls are located under the ‘Display’ menu.

i. Clicking on the menu option ‘Show Scale Bar’ will turn the 
display of the scale bar on/off in the image windows.

ii. Clicking on the menu option ‘Scale Bar Options’ and then 
choosing ‘Location’ will allow the operator to choose to display the 
scale bar in any of the four image display corners.

iii. Clicking on the menu option ‘Scale Bar Options’ and then 
choosing ‘Color’ will allow the operator to select the color to use for 
the scale bar display.

iv. Clicking on the menu option ‘Scale Bar Options’ and then 



choosing ‘Font’ will allow the operator to select the font to use for 
the scale bar display.

v. Clicking on the menu option ‘Scale Bar Options’ and then 
choosing ‘Units’ will allow the operator to select the desired units 
(nanometers, microns, or millimeters) for the scale bar.

10. Replaced the interface controls in the section ‘Display Zoom [mag]’ with a new section 
entitled ‘Window Size’.

a. The default window size is 512x512.
b. The window size is maintained regardless of the ‘Image Size’ settings (e.g. 

256x256, 1024x1024, and etc.)
c. Pressing the button ‘Smaller’ will make the window smaller in increments.
d. Pressing the button ‘Larger’ will make the window larger in increments.
e. Pressing the button ‘Fit Data’ will cause the image window to size to that of 

the image data.
f. Pressing the button ‘Reset’ will return the window size to 512x512.


